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Important Precautions

•  THIS SERVICE MANUAL IS AVAILABLE IN ENGLISH ONLY.
•  IF A CUSTOMER’S SERVICE PROVIDER REQUIRES A LANGUAGE OTHER THAN 

ENGLISH, IT IS THE CUSTOMER’S RESPONSIBILITY TO PROVIDE 
TRANSLATION SERVICES.

•  DO NOT ATTEMPT TO SERVICE THE EQUIPMENT UNLESS THIS SERVICE 
MANUAL HAS BEEN CONSULTED AND IS UNDERSTOOD.

•  FAILURE TO HEED THIS WARNING MAY RESULT IN INJURY TO THE SERVICE 
PROVIDER, OPERATOR OR PATIENT FROM ELECTRIC SHOCK, MECHANICAL 
OR OTHER HAZARDS.

•  CE MANUEL DE MAINTENANCE N’EST DISPONIBLE QU’EN ANGLAIS.
•  SI LE PRESTATAIRE DE SERVICES DU CLIENT A BESOIN DE CE MANUEL DANS 

UNE AUTRE LANGUE QUE L’ANGLAIS, IL INCOMBE AU CLIENT DE LE FAIRE 
TRADUIRE.

•  NE PAS TENTER D’INTERVENTION SUR LES ÉQUIPEMENTS TANT QUE LE 
MANUEL DE MAINTENANCE N’A PAS ÉTÉ CONSULTÉ ET COMPRIS.

•  LE NON-RESPECT DE CET AVERTISSEMENT PEUT ENTRAÎNER CHEZ LE 
TECHNICIEN, L’OPÉRATEUR OU LE PATIENT DES BLESSURES DUES À DES 
DANGERS ÉLECTRIQUES, MÉCANIQUES OU AUTRES.

•  DIESES KUNDENDIENST-HANDBUCH EXISTIERT NUR IN ENGLISCHER 
SPRACHE.

•  FALLS EIN FREMDER KUNDENDIENST EINE ANDERE SPRACHE BENÖTIGT, IST 
ES AUFGABE DES KUNDEN, FÜR EINE ENTSPRECHENDE ÜBERSETZUNG ZU 
SORGEN.

•  WARTEN SIE DIESES GERÄT NUR, WENN SIE DIE ENTSPRECHENDEN 
ANWEISUNGEN IM KUNDENDIENST-HANDBUCH GELESEN HABEN UND 
NACHVOLLZIEHEN KÖNNEN.

•  WIRD DIESE WARNUNG NICHT BEACHTET, SO KANN ES ZU VERLETZUNGEN 
DES KUNDENDIENSTTECHNIKERS, DES BEDIENERS ODER DES PATIENTEN 
DURCH ELEKTRISCHE SCHLÄGE, MECHANISCHE ODER SONSTIGE 
GEFAHREN KOMMEN.

WARNING

AVERTISSEMENT

WARNUNG
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•  ESTE MANUAL DE SERVICIO SÓLO ESTÁ DISPONIBLE EN INGLÉS.
•  SI ALGÚN PROVEEDOR DE SERVICIOS AJENO A GEMS SOLICITA UN IDIOMA 

QUE NO SEA EL INGLÉS, LA TRADUCCIÓN ES RESPONSABILIDAD DEL 
CLIENTE.

•  NO SE DEBERÁ DAR SERVICIO TÉCNICO AL EQUIPO SIN HABER 
CONSULTADO Y COMPRENDIDO ESTE MANUAL DE SERVICIO.

•  LA NO OBSERVANCIA DEL PRESENTE AVISO PUEDE DAR LUGAR A QUE EL 
PROVEEDOR DE SERVICIOS, EL USUARIO O EL PACIENTE SUFRAN LESIONES 
PROVOCADAS POR DESCARGAS ELÉCTRICAS, PROBLEMAS MECÁNICOS O 
PELIGROS DE OTRA NATURALEZA.

•  ESTE MANUAL DE ASSISTÊNCIA TÉCNICA SÓ SE ENCONTRA DISPONÍVEL EM 
INGLÊS.

•  SE QUALQUER OUTRO SERVIÇO DE ASSISTÊNCIA TÉCNICA, QUE NÃO A 
GEMS, SOLICITAR ESTES MANUAIS NOUTRO IDIOMA, É DA 
RESPONSABILIDADE DO CLIENTE FORNECER OS SERVIÇOS DE TRADUÇÃO.

•  NÃO TENTE REPARAR O EQUIPAMENTO SEM TER CONSULTADO E 
COMPREENDIDO ESTE MANUAL DE ASSISTÊNCIA TÉCNICA.

•  O NÃO CUMPRIMENTO DESTE AVISO PODE PÔR EM PERIGO A SEGURANÇA 
DO TÉCNICO, OPERADOR OU PACIENTE DEVIDO A CHOQUES ELÉTRICOS, 
MECÂNICOS OU OUTROS.

•  IL PRESENTE MANUALE DI MANUTENZIONE È DISPONIBILE SOLTANTO IN 
INGLESE.

•  SE UN ADDETTO ALLA MANUTENZIONE ESTERNO ALLA GEMS RICHIEDE IL 
MANUALE IN UNA LINGUA DIVERSA, IL CLIENTE È TENUTO A PROVVEDERE 
DIRETTAMENTE ALLA TRADUZIONE.

•  SI PROCEDA ALLA MANUTENZIONE DELL’APPARECCHIATURA SOLO DOPO 
AVER CONSULTATO IL PRESENTE MANUALE ED AVERNE COMPRESO IL 
CONTENUTO.

•  NON TENERE CONTO DELLA PRESENTE AVVERTENZA POTREBBE FAR 
COMPIERE OPERAZIONI DA CUI DERIVINO LESIONI ALL’ADDETTO ALLA 
MANUTENZIONE, ALL’UTILIZZATORE ED AL PAZIENTE PER FOLGORAZIONE 
ELETTRICA, PER URTI MECCANICI OD ALTRI RISCHI.

•  KÄESOLEV TEENINDUSJUHEND ON SAADAVAL AINULT INGLISE KEELES.
•  KUI KLIENDITEENINDUSE OSUTAJA NÕUAB JUHENDIT INGLISE KEELEST 

ERINEVAS KEELES, VASTUTAB KLIENT TÕLKETEENUSE OSUTAMISE EEST. 
•  ÄRGE ÜRITAGE SEADMEID TEENINDADA ENNE EELNEVALT KÄESOLEVA 

TEENINDUSJUHENDIGA TUTVUMIST JA SELLEST ARU SAAMIST.
•  KÄESOLEVA HOIATUSE EIRAMINE VÕIB PÕHJUSTADA TEENUSEOSUTAJA, 

OPERAATORI VÕI PATSIENDI VIGASTAMIST ELEKTRILÖÖGI, MEHAANILISE 
VÕI MUU OHU TAGAJÄRJEL.

AVISO

ATENÇÃO

AVVERTENZA 

HOIATUS 
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•  TÄMÄ HUOLTO-OHJE ON SAATAVILLA VAIN ENGLANNIKSI.
•  JOS ASIAKKAAN PALVELUNTARJOAJA VAATII MUUTA KUIN 

ENGLANNINKIELISTÄ MATERIAALIA, TARVITTAVAN KÄÄNNÖKSEN 
HANKKIMINEN ON ASIAKKAAN VASTUULLA. 

•  ÄLÄ YRITÄ KORJATA LAITTEISTOA ENNEN KUIN OLET VARMASTI LUKENUT 
JA YMMÄRTÄNYT TÄMÄN HUOLTO-OHJEEN.

•  MIKÄLI TÄTÄ VAROITUSTA EI NOUDATETA, SEURAUKSENA VOI OLLA 
PALVELUNTARJOAJAN, LAITTEISTON KÄYTTÄJÄN TAI POTILAAN  
VAHINGOITTUMINEN SÄHKÖISKUN, MEKAANISEN VIAN TAI MUUN 
VAARATILANTEEN VUOKSI.

•  ΤΟ ΠΑΡΟΝ ΕΓΧΕΙΡΙΔΙΟ ΣΕΡΒΙΣ ΔΙΑΤΙΘΕΤΑΙ ΣΤΑ ΑΓΓΛΙΚΑ ΜΟΝΟ.
•  ΕΑΝ ΤΟ ΑΤΟΜΟ ΠΑΡΟΧΗΣ ΣΕΡΒΙΣ ΕΝΟΣ ΠΕΛΑΤΗ ΑΠΑΙΤΕΙ ΤΟ ΠΑΡΟΝ 
ΕΓΧΕΙΡΙΔΙΟ ΣΕ ΓΛΩΣΣΑ ΕΚΤΟΣ ΤΩΝ ΑΓΓΛΙΚΩΝ, ΑΠΟΤΕΛΕΙ ΕΥΘΥΝΗ ΤΟΥ 
ΠΕΛΑΤΗ ΝΑ ΠΑΡΕΧΕΙ ΥΠΗΡΕΣΙΕΣ ΜΕΤΑΦΡΑΣΗΣ.

•  ΜΗΝ ΕΠΙΧΕΙΡΗΣΕΤΕ ΤΗΝ ΕΚΤΕΛΕΣΗ ΕΡΓΑΣΙΩΝ ΣΕΡΒΙΣ ΣΤΟΝ ΕΞΟΠΛΙΣΜΟ 
ΕΚΤΟΣ ΕΑΝ ΕΧΕΤΕ ΣΥΜΒΟΥΛΕΥΤΕΙ ΚΑΙ ΕΧΕΤΕ ΚΑΤΑΝΟΗΣΕΙ ΤΟ ΠΑΡΟΝ 
ΕΓΧΕΙΡΙΔΙΟ ΣΕΡΒΙΣ.

•  ΕΑΝ ΔΕ ΛΑΒΕΤΕ ΥΠΟΨΗ ΤΗΝ ΠΡΟΕΙΔΟΠΟΙΗΣΗ ΑΥΤΗ, ΕΝΔΕΧΕΤΑΙ ΝΑ 
ΠΡΟΚΛΗΘΕΙ ΤΡΑΥΜΑΤΙΣΜΟΣ ΣΤΟ ΑΤΟΜΟ ΠΑΡΟΧΗΣ ΣΕΡΒΙΣ, ΣΤΟ ΧΕΙΡΙΣΤΗ Ή 
ΣΤΟΝ ΑΣΘΕΝΗ ΑΠΟ ΗΛΕΚΤΡΟΠΛΗΞΙΑ, ΜΗΧΑΝΙΚΟΥΣ Ή ΑΛΛΟΥΣ ΚΙΝΔΥΝΟΥΣ.

•  EZEN KARBANTARTÁSI KÉZIKÖNYV KIZÁRÓLAG ANGOL NYELVEN ÉRHETŐ 
EL.

•  HA A VEVŐ SZOLGÁLTATÓJA ANGOLTÓL ELTÉRŐ NYELVRE TART IGÉNYT, 
AKKOR A VEVŐ FELELŐSSÉGE A FORDÍTÁS ELKÉSZÍTTETÉSE.

•  NE PRÓBÁLJA ELKEZDENI HASZNÁLNI A BERENDEZÉST, AMÍG A 
KARBANTARTÁSI KÉZIKÖNYVBEN LEÍRTAKAT NEM ÉRTELMEZTÉK.

•  EZEN FIGYELMEZTETÉS FIGYELMEN KÍVÜL HAGYÁSA A SZOLGÁLTATÓ, 
MŰKÖDTETŐ VAGY A BETEG ÁRAMÜTÉS, MECHANIKAI VAGY EGYÉB 
VESZÉLYHELYZET MIATTI SÉRÜLÉSÉT EREDMÉNYEZHETI.

•  ÞESSI ÞJÓNUSTUHANDBÓK ER EINGÖNGU FÁANLEG Á ENSKU.
•  EF ÞJÓNUSTUAÐILI VIÐSKIPTAMANNS ÞARFNAST ANNARS TUNGUMÁLS EN 

ENSKU, ER ÞAÐ Á ÁBYRGÐ VIÐSKIPTAMANNS AÐ ÚTVEGA ÞÝÐINGU.
•  REYNIÐ EKKI AÐ ÞJÓNUSTA TÆKIÐ NEMA EFTIR AÐ HAFA SKOÐAÐ OG SKILIÐ 

ÞESSA ÞJÓNUSTUHANDBÓK.
•  EF EKKI ER FARIÐ AÐ ÞESSARI VIÐVÖRUN GETUR ÞAÐ VALDIÐ MEIÐSLUM 

ÞJÓNUSTUVEITANDA, STJÓRNANDA EÐA SJÚKLINGS VEGNA RAFLOSTS, 
VÉLRÆNNAR EÐA ANNARRAR HÆTTU.

VAROITUS 

ΠΡΟΕΙΔΟΠΟΙΗΣΗ 

FIGYELMEZTETÉS 

VIÐVÖRUN
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•  TENTO SERVISNÍ NÁVOD EXISTUJE POUZE V ANGLICKÉM JAZYCE.
•  V PŘÍPADĚ, ŽE POSKYTOVATEL SLUŽEB ZÁKAZNÍKŮM POTŘEBUJE NÁVOD V 

JINÉM JAZYCE, JE ZAJIŠTĚNÍ PŘEKLADU DO ODPOVÍDAJÍCÍHO JAZYKA 
ÚKOLEM ZÁKAZNÍKA. 

•  NEPROVÁDĚJTE ÚDRŽBU TOHOTO ZAŘÍZENÍ, ANIŽ BYSTE SI PŘEČETLI 
TENTO SERVISNÍ NÁVOD A POCHOPILI JEHO OBSAH.

•  V PŘÍPADĚ NEDODRŽOVÁNÍ TÉTO VÝSTRAHY MŮŽE DOJÍT ÚRAZU 
ELEKTRICKÁM PROUDEM PRACOVNÍKA POSKYTOVATELE SLUŽEB, 
OBSLUŽNÉHO PERSONÁLU NEBO PACIENTŮ VLIVEM ELEKTRICKÉHOP 
PROUDU, RESPEKTIVE VLIVEM K RIZIKU MECHANICKÉHO POŠKOZENÍ NEBO 
JINÉMU RIZIKU.

•  DENNE SERVICEMANUAL FINDES KUN PÅ ENGELSK.
•  HVIS EN KUNDES TEKNIKER HAR BRUG FOR ET ANDET SPROG END 

ENGELSK, ER DET KUNDENS ANSVAR AT SØRGE FOR OVERSÆTTELSE.
•  FORSØG IKKE AT SERVICERE UDSTYRET MEDMINDRE

DENNE SERVICEMANUAL ER BLEVET LÆST OG FORSTÅET.
•  MANGLENDE OVERHOLDELSE AF DENNE ADVARSEL KAN MEDFØRE SKADE 

PÅ GRUND AF ELEKTRISK, MEKANISK ELLER ANDEN FARE FOR TEKNIKEREN, 
OPERATØREN ELLER PATIENTEN.

•  DEZE ONDERHOUDSHANDLEIDING IS ENKEL IN HET ENGELS 
VERKRIJGBAAR.

•  ALS HET ONDERHOUDSPERSONEEL EEN ANDERE TAAL VEREIST, DAN IS DE 
KLANT VERANTWOORDELIJK VOOR DE VERTALING ERVAN.

•  PROBEER DE APPARATUUR NIET TE ONDERHOUDEN VOORDAT DEZE 
ONDERHOUDSHANDLEIDING WERD GERAADPLEEGD EN BEGREPEN IS.

•  INDIEN DEZE WAARSCHUWING NIET WORDT OPGEVOLGD, ZOU HET 
ONDERHOUDSPERSONEEL, DE OPERATOR OF EEN PATIËNT GEWOND 
KUNNEN RAKEN ALS GEVOLG VAN EEN ELEKTRISCHE SCHOK, 
MECHANISCHE OF ANDERE GEVAREN.

•  ŠĪ APKALPES ROKASGRĀMATA IR PIEEJAMA TIKAI ANGĻU VALODĀ.
•  JA KLIENTA APKALPES SNIEDZĒJAM NEPIECIEŠAMA INFORMĀCIJA CITĀ 

VALODĀ, NEVIS ANGĻU, KLIENTA PIENĀKUMS IR NODROŠINĀT TULKOŠANU.
•  NEVEICIET APRĪKOJUMA APKALPI BEZ APKALPES ROKASGRĀMATAS 

IZLASĪŠANAS UN SAPRAŠANAS.
•  ŠĪ BRĪDINĀJUMA NEIEVĒROŠANA VAR RADĪT ELEKTRISKĀS STRĀVAS 

TRIECIENA, MEHĀNISKU VAI CITU RISKU IZRAISĪTU TRAUMU APKALPES 
SNIEDZĒJAM, OPERATORAM VAI PACIENTAM.

VÝSTRAHA

ADVARSEL

WAARSCHUWING

BRĪDINĀJUMS
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•  ŠIS EKSPLOATAVIMO VADOVAS YRA IŠLEISTAS TIK ANGLŲ KALBA.
•  JEI KLIENTO PASLAUGŲ TEIKĖJUI REIKIA VADOVO KITA KALBA – NE ANGLŲ, 

VERTIMU PASIRŪPINTI TURI KLIENTAS.
•  NEMĖGINKITE ATLIKTI ĮRANGOS TECHNINĖS PRIEŽIŪROS DARBŲ, NEBENT 

VADOVAUTUMĖTĖS ŠIUO EKSPLOATAVIMO VADOVU IR JĮ SUPRASTUMĖTE
•  NEPAISANT ŠIO PERSPĖJIMO, PASLAUGŲ TEIKĖJAS, OPERATORIUS AR 

PACIENTAS GALI BŪTI SUŽEISTAS DĖL ELEKTROS SMŪGIO, MECHANINIŲ AR 
KITŲ PAVOJŲ.

•  DENNE SERVICEHÅNDBOKEN FINNES BARE PÅ ENGELSK.
•  HVIS KUNDENS SERVICELEVERANDØR TRENGER ET ANNET SPRÅK, ER DET 

KUNDENS ANSVAR Å SØRGE FOR OVERSETTELSE.
•  IKKE FORSØK Å REPARERE UTSTYRET UTEN AT DENNE 

SERVICEHÅNDBOKEN ER LEST OG FORSTÅTT.
•  MANGLENDE HENSYN TIL DENNE ADVARSELEN KAN FØRE TIL AT 

SERVICELEVERANDØREN, OPERATØREN ELLER PASIENTEN SKADES PÅ 
GRUNN AV ELEKTRISK STØT, MEKANISKE ELLER ANDRE FARER.

•  NINIEJSZY PODRĘCZNIK SERWISOWY DOSTĘPNY JEST JEDYNIE W JĘZYKU 
ANGIELSKIM.

•  JEŚLI FIRMA ŚWIADCZĄCA KLIENTOWI USłUGI SERWISOWE WYMAGA 
UDOSTĘPNIENIA PODRĘCZNIKA W JĘZYKU INNYM NIŻ ANGIELSKI, 
OBOWIĄZEK ZAPEWNIENIA STOSOWNEGO TłUMACZENIA SPOCZYWA NA 
KLIENCIE.

•  NIE PRÓBOWAĆ SERWISOWAĆ NINIEJSZEGO SPRZĘTU BEZ UPRZEDNIEGO 
ZAPOZNANIA SIĘ Z PODRĘCZNIKIEM SERWISOWYM.

•  NIEZASTOSOWANIE SIĘ DO TEGO OSTRZEŻENIA MOżE GROZIĆ 
OBRAŻENIAMI CIAłA SERWISANTA, OPERATORA LUB PACJENTA W WYNIKU 
PORAŻENIA PRĄDEM, URAZU MECHANICZNEGO LUB INNEGO RODZAJU 
ZAGROŻEŃ.

•  ACEST MANUAL DE SERVICE ESTE DISPONIBIL NUMAI ÎN LIMBA ENGLEZĂ.
•  DACĂ UN FURNIZOR DE SERVICII PENTRU CLIENŢI NECESITĂ O ALTĂ LIMBĂ 

DECÂT CEA ENGLEZĂ, ESTE DE DATORIA CLIENTULUI SĂ FURNIZEZE O 
TRADUCERE.

•  NU ÎNCERCAŢI SĂ REPARAŢI ECHIPAMENTUL DECÂT ULTERIOR 
CONSULTĂRII ŞI ÎNŢELEGERII ACESTUI MANUAL DE SERVICE.

•  IGNORAREA ACESTUI AVERTISMENT AR PUTEA DUCE LA RĂNIREA 
DEPANATORULUI, OPERATORULUI SAU PACIENTULUI ÎN URMA 
PERICOLELOR DE ELECTROCUTARE, MECANICE SAU DE ALTĂ NATURĂ.

ĮSPĖJIMAS

ADVARSEL

OSTRZEŻENIE

ATENŢIE
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•  ДАННОЕ РУКОВОДСТВО ПО ОБСЛУЖИВАНИЮ ПРЕДОСТАВЛЯЕТСЯ 
ТОЛЬКО НА АНГЛИЙСКОМ ЯЗЫКЕ.

•  ЕСЛИ СЕРВИСНОМУ ПЕРСОНАЛУ КЛИЕНТА НЕОБХОДИМО РУКОВОДСТВО 
НЕ НА АНГЛИЙСКОМ ЯЗЫКЕ, КЛИЕНТУ СЛЕДУЕТ САМОСТОЯТЕЛЬНО 
ОБЕСПЕЧИТЬ ПЕРЕВОД.

•  ПЕРЕД ОБСЛУЖИВАНИЕМ ОБОРУДОВАНИЯ ОБЯЗАТЕЛЬНО ОБРАТИТЕСЬ 
К ДАННОМУ РУКОВОДСТВУ И ПОЙМИТЕ ИЗЛОЖЕННЫЕ В НЕМ СВЕДЕНИЯ.

•  НЕСОБЛЮДЕНИЕ УКАЗАННЫХ ТРЕБОВАНИЙ МОЖЕТ ПРИВЕСТИ К ТОМУ, 
ЧТО СПЕЦИАЛИСТ ПО ТЕХОБСЛУЖИВАНИЮ, ОПЕРАТОР ИЛИ ПАЦИЕНТ 
ПОЛУЧАТ УДАР ЗЛЕКТРИЧЕСКИМ ТОКОМ, МЕХАНИЧЕСКУЮ ТРАВМУ ИЛИ 
ДРУГОЕ ПОВРЕЖДЕНИЕ. 

•  TÁTO SERVISNÁ PRÍRUČKA JE K DISPOZÍCII LEN V ANGLIČTINE.
•  AK ZÁKAZNÍKOV POSKYTOVATEĽ SLUŽIEB VYŽADUJE INÝ JAZYK AKO 

ANGLIČTINU, POSKYTNUTIE PREKLADATEĽSKÝCH SLUŽIEB JE 
ZODPOVEDNOSŤOU ZÁKAZNÍKA. 

•  NEPOKÚŠAJTE SA VYKONÁVAŤ SERVIS ZARIADENIA SKÔR, AKO SI 
NEPREČÍTATE SERVISNÚ PRÍRUČKU A NEPOROZUMIETE JEJ.

•  ZANEDBANIE TOHTO UPOZORNENIA MÔŽE VYÚSTIŤ DO ZRANENIA 
POSKYTOVATEĽA SLUŽIEB, OBSLUHUJÚCEJ OSOBY ALEBO PACIENTA 
ELEKTRICKÝM PRÚDOM, PRÍPADNE DO MECHANICKÉHO ALEBO INÉHO 
NEBEZPEČENSTVA.

•  DEN HÄR SERVICEHANDBOKEN FINNS BARA TILLGÄNGLIG PÅ ENGELSKA.
•  OM EN KUNDS SERVICETEKNIKER HAR BEHOV AV ETT ANNAT SPRÅK ÄN 

ENGELSKA ANSVARAR KUNDEN FÖR ATT TILLHANDAHÅLLA 
ÖVERSÄTTNINGSTJÄNSTER.

•  FÖRSÖK INTE UTFÖRA SERVICE PÅ UTRUSTNINGEN OM DU INTE HAR LÄST 
OCH FÖRSTÅR DEN HÄR SERVICEHANDBOKEN.

•  OM DU INTE TAR HÄNSYN TILL DEN HÄR VARNINGEN KAN DET RESULTERA I 
SKADOR PÅ SERVICETEKNIKERN, OPERATÖREN ELLER PATIENTEN TILL 
FÖLJD AV ELEKTRISKA STÖTAR, MEKANISKA FAROR ELLER ANDRA FAROR.

•  BU SERVİS KILAVUZU YALNIZCA İNGİLİZCE OLARAK SAĞLANMIŞTIR.
•  EĞER MÜŞTERİ TEKNİSYENİ KILAVUZUN İNGİLİZCE DIŞINDAKİ BİR DİLDE 

OLMASINI İSTERSE, KILAVUZU TERCÜME ETTİRMEK MÜŞTERİNİN 
SORUMLULUĞUNDADIR.

•  SERVİS KILAVUZUNU OKUYUP ANLAMADAN EKİPMANLARA MÜDAHALE 
ETMEYİNİZ.

•  BU UYARININ GÖZ ARDI EDİLMESİ, ELEKTRİK ÇARPMASI YA DA MEKANİK 
VEYA DİĞER TÜRDEN KAZALAR SONUCUNDA TEKNİSYENİN, OPERATÖRÜN 
YA DA HASTANIN YARALANMASINA YOL AÇABİLİR.

ОСТОРОЖНО!

UPOZORNENIE

VARNING

DİKKAT
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DAMAGE IN TRANSPORTATION
All packages should be closely examined at time of delivery. If damage is apparent write “Damage In 
Shipment” on ALL copies of the freight or express bill BEFORE delivery is accepted or “signed for” by 
a GE representative or hospital receiving agent. Whether noted or concealed, damage MUST be 
reported to the carrier immediately upon discovery, or in any event, within 14 days after receipt, and the 
contents and containers held for inspection by the carrier. A transportation company will not pay a claim 
for damage if an inspection is not requested within this 14 day period.

CERTIFIED ELECTRICAL CONTRACTOR STATEMENT - FOR USA ONLY
All electrical Installations that are preliminary to positioning of the equipment at the site prepared for the 
equipment shall be performed by licensed electrical contractors. Other connections between pieces of 
electrical equipment, calibrations and testing shall be performed by qualified GE Healthcare personnel. 
In performing all electrical work on these products, GE will use its own specially trained field engineers. 
All of GE’s electrical work on these products will comply with the requirements of the applicable 
electrical codes.

The purchaser of GE equipment shall only utilize qualified personnel (i.e., GE’s field engineers, 
personnel of third-party service companies with equivalent training, or licensed electricians) to perform 
electrical servicing on the equipment.

OMISSIONS & ERRORS
If there are any omissions, errors or suggestions for improving this documentation, please contact the 
GE Healthcare Global Documentation Group with specific information listing the system type, manual 
title, part number, revision number, page number and suggestion details. Mail the information to: 
Service Documentation, 9900 Innovation Drive (RP-2123), Wauwatosa, WI   53226, USA.

GE Healthcare employees should use the iTrak System to report all documentation errors or omissions.
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LEGAL NOTES

The contents of this publication may not be copied or duplicated in any form, in whole or in part, without 
prior written permission of GE Healthcare.

GE Healthcare may revise this publication from time to time without written notice.

TRADEMARKS
All products and their name brands are trademarks of their respective holders.

COPYRIGHTS
All Material Copyright© 2007 by General Electric Company Inc. All Rights Reserved
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Chapter 1
Introduction

Section 1-1
Overview

1-1-1 Purpose of Chapter 1
This chapter describes important issues related to safely servicing the LOGIQworks.
The service provider must read and understand all the information presented in this manual before 
installing or servicing a unit.

1-1-2 Purpose of Service Manual
This Service Manual provides installation and service information for the LOGIQworks and contains the 
following chapters:

1.) Chapter 1 - Introduction: Contains a content summary and warnings.
2.) Chapter 2 - Pre-Installation: Contains any pre-installation requirements for the LOGIQworks.
3.) Chapter 3 - Installation: Contains the LOGIQworks installation procedure with installation 

checklist.
4.) Chapter 4 - Functional Checks: Contains functional checks that must be performed as part of the 

installation, or as required during servicing and periodic maintenance.
5.) Chapter 5 - Components and Functions (Theory): Contains block diagrams and functional 

explanations of the LOGIQworks electronics.
6.) Chapter 6 - Service Adjustments: Contains instructions on how to make available adjustments to 

the LOGIQworks.
7.) Chapter 7 - Diagnostics/Troubleshooting: Provides procedures for running diagnostic or related 

routines for the LOGIQworks.
8.) Chapter 8 - Replacement Procedures: Provides disassembly procedures and reassembly 

procedures for all changeable Field Replaceable Units (FRU).
9.) Chapter 9 - Renewal Parts: Contains a complete list of replacement parts for the LOGIQworks.
10.)Chapter 10 - Quality Assurance: Provides periodic maintenance procedures for the LOGIQworks.

Table 1-1    Contents in Chapter 1

Section Description Page Number

1-1 Overview 1-1

1-2 Important Conventions 1-4

1-3 Safety Considerations 1-7

1-4 Customer Assistance 1-19
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1-1-3 Typical Users of the Basic Service Manual

• Service Personnel (installation, maintenance, etc.).
• Hospital’s Service Personnel. Third party Service institutions.
• Architects (Some parts of the Pre-Installation Section).
• GE Service Personnel (Installation, Maintenance).

1-1-4 LOGIQworks Models covered by this Manual

Table 1-2    LOGIQworks Standard Hardware of System based on Dell Precision 340
(delivered from April 2003 to April 2004)

Table 1-3    LOGIQworks Standard Hardware of System based on Dell Precision 360 (delivered 
since May 2004 until December 2004)

PART PC CRT1 CRT2 LCD1 LCD2 Modem

BTU/h 860 495 495 195 195 164

Power (W) 250 135 135 57 57 48 Total BTU/h

LO
G

IQ
w

or
ks

 M
od

el
s H49021LA x x x 1520

H49021LB x x x x 2015

H49021LC x x x 1220

H49021LD x x x x 1415

PART PC LCD1 LCD2 Modem

BTU/h 860 195 195 164

Power (W) 250 57 57 48 Total BTU/h

LO
G

IQ
w

or
ks

 M
od

el
s H49021AA x x x 1520

H49021AB x x x x 2015

H49021AC x x x 1220

H49021AD x x x 1415
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1-1-4 LOGIQworks Models covered by this Manual (cont’d)

Table 1-4    LOGIQworks Standard Hardware of System based on Dell Precision 370 (delivered 
from December 2004 until November 2005)

Table 1-5    LOGIQworks Standard Hardware of System based on Dell Precision 380 (delivered 
from November 2005) and on Dell Precision 390 (delivered from December 2006)

1-1-4-1 How to Turn the LOGIQworks workstation on/off
See chapter 3, Section 3-4-4 on page 3-60.

1-1-4-2 How to Check for Hardware/Software version, Options
See chapter 3, Section 3-5-13 on page 3-203.

1-1-5 Purpose of Operator Manual(s)
The Operator Manual(s), Part Numbers available in chapter 9, should be fully read and understood 
before operating the LOGIQworks workstation and also kept near the unit for quick reference.

PART PC LCD1 LCD2 Modem

BTU/h 860 195 195 164

Power (W) 250 57 57 48 Total BTU/h

LO
G

IQ
w

or
ks

 M
od

el
s H49021AA x x x 1520

H49021AB x x x x 2015

H49021AC x x x 1220

H49021AD x x x 1415

PART PC LCD1 LCD2 Modem

BTU/h 1280 195 195 164

Power (W) 375 57 57 48 Total BTU/h

LO
G

IQ
w

or
ks

 M
od

el
s H49021AK x x x 1639

H49021AL x x x x 1834

H49021AM x x x 1639

H49021AN x x x 1639
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Section 1-2
Important Conventions

1-2-1 Conventions Used in Book
Model Designations

This manual covers the LOGIQworks PC.

(See Chapter 1 - LOGIQworks Models covered by this Manual on page 1-2.)

Icons

Pictures, or icons, are used wherever they reinforce the printed message. The icons, labels and 
conventions used on the product and in the service information are described in this chapter.

Safety Precaution Messages

Various levels of safety precaution messages may be found on the equipment and in the service 
information. The different levels of concern are identified by a flag word that precedes the precautionary 
message. Known or potential hazards are labeled in one of following ways:

WARNINGWARNING Warnings that must take heed of to protect the patients / users against the danger of injury.

CAUTION Warnings that must be heeded to avoid causing damage to the equipment.

NOTE General or additional information relating to specific topics.
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1-2-2 Standard Hazard Icons
Important information will always be preceded by the exclamation point contained within a triangle, as 
seen throughout this chapter. In addition to text, several different graphical icons (symbols) may be 
used to make you aware of specific types of hazards that could cause harm.

Other hazard icons make you aware of specific procedures that should be followed.

Table 1-6    Standard Hazard Icons

ELECTRICAL MECHANICAL RADIATION

LASER HEAT PINCH

Table 1-7    Standard Icons Indicating a Special Procedure be Used

AVOID STATIC ELECTRICITY TAG AND LOCK OUT WEAR EYE PROTECTION

LASER
LIGHT

Signed Date

TAG 
& 

LOCKOUT
EYE

PROTECTION
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1-2-3 Product Icons
The following table describes the purpose and location of safety labels and other important information 
provided on the equipment.

Table 1-8    Product Icons 

LABEL/SYMBOL PURPOSE/MEANING LOCATION

Identification and Rating Plate
Manufacturer's name and address
Model and serial numbers
Electrical ratings

On top of PC

Device Listing/Certification Labels
Laboratory logo or labels denoting 
conformance with industry safety standards 
such as UL or IEC.

Rear side of the unit
Rear side of the monitor

Type/Class Label Used to indicate the degree of safety or protection.

“CAUTION
This unit weighs...

Special care must be used to avoid..."
This precaution is intended to prevent injury 
that may result if one person attempt to move 
the unit considerable distances or on an incline 
due to the weight of the unit.

Service Manual

"CAUTION" The equilateral triangle is usually 
used in combination with other symbols to 
advise or warn the user.

Various

ATTENTION - Consult accompanying 
documents " is intended to alert the user to 
refer to the operator manual or other 
instructions when complete information cannot 
be provided on the label.

Various

"CAUTION - Dangerous voltage" (the lightning 
flash with arrowhead in equilateral triangle) is 
used to indicate electric shock hazards.

Various

"Mains OFF" Indicates the power off position of 
the mains power switch. ON/OFF switches
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Section 1-3
Safety Considerations

1-3-1 Safety Hints
If hardware from different manufacturers as ViewPoint is used Safety Notes are in their responsibility. 
So also see in the relevant manuals.

"OFF/Standby" Indicates the power off/
standby position of the power switch.
CAUTION
This Power Switch DOES NOT ISOLATE 
Mains Supply

ON/OFF switches

"Mains ON" Indicates the power on position of 
the mains power switch.

"Protective Earth" Indicates the protective 
earth (grounding) terminal.

"Equipotentiality" Indicates the terminal to be 
used for connecting equipotential conductors 
when interconnecting (grounding) with other 
equipment.

“Nonionizing Radiation” indicates that the 
system applies RF energy.

Rear of printer near power inlet

WARNINGWARNING For hardware related risks please pay attention to the safety instructions of the DELL hardware 
manuals (e.g. System Information Guide).

Table 1-8    Product Icons (Continued)

LABEL/SYMBOL PURPOSE/MEANING LOCATION
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1-3-1 Safety Hints (cont’d)

Figure 1-1   Sketch of the patient’s environment

WARNINGWARNING Danger of Electrical Shock!

Danger of Electrical Shock!

A connection between the patient and a personal computer can result in risks for the patient from 
electric current. Consider, therefore, these safety references:

– Use only CE marked electrical equipment!

– Install a galvanic isolator to insulate the connection between the personal computer and all 
connected medical equipment (e.g. fibre optic cable or certified video isolator)!

– Set up the personal computer outside the patient's vicinity (1.5 m/4.9 ft.)!

Use only CE marked galvanic isolators or medical devices appropriate under 
EN/IEC 60601-1 and EN/IEC 60601-1-1!

WARNINGWARNING Danger of Electromagnetic Incompatibility!

Devices that are not CE marked can create an electromagnetic field which could impair the 
operation of other devices.

To prevent this, check if the device is CE marked or FCC-marked.
Use only CE marked devices and medical devices appropriate under 
EN/IEC 60601-1-2.
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1-3-1 Safety Hints (cont’d)

WARNINGWARNING Danger of False Diagnosis!
Danger of Data Loss!

Personal computers can be affected by electromagnetic fields from other devices.

Do not place devices which could cause electromagnetic interference near the personal computer!

WARNINGWARNING Danger of False Diagnosis!

An incorrect monitor or incorrect monitor configuration can lead to false diagnosis.

Adjust the monitor to display the images in adequate quality according to the manufacturer's 
instructions for use. If in doubt, please contact your service representative.

WARNINGWARNING Danger of Data Loss!

System connected to the inter-/intranet could be infected by a computer virus. This infection can result 
in a loss of data or falsified data or an unoperable system.

The user has to ensure that the LOGIQworks system is protected from viruses, e.g. by using antivirus 
programs, firewalls and regular updates for antivirus programs, firewalls and the operation system. 

WARNINGWARNING Danger of Data Loss!

Activation of the function for automatic deletion of patient studies might cause data loss.
 
To avoid this back up your data frequently.

CAUTION
Danger of Power Failure!

We recommend to install an UPS (Uninterruptible Power Supply) if frequent power failure occurs.

CAUTION
Danger of Inoperable System!

LOGIQworks should be installed by a GE service technician to avoid unoperable system.
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1-3-2 Label Locations of System based on Dell Precision 340
Sony Labels only. Guarantee agreement

1.) CE-Label
2.) VDE-Label
3.) UL-Label
4.) Identification plate 
5.) Homologation label (for Japan only) 

Figure 1-2  Labeling

3 21 4 5
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1-3-2 Label Locations of System based on Dell Precision 340 (cont’d)

Figure 1-3   Computer Tower Labelling

Power Input 
Information

Tower Rear

Tower Top Side 
(Seen from front)

Front

Serial Number
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1-3-2 Label Locations of System based on Dell Precision 340 (cont’d)

Figure 1-4  CRT Monitor Labels

Figure 1-5  LCD NEC 1880 Monitor Labels

Serial Number

CRT Monitor, seen 
from the rear

LCD Monitor seen 
from the rear
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1-3-2 Label Locations of System based on Dell Precision 340 (cont’d)

Figure 1-6  Recovery CD Label with Rating Plate Label

Figure 1-7  Modem Labels

Modem seen from below
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1-3-3 Label Locations of System based on Dell Precision 360 and Dell Precision 370

Figure 1-8  Computer Tower Labeling

Power Input 
Information

Tower Rear

Tower Top Side 
(Seen from front)

Front

Serial Number
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1-3-3 Label Locations of System based on Dell Precision 360 and Dell Precision 370 
(cont’d)

Tower Front

Figure 1-9  Additional Computer Labeling for Dell Precision 370 only
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1-3-3 Label Locations of System based on Dell Precision 360 and Dell Precision 370 
(cont’d)

Figure 1-11   LCD DELL 1901 Monitor Labels

Figure 1-10   LCD DELL 2001 Monitor Labels

LCD Monitor seen 
from the rear

LCD Monitor seen 
from the rear
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1-3-4 Label Locations of System based on Dell Precision 380 and Dell Precision 390

Figure 1-13   

Figure 1-12  Computer Tower Labeling

Tower Rear

Tower Bottom Side 

Tower Top Side 
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1-3-5 Label Locations

Figure 1-14  Recovery CD Label with Rating Plate Label

Figure 1-15  Modem Label

Modem seen from below
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Section 1-4
Customer Assistance

1-4-1 Contact Information
If this equipment does not work as indicated in this service manual or in the Basic User Manual, or if 
you require additional assistance, please contact the local distributor or appropriate support resource, 
as listed below.

Prepare the following information before you call:

• System ID serial number.
• Software version.

Table 1-9    Phone Numbers for Customer Assistance

Location Phone Number

USA/Canada
GE Medical Systems
Ultrasound Service Engineering
4855 W. Electric Avenue
Milwaukee, WI 53219

Customer Answer Center

Service
1-800-437-1171
1-800-321-7937 (Latin America)
1-800-668-0732 (Canada)
Applications
1-800-682-5327
1-262-524-5698
Fax: +1-414-647-4125

Europe
GE Ultraschall Deutschland GmbH & Co. KG
Beethovenstraße 239
Postfach 11 05 50, D-42665 Solingen
Germany

Tel: +33 130831300 (General Imaging & Cardiac)

Fax: +49-212 2802 431

Asia Singapore/Japan)
GE Ultrasound Asia
Service Department - Ultrasound
298 Tiong Bahru Road #15-01/06
Central Plaza
Singapore 169730

Asia Support Center - Singapore
Phone: +65-6291-8528
Fax: +65-6291-7006

Japan Support Center
Phone: 81-426-48-2940
Fax: 81-426-48-2905



GE MEDICAL SYSTEMS
DIRECTION 5184024-100, REVISION  5 LOGIQWORKS® BASIC SERVICE MANUAL 

1-20 Section 1-4 - Customer Assistance

1-4-2 System Manufacturer

Table 1-10    Phone Numbers for Customer Assistance

Manufacturer Phone Number

ViewPoint Bildverarbeitung GmbH
Argelsrieder Feld 12
D-82234 Wessling
GERMANY

(+49) 8153 9311 0
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Chapter 2
Pre-Installation

Section 2-1
Overview

2-1-1 Purpose of Chapter 2
This chapter provides the information required to plan and prepare for the installation of a LOGIQworks. 
Included are descriptions of the facility and electrical needs to be met by the purchaser of the unit. A 
checklist is also provided at the end of this section to help determine whether the proper planning and 
preparation is accomplished before the actual equipment installation is scheduled.

Table 2-1    Contents in Chapter 2

Section Description Page Number

2-1 Overview 2-1

2-2 General Console Requirements 2-2

2-3 Facility Needs 2-11
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Section 2-2
General Console Requirements

2-2-1 Environmental Requirements of System based on Dell Precision 340

Table 2-2    Dell Precision 340 Workstation

Table 2-3    NEC LCD 1880 Monitor

Table 2-4    Global Modem

2-2-1-1 Cooling
The cooling requirement for the LOGIQworks is within the range 1220-2100 BTU/hr. This is depending 
on whether a CRT Monitor or LCD Monitor is used, and on the hardware options installed. For detailed 
BTU/hr. see table 2-7 and table 2-8. The BTU/hr. value relates to the maximum operational Power 
consumption of the LOGIQworks Workstation. This figure does not include cooling needed for lights, 
people, or other equipment in the room. Each person in the room places an additional 300 BTU/hr. 
Demand on the cooling system.

Operation Non-Operation Storage Transport

Temperature 10 to 35 oC

(50 to 95 oF)

-40 to 65 oC

(- 40 to 149oF)

-40 to 65 oC

(- 40 to 149oF)

-40 to 65 oC

(-40 to 149 oF)

Humidity
20% to 80% 

non-condensing
20% to 80%

non-condensing
20% to 80%

non-condensing
20% to 80%

non-condensing

Altitude
-52 - 10000ft
-16 - 3048 m

-52 - 34777ft
-16 - 10600 m

52 - 34777ft
-16 - 10600 m

52 - 34777ft
-16 - 10600 m

Operation Non-Operation Storage Transport

Temperature 5 to 35 oC

(41to 95oF)

-10 to 60 oC

(- 14 to 140oF)

-10 to 60 oC

(-14 to 140oF)

-10 to 60 oC

(-14 to 140 oF)

Humidity
30% to 80% 

non-condensing
10% to 85%

non-condensing
10% to 85%

non-condensing
10% to 85

non-condensing

Altitude 0 - 15912ft
0 - 4850m

0 - 45000ft
0 - 13716m

0 - 45000ft
0 - 13716m

0 - 45000ft
0 - 13716m

Operation Non-Operation Storage Transport

Temperature 0 to 50 oC

(32 to 120oF)

0 to 50 oC

(32 to 120oF)

-20 to 70 oC

(-4 to 158oF)

-20 to 70 oC

(-4 to 158oF)

Humidity
20% to 90% 

non-condensing 
20% to 90% 

non-condensing
20% to 90% 

non-condensing
20% to 90% 

non-condensing

Altitude N/A N/A N/A N/A
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2-2-1-1 Cooling (cont’d)

Table 2-5    LOGIQworks Standard Hardware of System based on Dell Precision 340

2-2-1-2 Lighting
Bright light is needed for system installation, updates and repairs. However, operator and patient 
comfort may be optimized if the room light is subdued and indirect. Therefore a combination lighting 
system (dim/bright) is recommended. Keep in mind that lighting controls and dimmers can be a source 
of EMI which could degrade image quality. These controls should be selected to minimize possible 
interference.

PART PC CRT1 CRT2 LCD1 LCD2 Modem

BTU/HR 860 495 495 195 195 164

Power (W) 250 135 135 57 57 48 Total BTU/HR

LO
G

IQ
w

or
ks

 M
od

el
s

H49021LA x x x 1520

H49021LB x x x x 2015

H49021LC x x x 1220

H49021LD x x x x 1415
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2-2-2 Environmental Requirements of System based on Dell Precision 360, on Dell 
Precision 370, on Dell Precision 380 or on Dell Precision 390

 

Table 2-8 Global Modem

2-2-2-1 Cooling
The cooling requirement for the LOGIQworks is within the range 1220-2100 BTU/hr. This is depended 
on which hardware options that have been installed. For detailed BTU/hr. see table 2-7 and table 2-8. 
The BTU/hr. value relates to the maximum operational Power consumption of the LOGIQworks 
Workstation. This figure does not include cooling needed for lights, people, or other equipment in the 
room. Each person in the room places an additional 300 BTU/hr. Demand on the cooling system.

Table 2-6 Dell Precision 360, Dell Precision 370, Dell Precision 380, Dell Precision 
390 Workstation

Operation Storage Transport

Temperature 10 to 35 oC

(50 to 95 oF)

-40 to 65 oC

(- 40 to 149oF)

-40 to 65 oC

(-40 to 149 oF)

Humidity
20% to 80% 

non-condensing
20% to 80%

non-condensing
20% to 80

non-condensing

Altitude
-52 - 10000ft
-16 - 3048 m

52 - 34777ft
-16 - 10600 m

52 - 34777ft
-16 - 10600 m

Table 2-7 DELL LCD 1901, DELL LCD 2001 Monitor

Operation Storage Transport

Temperature 5 to 35 oC

41 to 95 oF

0 to 60oC

32 to 140 oF

-20 to 60 oC

-4 to 140oF

Humidity 10% to 80%
non-condensing

5% to 90%
non-condensing

5% to 90%
non-condensing

Altitude 3,657.6m (12,000 ft) 
max.

12,192 m (40,000 ft) 
max

12,192 m (40,000 ft) 
max

Operation Storage Transport

Temperature 0 to 50 oC

(32 to 120oF)

-20 to 70 oC

(-4 to 158oF)

-20 to 70 oC

(-4 to 158oF)

Humidity
20% to 90% 

non-condensing 
20% to 90% 

non-condensing
20% to 90% 

non-condensing

Altitude N/A N/A N/A
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2-2-2-1 Cooling (cont’d)

Table 2-9    LOGIQworks Standard Hardware of DELL Precision 360 and DELL Precision 370

PART PC LCD1 LCD2 Modem

BTU/h 860 195 195 164

Power (W) 250 57 57 48 Total BTU/h

LO
G

IQ
w

or
ks

 M
od

el
s H49021AC x x x 1220

H49021AD x x x x 1415

H49021AA x x x 1220

H49021AB x x x x 1415

Table 2-10    LOGIQworks Standard Hardware of DELL Precision 380 and of Dell 390

PART PC LCD1 LCD2 Modem

BTU/h 1280 195 195 164

Power (W) 357 57 57 48 Total BTU/h

LO
G

IQ
w

or
ks

 M
od

el
s H49021AK x x x 1220

H49021AL x x x x 1415

H49021AM x x x 1220

H49021AN x x x 1415
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2-2-2-1 Cooling (cont’d)

2-2-2-2 Lighting
Bright light is needed for system installation, updates and repairs. However, operator and patient 
comfort may be optimized if the room light is subdued and indirect. Therefore a combination lighting 
system (dim/bright) is recommended. Keep in mind that lighting controls and dimmers can be a source 
of EMI which could degrade image quality. These controls should be selected to minimize possible 
interference.

2-2-3 Time and Manpower Requirements
Site preparation takes time. Begin Pre-installation checks as soon as possible, if possible, six weeks 
before delivery, to allow enough time to make any changes.

Table 2-11    LOGIQworks Optional Hardware

PART Modem

BTU/h 164

Power (W) 48 Total BTU/h

All x 164

Table 2-12    Average Installation Time

Description Average Installation 
Time

Comments

Unpacking 15 minutes 1 person

Checking delivery 15 minutes 1 person

Installation of
LOGIQworks 

1.0 hour 1 person 

Check connectivity 
and setup

15 minutes 1 person
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2-2-4 Electrical Requirements

2-2-4-1 LOGIQworks Power Requirements
Electrical Specifications for LOGIQworks

Table 2-13    Electrical Specifications of LOGIQworks System based on Dell Precision 340

 

 

2-2-4-2 Inrush Current
230 VAC:2.5A

100 VAC: 5A

2-2-4-3 Site Circuit Breaker
It is recommended that the branch circuit breaker for the machine be readily accessible.

2-2-4-4 Site Power Outlets
Three to five AC power outlet must be less than 1.2 meters (3.9feet) from the LOGIQworks Workstation. 
Electrical installation must meet all current local, state, and national electrical codes.

NOTE LOGIQworks requires a dedicated power and ground for the proper operation of its workstation. This 
dedicated power shall originate at the last distribution panel before the system. The dedicated line shall 
consist of one phase, a neutral (not shared with any other circuit), and a full size ground wire from the 
distribution panel to the workstation. Please note that image artifacts can occur, if at any time within the 
facility, the ground from the main facility's incoming power source to the workstation is only a conduit.

GEVU P/N Voltage Tolerances Power Frequency

H49021LA 110 - 230 VAC ±10% 398W 50-60 Hz

H49021LB 110 - 230 VAC ±10% 543W 50-60 Hz

H49021LC 110 - 230VAC ±10% 310W 50-60 Hz

H49021LD 110 - 230VAC ±10% 367W 50-60 Hz

Table 2-14    Electrical Specifications for LOGIQworks System based on Dell Precision 360 or 
on Dell Precision 370

GEVU P/N Voltage Tolerances Power Frequency

H49021AA/AC 110 - 230VAC ±10% 310W 50-60 Hz

H49021AB/AD 110 - 230VAC ±10% 367W 50-60 Hz

Table 2-15    Electrical Specifications for LOGIQworks System based on Dell Precision 380 or 
on Dell Precision 390

GEVU P/N Voltage Tolerances Power Frequency

H49021AK/AM 110 - 230VAC ±10% 375W 50-60 Hz

H49021AL/AN 110 - 230VAC ±10% 375W 50-60 Hz
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2-2-4-4 Site Power Outlets (cont’d)

2-2-4-5 Unit Power Plug
If the unit arrives without a power plug, or with the wrong plug, you must contact GE Service; they must 
supply what is locally required.

WARNINGWARNING POWER OUTAGE MAY OCCUR. 
The LOGIQworks requires a dedicated single branch circuit. To avoid circuit overload and 
possible loss of critical care equipment, make sure you DO NOT have any other equipment 
operating on the same circuit.
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2-2-5 EMI Limitations

Computers are susceptible to Electromagnetic Interference (EMI) from radio frequencies, magnetic 
fields, and transients in the air or wiring. They also generate EMI. The LOGIQworks complies with limits 
as stated on the EMC label. However there is no guarantee that interference will not occur in a particular 
installation.

Possible EMI sources should be identified before the unit is installed. 

Electrical and electronic equipment may produce EMI unintentionally as the result of a defect. 
These sources include: 

• medical lasers, 
• scanners, 
• cauterizing guns, 
• computers, 
• monitors, 
• fans, 
• gel warmers, 
• microwave ovens,
• light dimmers 
• portable phones. 
The presence of a broadcast station or broadcast van may also cause interference.

see Table 2-16 for EMI Prevention tips

 

WARNINGWARNING Danger of Electromagnetic Incompatibility!

Devices that are not CE marked can create an electromagnetic field which could impair the operation 
of other devices.

To prevent this, check if the device is CE marked or FCC-marked.
Use only CE marked devices and medical devices appropriate under 
EN/IEC 60601-1-2.

WARNINGWARNING Danger of False Diagnosis!
Danger of Data Loss!

Personal computers can be affected by electromagnetic fields from other devices.

Do not place devices which could cause electromagnetic interference near the personal computer!

Table 2-16    EMI Prevention/Abatement

EMI Rule Details

Be aware of RF sources
Keep the unit at least 5 meters or 15 feet away from other EMI sources. Special shielding may 
be required to eliminate interference problems caused by high frequency, high powered radio 
or video broadcast signals.

Ground the unit Poor grounding is the most likely reason a unit will have noisy images. Check grounding of the 
power cord and power outlet.
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Take care with cellular 
phones Cellular phones may transmit a 5 V/m signal; that could cause image artifacts. 

Table 2-16    EMI Prevention/Abatement

EMI Rule Details
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Section 2-3
Facility Needs

2-3-1 Purchaser Responsibilities
The work and materials needed to prepare the site is the responsibility of the purchaser. Delay, 
confusion, and waste of manpower can be avoided by completing pre installation work before delivery. 
Use the Pre installation checklist to verify that all needed steps have been taken. Purchaser 
responsibility includes:

• Procuring the materials required.
• Completing the preparations before delivery of the LOGIQworks.
• Paying the costs for any alterations and modifications not specifically provided in the sales contract.

The desire to use a non–listed or customer provided product or to place an approved product further 
from the workstation than the interface kit allows presents challenges to the installation team. To avoid 
delays during installation, such variances should be made known to the individuals or group performing 
the installation at the earliest possible date (preferably prior to the purchase).

The workstation suite must be clean prior to delivery of the machine. Carpet is not recommended 
because it collects dust and creates static. Potential sources of EMI (electromagnetic interference) 
should also be investigated before delivery. Dirt, static, and EMI can negatively impact system reliability.

2-3-2 Required Features
• Dedicated single branch power outlets of adequate amperage (see Table 2-14) meeting all local 

and national codes which is located less than 1.5 m (5 ft.) from the workstation’s proposed location.
• Proposed location for the workstation is at least 0.3 m (1 ft.) from the wall for cooling.
• Power outlet and place for any external peripheral are within 2 m (6.6ft) of each other with peripheral 

within 1 m of the unit to connect cables.
• Power outlets for test equipment within 1 m (3.3 ft.) of PC.
• Either an Analog Phone Line, or a GE Approved Broadband/VPN connection, is required for iLinq. 

A functional LAN is required for Network connectivity.
• An Ethernet network wall jack is required.

2-3-3 Desirable Features
• Circuit breaker for dedicated power outlet is easily accessible.
• Dual level lighting (bright and dim).
• Lockable cabinet ordered by GE for its software and proprietary manuals.

WARNINGWARNING All electrical installations that are preliminary to the positioning of the equipment at the site prepared for 
the equipment must be performed by licensed electrical contractors. Other connections between pieces 
of electrical equipment, calibrations, and testing must also be performed by qualified personnel. The 
products involved (and the accompanying electrical installations) are highly sophisticated and special 
engineering competence is required. All electrical work on these products must comply with the 
requirements of applicable electrical codes. The purchaser of GE equipment must only utilize qualified 
personnel to perform electrical servicing on the equipment.
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2-3-3 Desirable Features (cont’d)

 

 

Figure 2-1   Minimum room needs for LOGIQworks

Figure 2-2   Suggested Maximum Room with LOGIQworks and Ultrasound Scanner

3 to 4 dedicated Power outlets

Vivid 3

A dedicated Ethernet network wall outlet

Work Station parts

A dedicated Analog Telephone jack

1m14cm

304.8 cm

243,84 cm

A dedicated Power 
outlet

A dedicated Ethernet 
network wall outlet

LOGIQworksparts 

A dedicated Analog 
Telephone jack

3 to 4 dedicated Power outlets 
A dedicated Ethernet network wall outlet

A dedicated Analog Telephone jack

Hot & Cold water

609.6 cm

243,84 cm

105cm

1.5m
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2-3-3-1 Patient environment IEC 60601-1-1
An area in which patients are normally cared for, the patient vicinity is the space with surfaces likely to 
be contacted by the patient or attendant who can touch the patient.

In practice a distance of 2,5 m (8.2 ft.) above the floor on which the medical personnel stand and a 
horizontal distance of 1,5 m (4.9 ft.) have justified themselves as indicative of the dimensions of the 
Patient Environment.

The patient environment/vicinity will be depicted as a dashed line in this procedure. See example below.

2-3-3-2 Patient environment IEC 601-1
Sub clause 2.204 

Such an area is an environment in which medical diagnosis, monitoring or treatment is carried out. It is 
very difficult to attach unique dimensions to the PATIENT ENVIRONMENT.

WARNINGWARNING Danger of Electrical Shock!

Danger of Electrical Shock!

A connection between the patient and a personal computer can result in risks for the patient from 
electric current. Consider, therefore, these safety references:

– Use only CE marked electrical equipment!

– Install a galvanic isolator to insulate the connection between the personal computer and all 
connected medical equipment (e.g. fibre optic cable or certified video isolator)!

– Set up the personal computer outside the patient's vicinity (1.5 m/4.9 ft.)!

Use only CE marked galvanic isolators or medical devices appropriate under 
EN/IEC 60601-1 and EN/IEC 60601-1-1!

Figure 2-3   Patient safety information



GE MEDICAL SYSTEMS
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS BASIC SERVICE MANUAL

2-14 Section 2-3 - Facility Needs

2-3-4 Networking Pre-installation Requirements

2-3-4-1 LOGIQworks Connected to a Network
Supported networks:

• 10 or 100 Megabit Network can be used.

2-3-4-2 Stand Alone Network or Integrated into Hospital’s Network
If LOGIQworks is to be used in a separate network together with a LOGIQ 9 or LOGIQ 7 and a network 
printer with no connection to the Hospital’s network or LOGIQworks is to be on the Hospital network 
either the predefined factory settings should be used.

2-3-4-3 DICOM Network Option Pre-Installation Requirements
To configure the LOGIQworks to work with other network connections, the site’s network administrator 
must provide information to complete the Data Collection Document on page 14. Ensure that there are 
no spaces in any field of the form except for those fields under PHYSICAL LOCATION. Entries must 
include: 

• Verify that there is a Conformancy Statement that documents the DICOM server you are about to 
use supports Ultrasound images.

• A host name, local port number, AE Title, IP address and Net Mask for the LOGIQworks. 
• The IP addresses for the default gateway and other routers at the site for ROUTING 

INFORMATION.
• The host name, IP address, port and AE Title for each device the site wants connected to the 

LOGIQworks for DICOM APPLICATION INFORMATION. Fields for Description, Institution Name, 
Institution Department Name and Station Name are also available to describe the sending devices 
in more detail. This information may be useful for error solving. 

2-3-4-4 Insite 2
For Insite 2 a connection to the internet is required.

Recommendation: A permanent broadband to the internet. The customer is responsible for the 
connectivity, configuration and operation of this internet access funktionality.
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2-3-4-4 Insite 2 (cont’d)

Figure 2-4  Data Collection Document Page 1



GE MEDICAL SYSTEMS
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS BASIC SERVICE MANUAL

2-16 Section 2-3 - Facility Needs

2-3-4-4 Insite 2 (cont’d)

Figure 2-5  Data Collection Document Page 2
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2-3-4-4 Insite 2 (cont’d)

Figure 2-6  Data Collection Document Page 3
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2-3-4-4 Insite 2 (cont’d)

Figure 2-7  Data Collection Document Page 4
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2-3-4-4 Insite 2 (cont’d)

Figure 2-8  Data Collection Document Page 5
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Your Notes:
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Chapter 3
Installation

Section 3-1
Overview

3-1-1 The Purpose of Chapter 3
This chapter contains information NEEDED to install the UNIT, a procedure that describes how to 
receive and unpack the equipment and how to file a damage or loss claim. 

How to prepare the facility and unit of the actual installation, and how to check and test the unit and 
external peripherals for electrical safety are included in this procedure.

3-1-2 Average Installation Time
For time and personnel estimates during the installation see: Section 2-2-3 "Time and Manpower 
Requirements" on page 2-6.

Table 3-1    Contents in Chapter 3

Section Description Page Number

3-1 Overview 3-1

3-2 Receiving and Unpacking the Equipment 3-3

3-3 Preparing for Installation 3-22

3-4 Completing the Installation 3-25

3-5 Configuration 3-68

3-6 Software Upgrades 3-205
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3-1-3 Safety Reminders
 

 

WARNINGWARNING WHEN USING ANY TEST INSTRUMENT THAT IS CAPABLE OF OPENING THE 
AC GROUND LINE (I.E., METER’S GROUND SWITCH IS OPEN), DON’T TOUCH 
THE UNIT!

WARNINGWARNING Two people should unpack the unit because of its weight. Two people are required whenever a part 
weighing 22 kg (50 lbs.) or more must be lifted.

CAUTION If the unit is very cold or hot, do not turn on its power until it has had a chance to acclimate to its 
operating environment.

Table 3-2    LOGIQworks Acclimate Time

°C -40 -35 -30 -25 -20 -15 -10 -5 0 5 10 15 20 25 30 35 40 45 50 55 60

°F -40 -31 -22 -13 -4 5 -50 41 32 41 50 59 68 77 86 95 104 113 122 131 140

hrs 20 18 16 14 12 10 8 6 4 2 0 0 0 0 0 0 0 2 4 6 8

WARNINGWARNING To prevent electrical shock, connect the unit to a properly grounded power outlet. Do not use a 
three to two prong adapter. This defeats safety grounding.

WARNINGWARNING OPERATOR MANUAL(S) 
The User Manual(s) should be fully read and understood before operating the LOGIQworks and 
kept near the unit for quick reference.
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Section 3-2
Receiving and Unpacking the Equipment

3-2-1 Shipment Description
From the source factory all LOGIQworks parts are packed in the original packaging and put into a card-
board box.

3-2-1-1 Check of Delivered Box
1.) Check that cardboard box is undamaged as it was shipped.

2.) Check that they match the contents on the included Delivery Note.
3.) Check that each box is undamaged and unopened.
4.) Open each of these cardboard boxes.
5.) Check that contents are there and undamaged.
6.) Move the shipment to the place where it is to be installed.
7.) Unpack the Parts, run the check list shown below.
8.) Handling Incomplete or Damaged Shipment.
Please read that procedure before packing/unpacking the LOGIQworks.

User Manual(s):

Check that the correct User Manual(s) for the system and software revision is included with the 
installation. Specific language versions of the User Manual may also be available. Check with your GE 
Sales Representative for availability.

We strongly advise you to store the LOGIQworks packing material in undamaged condition in case of 
future transportation.

CAUTION Do not accept if damaged!
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3-2-1-1 Check of Delivered Box (cont’d)

WARNINGWARNING
Transport only with forklift or stracker truck.
During transport pay attention to the point of gravity!

Have two people available to unpack the LOGIQworks. 
Attempts to move the unit considerable distances or on an incline by one person could result 
in injury or damage or both.

Figure 3-1  Shipping packaging and envelope at front panel of the crate

CAUTION The device must only be transported in the original packaging!
Unpack the devices such a way that packaging can be reused.

Check whether delivery is complete (according to 
packing list) and check visual damage!

The envelope with delivery address, packing list and
invoice is located on the front panel of the crate. 

Shipping packaging, cut the black ribbon 
with a knife and unpack the system com-
ponents
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3-2-1-1Check of Delivered Box (cont’d)

Table 3-3    The LOGIQworks H49021LC parts

Figure 3-2  The LOGIQworks H49021LC delivery

Name Qty

1 Dell Precision 340 1

2 Monitor NEC LCD 1880 Sx 1

3 Modem 1

1

2

3
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3-2-1-1Check of Delivered Box (cont’d)

Table 3-4    The LOGIQworks H49021LD parts

Figure 3-3  The LOGIQworks H49021LD delivery

Name Qty

1 Dell Precision 340 1

2 Monitor NEC LCD 1880 Sx 2

3 Modem 1

1

2

3
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3-2-1-1Check of Delivered Box (cont’d)

Table 3-5    The LOGIQworks H49021LA parts

Figure 3-4  The LOGIQworks H49021LA delivery

Item Name Qty

1 Dell Precision 340 1

2 Monitor Sony GMD-F520 1

3 Modem 1

1

2

3
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3-2-1-1Check of Delivered Box (cont’d)

Table 3-6    The LOGIQworks H49021LB parts

Figure 3-5  The LOGIQworks H49021LB delivery

Name Qty

1 Dell Precision 340 1

2 Monitor Sony GMD-F520 2

3 Modem 1

1

2

3
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3-2-1-1Check of Delivered Box (cont’d)

Figure 3-6  The LOGIQworks H49021AC/H49021AA or H49021AK/H49021AM delivery.

Table 3-7    The LOGIQworks 1FP H49021AA/H49021AC parts

Name Qty

1
Dell Precision 360

or 
Dell Precision 370

1

2 Monitor Dell LCD 1901 Europe 1

3 Monitor Dell LCD 2001 US/ASIA 1

Table 3-8    The LOGIQworks 1FP H49021AK/H49021AM parts

Name Qty

1
Dell Precision 380

or 
Dell Precision 390

1

2 Monitor Dell LCD 1901 Europe 1

3 Monitor Dell LCD 2001 US/ASIA 1

1

2 3
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3-2-1-1Check of Delivered Box (cont’d)

Figure 3-7  The LOGIQworks H49021AD/H49021AB or H49021AL/H49021AN delivery

Table 3-9    The LOGIQworks H49021AD/H49021AB parts

Name Qty

1
Dell Precision 360

or
Dell Precision 370

1
or
1

2 Monitor Dell LCD 1901 Europe 2

Monitor Dell LCD 2001 US/Asia 2

Table 3-10    The LOGIQworks H49021AL/H49021AN parts

Name Qty

1
Dell Precision 380

or
Dell Precision 390

1

2 Monitor Dell LCD 1901 Europe 2

Monitor Dell LCD 2001 US/Asia 2

1

2
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3-2-1-2 Contents of CPU Box

3-2-1-2-1 Contents of CPU Box of System based on Dell Precision 340

Table 3-11    Contents of CPU Box of System based on Dell Precision 340

Figure 3-8  Contents of CPU Box

Item Name Qty

1 Dell Precision 340 1

2 US Keyboard 1

3 Installation Guide Setup 1

4 Quick Reference Guide 1

5 System Information Guide 1

6 PS/2 Mouse 1

7 Power Cable German 1

8 Y-Monitor Cable digital 1

9 Y-Monitor Cable analog 1

10 Windows 2000 CD 1

11 Utility CDs 1

2

1

3

4

5

6

7

8

9

10

11
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3-2-1-2-2 Contents of CPU Box of System based on Dell Precision 360 or on Dell Precision 370

Figure 3-9  Contents of CPU Box of System based on Dell Precision 360 or on Dell Precision 370

Table 3-12    Contents of CPU Box of System based on Dell Precision 360 or 
on Dell Precision 370

Item Name Qty

1 Dell Precision 340 1

2 US Keyboard 1

3 Installation Guide Setup 1

4 Quick Reference Guide 1

5 System Information Guide 1

6 PS/2 Mouse 1

7 Power Cable German 1

8 Windows 2000 CD 1

9 Utility CDs 1

1

2 3

4

5

6
7

8

9
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3-2-1-2-3 Contents of CPU Box of System based on Dell Precision 380 and Dell Precision 390

Figure 3-10  Contents of CPU Box of System based on Dell Precision 380 and Dell Precision 390

Table 3-13    Contents of CPU Box of System based on Dell Precision 380 
and Dell Precision 390 

Item Name Qty

1 Dell Precision 380/Dell Precision 390 1

2 US Keyboard 1

3 Installation Guide Setup 1

4 Quick Reference Guide 1

5 System Information Guide 1

6 USB Mouse 1

7 Power Cable German 1

8 Windows XP CD 1

9 Utility CDs 1

1

2 3

4

5

6

7

8

9
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3-2-1-3 Additional Parts in CPU Box

3-2-1-3-1 Additional Parts in CPU Box of System based on Dell Precision 340

Table 3-14    CPU Box parts list

Figure 3-11  Additional Parts in CPU Box

Item Name Qty.

1 Basic Service Manual 1

2 Quick Guide with User Manual CD 1

3 Quick Card 1

4 Cat5 Patch cable 1

5 Optical USB Mouse 1

6 Recovery CD’s 1

7 USB Harddisk 1

8 RA 600 Dongle 1

9 Release Notes 1

10 Log on Informations 1

11 3-5 Power cords, if not shipped to Germany 3-5

1

2 3

4

5

6

7

8

9

10

11
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3-2-1-3-2 Additional Parts in CPU Box of System based on Dell Precision 360, Dell Precision 370, Dell
Precision 380 and Dell Precision 390

 

 

Figure 3-12   Additional Parts in CPU Box of System based on Dell Precision 360, Dell Precision 370, Dell 
Precision 380 and Dell Precision 390

Table 3-15    CPU Box parts list

Item Name Qty.

1 Quick Card 1

2 Quick Guide 1

3 Basic Service Manual 1

4 Cat5 Patch cable 1

5 Cat5 Cross Over Patch cable
(for Europe only) 1

6 2 Power cords, if not shipped to Germany 2

7 Recovery CD 1

8 User Documentation CD 1

1

2

4

5

6 7 9

11

3

8

10

12

13

14

15

16



GE MEDICAL SYSTEMS
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS BASIC SERVICE MANUAL

3-16 Section 3-2 - Receiving and Unpacking the Equipment

9 Optical USB Mouse 1

10 Software Option Dongle 1

11 USB Harddisk 3-5

13 Instant CD/DVD

15 Powercord FP2001US for US only 1-2

16 Y-Monitor cable 1

Table 3-15    CPU Box parts list

Item Name Qty.
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3-2-1-4 LCD Monitor

3-2-1-4-1 LCD Monitor of System based on Dell Precision 340

Table 3-16    Contents of LCD Monitor

Figure 3-13  Parts in the LCD delivery of System based on Dell Precision 340

Item Name Qty.

1 Monitor, LCD 1

2 Signal Cable analog 1

3 Signal Cable digital 1

4 Power Cable EU* 1

5 Documentation 1

(*If not shipped to Germany, the EU power 
cord is not used; see Table 3-22 and

Table 3-23 for power cord information)

1

2

3

4

5
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3-2-1-4-2 LCD Monitor of System based on Dell Precision 360, Dell Precision 370, Dell Precision 380 or Dell
Precision 390

Figure 3-14  Parts in the LCD delivery of System based on Dell Precision 360, Dell Precision 370, Dell Precision 
380 or Dell Precision 390

Table 3-17    Contents of LCD monitor of System based on Dell Precision 360, Dell 
Precision 370, Dell Precision 380 or Dell Precision 390

Item Part Name Qty

1 Monitor, LCD 1

2 Power Supply 1

3 Power Cable US 1

4 USB Cable 1

5 Signal Cable analog 1

6 Software CD 1

7 Installation Manual 1

1

2 3 4 5
6

7
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3-2-1-5 Sony CRT Monitor

Table 3-18    Contents of CRT Monitor Box

Figure 3-15  Parts in the CRT delivery

Item Name Qty

1 Monitor CRT 1

2 Signal Cable analog 1

3 Power Cable EU* 1

4 Documentation 1

(*If not shipped to Germany, the EU 
power cord is not used; see Table 3-22 

and Table 3-23 for power cord 
information)

1

2

3

4
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3-2-1-6 Modem Kit Parts Delivery Inspection 

3-2-1-6-1 Modem Kit Parts Delivery Inspection of System based on Dell Precision 340

Table 3-19    Modem Kit 066E0796 Parts Table

Figure 3-16  Modem Kit 066E0796 Parts overview.

ITE
M Name Part Number Qty.

1 Read Me First Document Part of GE Part Number 2245794 1

2 Modem GE Part Number 2245794 1

3 Telephone cable Part of GE Part Number 2245794 1

4 Telephone Wire Part of GE PartNumber 2245794 1

5 AC/DC Power convertor Part of GE Part Number 2245794 1

6 Power Cable Part of GE Part Number 2245794 1

7 Plastic bag with 4 Stand-Offs Part of GE Part Number 2245794 1

8 Velcro-fasteners Part of GE Part Number 2245794 1

9 Installation manual Part of GE Part Number 2245794 1

10 Telephone jack adapters Part of GE Part Number 2245794 1

1

2

3

4

5

6
7

8

9

10
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3-2-1-6-2 Modem Parts Delivery Inspection of System based on Dell Precision 360, Dell Precision 370, Dell
Precision 380 and Dell Precision 390

Table 3-20    Modem Parts Table

Figure 3-17  Modem Parts overview.

ITE
M Name Part Number Qty.

1 Installation CD Part of GE Part Number 2413338 1

2 Modem GE Part Number 2413338 1

3 Telephone cable Part of GE Part Number 2413338 1

4 Quick Start Guide Part of GE Part Number 2413338 1

5 Telephone Wire Part of GE PartNumber 2413338 1

6 Plastic bag with 4 Stand-Offs Part of GE Part Number 2413338 1

3

1

2

3

4

5

6



GE MEDICAL SYSTEMS
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS BASIC SERVICE MANUAL

3-22 Section 3-3 - Preparing for Installation

Section 3-3
Preparing for Installation

3-3-1 Physical Inspection

3-3-1-1 LOGIQworks Voltage Settings
• Verify that the LOGIQworks has the correct voltage delivery. 

Figure 3-18  Correct Voltage Settings

Table 3-21    International Voltage and Frequencies settings

Country V Hz

Argentina 220 50

Australia 230 50

Austria 230 50

Bahamas 120 60

Belgium 230 50

Brazil 110/220 60

Canada 120 60

China, People’s Republic of 220 50

Croatia 230 50

Czech Republic 230 50

Denmark 230 50

Egypt 220 50

Finland 230 50

Switch 110/220V
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France 230 50

Germany 230 50

Great Britain 230 50

Greece 220 50

Hong Kong 220 50

Hungary 230 50

Iceland 220 50

India 240 50

Israel 230 50

Italy 230 50

Japan 100 50/60

Korea, South 220 60

Luxembourg 220 50

Mexico 127 60

Monaco 127/220 50

Netherlands 230 50

New Zealand 230 50

Norway 230 50

Poland 230 50

Portugal 220 50

Russian Federation 220 50

Singapore 230 50

Slovak Republic 230 50

South Africa 220/230 50

Spain 230 50

Sweden 230 50

Switzerland 230 50

Taiwan 110 60

Turkey 230 50

United States of America 120 60

Table 3-21    International Voltage and Frequencies settings

Country V Hz
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3-3-1-2 Power Cables

Table 3-22    Power Cable for DELL PC and DELL Monitor FP1901, Multitech Modem

Name Part Number

Power Cord US 2369732

Power Cord French 2369733

Power Cord German 2369734

Power Cord Italian 2369735

Power Cord Spanish 2369736

WARNINGWARNING Connecting The LOGIQworks to a wrong voltage level destroys the LOGIQworks. 

Table 3-23    Power Cable for DELL Monitor 2001

Name Part Number

Power Cord US 2409670
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Section 3-4
Completing the Installation

3-4-1 System Specifications

3-4-1-1 Physical Dimensions of LOGIQworks
The physical dimensions of the LOGIQworks main parts are summarized in Table 3-25.
Table 3-27 lists the weight of LOGIQworks, with monitor and without on-board peripherals.

Table 3-24    Physical Dimension Table of System based on Dell Precision 340

Unit Description Height Width Depth Unit

DellPrecision 340 42.5 18.1 44.7 cm

17.0 7.1 17.5. Inches

Sony GDM F520 49.9 49.7 48.7 cm

19.0 19.4 19.0 Inches

NEC LCD 1880 39.4 38.7 18.0 cm

15.0 15.1 7.0 Inches

Modem 10.9 2.5 14.5 cm

4.3 1.0 5.7 Inches

Table 3-25    Physical Dimensions table of System based on Dell Precision 360, Dell Precision 
370, Dell Precision 380 or on Dell Precision 390

Unit Description Height Width Depth Unit

Dell Precision 360
Dell Precision 370

42.5 18.1 44.7 cm

17.0 7.1 17.5 Inches

Dell Precision 380
Dell Precision 390

44.5 16.5 45.7 cm

17.5 6.5 18 Inches

DELL LCD 1901 39.4 38.7 18.0 cm

15.0 15.1 7.0 Inches

Modem 10.9 2.5 14.5 cm

4.3 1.0 5.7 Inches

DELL LCD 2001 39.4 38.7 18.0 cm

15.0 15.1 7.0 Inches
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3-4-1-2 Required Space for LOGIQworks Installation

Figure 3-19  Required Space for System with 1 CRT Monitor

Figure 3-20  Required Space for System with 2 CRT Monitors

min. 100

min. 80cm
recommended 100 cm

70 cm

CRT 1

Keyboard
Mouse

min. 140cm

min. 80cm
recommended 100 cm

120 cm

CRT 1 CRT 2

Keyboard
Mouse



GE MEDICAL SYSTEMS  
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS® BASIC SERVICE MANUAL 

Chapter 3 Installation 3-27

3-4-1-2 Required Space for LOGIQworks Installation (cont’d)

Figure 3-21   Required Space for System with 1 LCD Monitor

Figure 3-22   Required Space for System with 2 LCD Monitors

min. 80

min. 80cm
recommended 100 cm

60 cm

LCD 1

Keyboard
Mouse

min. 120 cm

min. 80cm
recommended 100 cm

100 cm

LCD 1 LCD 2

Keyboard
Mouse
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3-4-1-3 Weight

3-4-1-3-1 Weight of System based on Dell Precision 340

Table 3-26    Weight table of System based on Dell Precision 340

3-4-1-3-2 Transport of PC and Monitor
The weight of PC and Monitor exceeds 25lbs. To prevent injuries form carrying PC and Monitor, cut 
the delivered box (See “3-2-1-1 Check of Delivered Box (cont’d)” on page 4.) and move PC and 
Monitor to the installation location.

3-4-1-4 Acoustic Noise Output
max. 57dB(A)

3-4-2 Electrical Specifications
To see the Electrical Specifications for the LOGIQworks see Table 2-14 on page 2-7.

Power Consumption nominal 550 VA including all options.

.

Model Weight [kg] Weight [lbs]

Dell Precision 340 9.9 21.83

LOGIQworksw/CRT Monitor 30.5 67.24

LOGIQworksw/LCD Monitor 8.2 18.08

Modem 0.2 0.5

Table 3-27    Weight table of System based on Dell Precision 360, Dell Precision 370, on Dell 
Precision 380 or on Dell Precision 390

Model Weight [kg] Weight [lbs]

Dell Precision 360
Dell Precision 370 9.9 21.83

Dell Precision 380
Dell Precision 390 17.7 39

LOGIQworks/LCD Monitor 8.2 18.08

Modem 0.2 0.5

WARNINGWARNING Modification of voltage setting only by an authorized service person! Output power: 550VA per mains 
outlet, max. power of all connected accessories must not exceed 550VA.
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3-4-3 Installing LOGIQworks at the Site

3-4-3-1 Place the Parts ergonomically correct.
 

1.) Place the Monitor, Keyboard, Mouse, Peripherals, Desk and stool ergonomically correct and place 
the Tower Computer either on the floor below the desk or on the desk top. Some prefer the 
computer topside while others prefer it down below.

Figure 3-23   Work Station w/ Monitor, Keyboard, PC, Mouse

Tower PC 
mounted on the floor
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3-4-3-2 Single LCD Monitor Installation of System based on Dell Precision 340
Items needed:

Figure 3-24  Items needed for Single LCD Monitor Installation of System based on Dell Precision 340

1
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5

6

7

8

9

10
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3-4-3-2 Single LCD Monitor Installation of System based on Dell Precision 340 (cont’d)

Table 3-28    Items needed for Single LCD Monitor Installation

Item Name Qty

1 Dell Precision 340 1

2 Monitor NEC LCD 1880 Sx 1

3 Signal Cable digital 1

4 Y-Monitor Cable digital 1

5 Cat5 Patch cable 1

6 RA600 Dongle 1

7

Keyboard US
Keyboard France
Keyboard German

Keyboard Italy
Keyboard Spain

1

8 Optical USB Mouse 1

9 USB Hard Disk 1

10 Power Cord 2
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3-4-3-3 Single LCD Monitor Installation of System based on Dell Precision 360 or on Dell Precision 370
Items needed:

Figure 3-25  Items needed for Single LCD Monitor Installation of System based on Dell Precision 360 or on Dell 
Precision 370

1

23

4

5

6

7

8

9

10

11



GE MEDICAL SYSTEMS  
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS® BASIC SERVICE MANUAL 

Chapter 3 Installation 3-33

3-4-3-3 Single LCD Monitor Installation of System based on Dell Precision 360 or on Dell Precision 370 
(cont’d)

Table 3-29    Items needed for Single LCD Monitor Installation

Item Name Qty

1
Dell Precision 360

or
Dell Precision 370

1

2 Monitor Dell LCD 1901 or LDCD 2001 1

3 Signal Cable digital 1

4 Cat5 Patch cable 1

5

Keyboard US
Keyboard France
Keyboard German

Keyboard Italy
Keyboard Spain

1

6 Optical USB Mouse 1

7 USB Hard Disk 1

8 Power Cord 2

9 Software Option Dongle 1

10 RA600 Dongle 1

11 Y-Monitor Cable (DELL 370 only) 1
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3-4-3-4 Single LCD Monitor Installation of System based on Dell Precision 380 and Dell Precision 390
Items needed:

Figure 3-26  Items needed for Single LCD Monitor Installation of System based on Dell Precision 380 and Dell 
Precision 390
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3-4-3-4 Single LCD Monitor Installation of System based on Dell Precision 380 and Dell Precision 390 
(cont’d)

Table 3-30   Items needed for Single LCD Monitor Installation

Item Name Qty

1 Dell Precision 380/Dell Precision 390 1

2 Monitor Dell LCD 1901 or LDCD 2001 1

3 Signal Cable digital 1

4 Cat5 Patch cable 1

5

Keyboard US
Keyboard France
Keyboard German

Keyboard Italy
Keyboard Spain

1

6 Optical USB Mouse 1

7 USB Hard Disk 1

8 Power Cord 2

9 Software Option Dongle 1

10 RA600 Dongle (not used if permanent 
License is installed) 1

11 Y-Monitor Cable 1
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3-4-3-5 Double LCD Monitor Installation of System based on Dell Precision 340

Figure 3-27  Items needed for Double LCD Monitor Installation of System based on Dell Precision 340
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3-4-3-5 Double LCD Monitor Installation of System based on Dell Precision 340 (cont’d)

Table 3-31    Double LCD Monitor Installation

Item Name Qty

1 Dell Precision 340 1

2 Monitor NEC LCD 1880 Sx 2

3 Signal Cable digital 2

4 Y-Monitor Cable digital 1

5 Cat5 Patch cable 1

6 RA600 Dongle 1

7

Keyboard US
Keyboard France
Keyboard German

Keyboard Italy
Keyboard Spain

1

8 Optical USB Mouse 1

9 USB Hard Disk 1

10 Power Cord 3
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3-4-3-6 Double LCD Monitor Installation of System based on Dell Precision 360 or on Dell Precision 370

Figure 3-28  Items needed for Double LCD Monitor Installation of System based on Dell Precision 360 or Dell 
Precision 370
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3-4-3-6 Double LCD Monitor Installation of System based on Dell Precision 360 or on Dell Precision 370 
(cont’d)

Table 3-32    Items needed for Double LCD Monitor Installation

Item Name Qty

1
Dell Precision 360

or
Dell Precision 370

1

2 Monitor Dell LCD 1901 or LCD 2001 2

3 Signal Cable digital 2

4 Cat5 Patch cable 1

5

Keyboard US
Keyboard France
Keyboard German

Keyboard Italy
Keyboard Spain

1

6 Optical USB Mouse 1

7 USB Hard Disk 1

8 Power Cord 3

9 Software Option Dongle 1

10 RA600 Dongle 1

11 Y-Monitor cable (DELL 360 only) 1
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Table 3-33    Double LCD Monitor Installation of System based on Dell Precision 380 and Dell 
Precision 390

Figure 3-29  Items needed for Double LCD Monitor Installation of System based on Dell Precision 380 and Dell 
Precision 390

1

2

4

5

6

7

8

9
10

11

3



GE MEDICAL SYSTEMS  
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS® BASIC SERVICE MANUAL 

Chapter 3 Installation 3-41

3-4-3-6 Double LCD Monitor Installation of System based on Dell Precision 360 or on Dell Precision 370 
(cont’d)

Table 3-34    Items needed for Double LCD Monitor Installation

Item Name Qty

1 Dell Precision 380/Dell Precision 390 1

2 Monitor Dell LCD 1901 or LCD 2001 2

3 Signal Cable digital 2

4 Cat5 Patch cable 1

5

Keyboard US
Keyboard France
Keyboard German

Keyboard Italy
Keyboard Spain

1

6 Optical USB Mouse 1

7 USB Hard Disk 1

8 Power Cord 3

9 Software Option Dongle 1

10 RA600 Dongle 1

11 Y-Monitor cable 1
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3-4-3-7 Single CRT Monitor Installation

Figure 3-30  Items for Single CRT Monitor Installation
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3-4-3-7 Single CRT Monitor Installation (cont’d)

Table 3-35    Items for Single CRT Monitor Installation

Item Name Qty

1 Dell Precision 380/Dell Precision 390 1

2 Monitor Sony GDM F520 1

3 Signal Cable analog 1

4 Y-Monitor Cable analog 1

5 Cat5 Patch cable 1

6 RA600 Dongle 1

7

Keyboard US
Keyboard France
Keyboard German

Keyboard Italy
Keyboard Spain

1

8 Optical USB Mouse 1

9 USB Hard Disk 1

10 Power Cord 2
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3-4-3-8 Double CRT Monitor Installation
Items needed:

Figure 3-31  Items needed for Double CRT Monitor Installation
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3-4-3-8 Double CRT Monitor Installation (cont’d)

Table 3-36    Items for Double CRT Monitor Installation

Item Name Qty Part Number

1 Dell Precision 340 1 2365947

2 Monitor Sony GDM F520 2 2365798

3 Signal Cable analog 2 2368273

4 Y-Monitor Cable analog 1 2368269

5 Cat5 Patch cable 1 2366640

6 RA600 Dongle 1 see Centricity RA600 Service Manual - Renewal Parts 
chapter 10, page 269

7

Keyboard US
Keyboard France
Keyboard German

Keyboard Italy
Keyboard Spain

1

236635
2369714
2369631
2369725
2369730

8 Optical USB Mouse 1 2366634

9 USB Hard Disk 1 2365958

10 Power Cord 3 see Table 3-22
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3-4-3-9 Connections at rear of PC of System based on Dell Precision 340

Figure 3-32  Connections at rear of PC of System based on Dell Precision 340

Y-Monitor Cable

DVD IEEE 1394

Computer 
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Keyboard 
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Mouse
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USB HDD
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3-4-3-10 Mouse and USB Harddisk Connection of Dell Precision 360

1.) Connect the Mouse to one of the USB Connectors.
2.) Connect the USB Harddisk to the other USB Connector.
3.) Connect the USB Software Option Dongle.
4.) Connect the parallel RA600 Dongle.

3-4-3-11 Keyboard and Network Connection of Dell Precision 360

1.) Connect PS2 Cable from the keyboard, that has a red plug, to the left hand PS2 Connector at the 
rear of the PC.

2.) Connect the patch cable with the network connector at the rear of the PC and the wall network 
outlet.

Figure 3-33    Mouse and PC Rear
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3-4-3-11 Keyboard and Network Connection of Dell Precision 360 (cont’d)

Figure 3-34   Keyboard and PC Rear.
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3-4-3-12 Connections at Rear of PC of System based on Dell Precision 370

Figure 3-35  Connections at rear of PC of System based on Dell Precision 370
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3-4-3-13 Monitor Connections of System based on Dell Precision 340

1.) Connect the Monitor Power Cable to the rear of the Monitor.
2.) Connect the other end to a Wall Power Outlet.
3.) Connect the Y-Monitor Signal Cable to the display Card Socket at the rear of the PC.
4.) Connect the Monitor Signal Cable to the Y-Monitor Cable tagged with 1.
5.) Connect the other end to the digital Monitor Signal input1 as shown in the picture.
6.) In case of dual Monitor installation connect the second Monitor to the Y-cable tagged with 2

Figure 3-36  LCD Monitor Power Connection

Rear of LCD Monitor
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.3-4-3-13 Monitor Connections of System based on Dell Precision 340 (cont’d)

Figure 3-37  PC and LCD Rear

LCD Rear

3
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3-4-3-14 Monitor Connection

1.) Connect the Monitor Power Cable to the rear of the Monitor.
2.) Connect the other end to a Wall Power Outlet.

3.) Connect the Y-Monitor Signal Cable to the display Card Socket at the rear of the PC.
4.) Connect the Monitor Signal Cable to the Y-Monitor Cable tagged with 1.
5.) Connect the other end to one of the analog Monitor Signal inputs.
6.) In case of dual Monitor installation connect the second Monitor to the Y-cable tagged with 2.

Figure 3-38  CRT Monitor power connection

Figure 3-39  PC and CRT Rear

Rear of CRT Monitor
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3-4-3-15 Monitor Connections of System based on Dell Precision 360

1.) Connect the Monitor Power Cable to the rear of the Monitor.
2.) Connect the other end to a Wall Power Outlet.

Figure 3-40   LCD Monitor Power Connection

Rear of LCD Monitor
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3-4-3-15 Monitor Connections of System based on Dell Precision 360 (cont’d)
3.) Connect the Y-Monitor Signal Cable to the display Card Socket at the rear of the PC.
4.) Connect the other end to the digital Monitor Signal input1 as shown in the picture.
5.) In case of dual Monitor installation connect the second Monitor to the Y-cable tagged with 2.

Figure 3-41  PC and LCD Rear

LCD Rear



GE MEDICAL SYSTEMS  
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS® BASIC SERVICE MANUAL 

Chapter 3 Installation 3-55

3-4-3-16 Monitor Connections of System based on Dell Precision 370

1.) Connect the Monitor Power Cable to the rear of the Monitor.
2.) Connect the other end to a Wall Power Outlet.

3.) Connect the Y-Monitor Signal Cable to the display Card Socket at the rear of the PC.
4.) Connect the Monitor Signal Cable to the Y-Monitor Cable tagged with 1.
5.) Connect the other end to the digital Monitor Signal Input 1 as shown in the picture.

Figure 3-42   LCD Monitor Power Connection

Rear of LCD Monitor



GE MEDICAL SYSTEMS
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS BASIC SERVICE MANUAL

3-56 Section 3-4 - Completing the Installation

3-4-3-16 Monitor Connections of System based on Dell Precision 370 (cont’d)
6.) In case of dual Monitor installation connect the second Monitor to the Y-cable tagged with 2.

Figure 3-43  PC and LCD Rear
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3-4-3-17 PC Connections

1.) Connect the female end of the PC Power Cable to the Power Socket on the PC and the other end 
to a wall Power Outlet.

Figure 3-44   Signal and Power connections between PC rear and Power Outlet
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3-4-3-18 Global Modem Connections

1.) To do Modem RS232 Connection, plug one end of the RS232 cable into the RS232 connector on 
the modem, and the other end into a serial port connector on your computer, Port 1.

2.) To do Modem Line Connection, plug one end of the telephone wire into the modem’s LINE jack, 
and the other end into a phone line wall jack.

3.) To do Modem Power Connection: 

a.) Plug the female end of the Power Cable into the AC/DC Convertor and the male end into a 
vacant AC power outlet on the wall.

b.) Plug the AC/DC convertor cable into the PWR jack on the modem.

Figure 3-45   Global Modem Signal and Power connections for Dell Precision 340

NOTE The modem delivery includes a large set of global telephone standards adapters for the telephone wire.

NOTE The LINE jack is not interchangeable with the PHONE jack. Do not plug the phone into the LINE jack 
or the line cable into the PHONE jack.

CAUTION Use only the AC/DC power supply supplied with the modem. Use of any other AC/DC power supply will 
void the warranty and could damage the modem.

Telephone Wire

Modem

Phone line wall jack

Power 
Cable

AC/DC Convertor

RS232 
Cable
076D2610

Power 
Cable,
female
connector

Power Cable, 
male 
connector

To PC Com 13
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3-4-3-18 Global Modem Connections (cont’d)

Figure 3-46  Global Modem Signal Connection for Dell Precision 360, Dell Precision 370, Dell Precision 380 or 
Dell Precision 390
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3-4-4 Power On / Boot Up

Table 3-37    Bootup

Step Check Expected Result

1

Turn ON the Power switch Drag down the menu

2
Administrator/Admin:
Password should be changed 
after first use

On the appearing dialog type: - lwuser
Password:- lw

Table 3-38    Pre defined User

Username Password Permission

lwuser lw restricted

Administrator admin Administrator
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3-4-5 Third Party Products
The third party product Nero Burning ROM needs to be installed from the vendor setup CDs. Please 
use the default installation settings. They are no longer part of the default system configuration.
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3-4-6 Initialize Service Platform for LOGIQworks up to Version 2.0
The Checkout process initiates a communication between the customer and GE. Before you begin with 
the checkout you need to have an IP address to connect to the GE network.

You can choose between two physical connection types the “Modem connection” or the “VPN 
connection”. 

For a complete Checkout you have to prepare first the client (customer) PC. After the client PC is 
prepared you or somebody in the OLC can finish the checkout using the VOLC software.

To prepare the client PC you should know the GE InSite IP address. 

To finish the Checkout using VOLC you need to know the Service SystemID, which can be derived from 
the Manufacturing System number (See “Recovery CD Label with Rating Plate Label” on page 18.) in 
the following way: Service SystemID = Dell Service Tag.

1.) Go to iLingqShell on the desktop and click the button .
2.) To start “InSite Interactive Platform Configuration” type in the following lines: 

3.) Wait for the application to come up.
4.) Click 3 times “accept” at the start screen.
5.) Select the “Device connection” tab.
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3-4-6 Initialize Service Platform for LOGIQworks up to Version 2.0 (cont’d)

3-4-6-1 Modem Configuration
6.) Select “Modem” as device connection type.
7.) Select one of the following items corresponding to your telephone connection:

- Dial out prefix
- Internal prefix
- COM3 serial port 
- Dialing Mode
- Modem Type “MultiTech MT5634 ZBA V.90”
- CPU Serial Port Speed 38400
- Country

8.) Click “Apply”. The “Location Information” window pops up.
9.) Enter the appropriate information and click “OK”. 
10.)Click “OK” to the system message.

Figure 3-47  Configuring the “Device connection” tab
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3-4-6-1 Modem Configuration (cont’d)

11.)The “Phone and Modem Options” window pops up. Click on “Remove” and then “Add”.
12.)Follow the instructions of the “Add/Remove Hardware Wizard”.

13.)Click ”Next” to start the installation process. Wait until the “Finish” button pops up and click it. The 
modem is installed.

Figure 3-48  The “Location Information” window

Figure 3-49  The Add/Remove Hardware Wizard
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3-4-6-1 Modem Configuration (cont’d)
14.)The “Install Modem” system message pops up. Quit with “OK”.

15.)Click on the “InSite Checkout” tab.

16.)Enter the correct GE InSite IP address.
17.)Click “Checkout now” and reboot the system. The PC is ready for OLC checkout now.

3-4-6-2 VPN Configuration

1.) Open the “InSite Interactive Platform Configuration”. See Initialize Service Platform for 
LOGIQworks up to Version 2.0 on page 3-62.

Figure 3-50  The “Install Modem” system message

Figure 3-51  The “Insite Checkout” tab
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3-4-6-2 VPN Configuration (cont’d)

2.) Select “network” on the “Device Connection Type” field.
3.) Enter the local gateway IP address.
4.) Click “Apply”.
5.) Select the “InSite Checkout” tab.
6.) Click “Checkout Now”. The PC is ready for OLC checkout.

Figure 3-52  The InSite Interactive Platform Configuration” window
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3-4-7 Initialize Service Platform for LOGIQworks 3.0
For Installation Inside II see Technical Publication, Installation Manual: InSite II ViewPoint/LOGIQworks 
(Direction 5181936-100).

3-4-8 Filling out and sending the Product Locator Card
To finish the installation procedure the product locator card has to be filled out and send to the given 
address.

Figure 3-53  Product Locator Card



GE MEDICAL SYSTEMS
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS BASIC SERVICE MANUAL

3-68 Section 3-5 - Configuration

Section 3-5
Configuration

This chapter provides you with information on how to configure your LOGIQworks at an operating 
system and application level.

When you receive your LOGIQworks system all these configuration settings are already pre configured 
according to the information you provided with the Data Collection Document (please refer to Section  
"Recommendation: A permanent broadband to the internet. The customer is responsible for the 
connectivity, configuration and operation of this internet access funktionality." on page 2-14.

Please verify that all of these settings are correct.

3-5-1 Windows level configuration

3-5-1-1 Set System Time

1.) From Windows, right click on the clock located on the task bar.

2.) Select the Adjust Date/Time menu option.

3.) Click the Time Zone tab and set appropriately.

Figure 3-54  Windows Task bar

Figure 3-55  Windows Task bar - Date/Time-Adjustment

1.
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3-5-1-1 Set System Time (cont’d)

4.) Click on OK.
5.) Select the Date & Time tab and set the time and date appropriately.

6.) Click OK to apply the changes.

Figure 3-56  Windows Time Zone-Table

Figure 3-57  Windows Date & Time Table

3.

5.
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3-5-1-2 Select Units
To change the units of measurement use the Windows control panel.

Double click Regional Options in the Windows Control Panel.

Click the Numbers tab and select U.S. or Metric from the Measurement System drop down list. Then 
click OK.

If you wish to overrule Windows’ Regional Settings you can select either Metric or U.S.from the drop 
down list in the LOGIQworks Generic Properties page (see Section 3-5-2-5 "System Properties" ).

Figure 3-58  Windows Control Panel

Select here U.S. or Metric
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3-5-1-3 Monitor Setup

1.) Select Control Panel from the Windows Start Menu.
2.) Select Display, the Display Properties page opens.
3.) Select the Settings tab and click Advanced...

Set up your system for single monitor use:

On the ATI Displays Tab only one monitor is available. You don’t need to apply any changes, the system 
automatically detects the number of monitors connected.

Figure 3-59  Windows Display Properties

Settings Tab

Resolution for Dell LCD 1901:
1280x1024

Advanced for Dell LCD 2001:
1600x1200
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3-5-1-3-1 Monitor Setup based on Dell 340

Set up your system for dual monitor use:

4.) On the ATI Displays Tab make sure that both monitors are checked and activated (green light 
shows activation).

Figure 3-60  ATI Radeon Display Properties - Dual Monitor

Monitor connected Second monitor not 
connected
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3-5-1-3 Monitor Setup (cont’d)

5.) Select the radio button for the left monitor. For the right monitor select the to create an 

extended desktop to the right. (Do not use the clone button )

6.) The resolution for both monitors shall be identical for both monitors.
7.) Exit each dialog by pressing the OK button.

Figure 3-61  ATI Radeon Display Properties - Dual Monitor

4: Green light = active

5: Radio Button

6: Monitor Settings
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3-5-1-3-2 Set up your system for true dual graphic card use (based on Dell 360)

Figure 3-62  Dual Monitor Configuration for True Dual Graphic Card

Figure 3-63  Dual Monitor connection for ATI True Dual Graphic Card

 

Port onePort two
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3-5-1-3 Monitor Setup (cont’d)

Figure 3-64  Dual Monitor connection for Dell Precision 370
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3-5-1-4 Configure TCP/IP Settings
Connect your LOGIQworks system to the network.

To achieve communication between Scanner and LOGIQworks the following steps must be completed 
successfully.

Configure the TCP/IP settings using the Windows Control Panel:

If not already configured according to the information you provided with the Data Collection Document 
(see chapter ) or in case of configuration changes enter the correct data in the fields described in the 
figure below.

Please refer to Section 3-5-4-6 "Receive" on page 3-140 for details on how to configure the “receive” 
behavior of LOGIQworks through the Connection Service. Also please refer to Section 3-5-10 
"Connectivity (Application Level)" on page 3-183 for general Connectivity Settings on the Application 
Level.

Figure 3-65  Internet Protocol (TCP/IP)

NOTE On the scanner the connectivity TCP/IP must be setup with the above TCP/IP information in the area 
for a Remote Archive to achieve communication with LOGIQworks.

You need to ask your network administrator for
the appropriate settings.

Type in:
• IP address
• Subnet mask
• Default gateway

NOTE:This example shows fictive numbers! 
When you receive your LOGIQworksthe 
TCP/IP settings should reflect the 
information you provide with the Data 
Collection Document.
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3-5-1-5 Keyboard setup

Depending on your order you will receive a non-US keyboard. All keyboard input locales will be pre 
configured. Please check whether settings are correct.

1.) Click on the keyboard setup button, the following window will appear:

NOTE This Procedure is not required if the keyboard is a US keyboard, since the default setting is set to US, 
English keyboards.

Figure 3-66  Keyboard Status Window
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3-5-1-5 Keyboard setup (cont’d)
2.) Click on Input Locals, the following window will appear:

3.) Use the scroll bar to find the correct language keyboard layout for your keyboard.
4.) Click on the Set as Default button.
5.) Click on Apply button.
6.) Click on OK.
7.) Reboot LOGIQworks to get the full effect of the Keyboard Layout change.

Figure 3-67  Keyboard Properties Window

3

4

4

56
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3-5-2 General Application Level Configuration for LOGIQworks up to Rev. 1.3

3-5-2-1 TruAccess Plugin Definition
Verify that the TruAccess Raw Data Processing plugin is already defined and activate the plugin if not 
yet done.

1.) Select Configuration -> Plugin Definitions... from the Data Selector menu.

2.) If TruAccess Raw Data Processing is not yet listed in the Installed Plugins window, click Add... to 
open the Add Plugin Definitions dialog box. If it is already listed quit the dialog by clicking on 
“Cancel”.

3.) From the Select Component drop-down list, select TruAccess Raw Data Processing.
4.) You can change the default description in the Enter Descriptions field. The entered text will be 

displayed in the Series Area Plugin menu (right click popup menu).
5.) Click OK to apply the changes.

Figure 3-68  LOGIQworks-Plugin Definition Properties (1)

3

4

2

Administrator only; not available as menu option for non-admin users.
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3-5-2-1 TruAccess Plugin Definition (cont’d)
Resulting list of installed plugins after TruAccess Raw Data Processing has been added:

Figure 3-69  LOGIQworks- Plugin Definition Properties (2)
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3-5-2-2 General settings
To view and set general LOGIQworks properties:

1.) Select Configuration > Generic... from the Data Selector Menu.
2.) Select the General tab in the Generic Properties dialog.

• ROOT Directory: Root directory of RA 600. This is the directory into which RA 600 has been 
installed. (Default: C:\AMI_61)

• Work Directory: Directory for temporary files created by RA 600. (Default: D:\AMI_61\WORK)
• Main Window: 

- Initial View: Check from the Initial View drop-down list the Worklist View you want 
LOGIQworks to display by default when starting. (Default: nothing selected, Local Studies will 
be default then)

Figure 3-70  Generic Properties - General Settings

Initial View

Compare patients on

Administrator only
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3-5-2-2 General settings (cont’d)
- Compare Patients on: Indicate how you want to view patient studies in a patient worklist: by 

name, ID or both. LOGIQworks will collapse all the studies into one folder for viewing on the 
Local Patient Worklist, provided that the studies have the same patient name and/or patient 
ID.(Default: Both name and ID)

3-5-2-3 Logging
To set and view RA600’s logging properties:

1.) Select Configuration > Generic... from the Data Selector Menu.
2.) Select the Logging tab from the Generic Properties dialog.

Figure 3-71  General Settings - Logging

Do not change!
D:\AMI_61\LOG\Workstation.LOG
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3-5-2-3 Logging (cont’d)

• Logging Level: Set the level of logging messages. If set to ALL, all messages will be logged. If set 
to NORMAL (the typical setting) only error messages will be logged. 

• Logging Type: Set the types of logging used by the RA 600 application. (Default: File)
- File: If this check box is checked, RA 600 will write general information about its operation to 

the RadWorks.log file, which you can view in the Log folder. 
- Pipe: Used in combination with the listening tool in the X:\AMI_61\bin folder. Among other 

things, it enables you to observe DICOM transmissions in a pipe. Consult the technical 
reference manual or contact technical support for additional information. 

- Console: If this check box is checked, LOGIQworks will display a window that continuously 
shows the actions LOGIQworks is performing. This is useful when troubleshooting. 

• Log File: Set the name of the general log file. Each Service has its own default log filename. See 
the Database Service, Connection Service and Print Service properties for details.
(Default: D:\LOG\AMI_61\RadWorks.LOG; DO NOT CHANGE THE DEFAULT SETTINGS!)

• Truncation Size (kB): Set the truncation size of the logging file. The truncation size is the size the 
log file will be shortened to when its maximum size has been exceeded.(Default: 16 kB)

• Maximum Size (kB): Set the maximum size of the log file.
Set the Maximum Size of the log file to 0 to disable log file truncation. This can be very handy for 
troubleshooting. (Default: 64 kB)

• Always Flush File after Write: If checked, all logging actions will be written immediately to the log 
file. This option will have a serious impact on the performance of LOGIQworks, so it should not 
normally be checked. (Default: not checked)

• Log Pipe: Name of the pipe where logging information is written.
(Default: \\.\pipe\AMI2\RadWorks\Logging)

3-5-2-4 Popup Menu
To select/deselect popup menu:

1.) Select Configuration > Generic... from the Data Selector menu.
2.) Select the Popup Menu tab from the Generic Properties dialog.
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3-5-2-4 Popup Menu (cont’d)

Check the boxes next to the menu items to select the ones you want to appear on the pop-up menu that 
appears when right-clicking in the Data Selector.

3-5-2-5 System Properties

To set display (system) properties:

1.) Select Configuration > Generic... from the Data Selector menu.
2.) Select the System tab from the Generic Properties dialog.

Figure 3-72  General Settings - Popup Menu
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3-5-2-5 System Properties (cont’d)

• System Measurement: Select the units of measurements you want LOGIQworks to use from the 
drop-down list. If you select REGIONAL SETTINGS (see Figure 3-74), LOGIQworks will use the 
settings as specified in Regional Settings in the Windows Control Panel (see Section 3-5-1-2 on 
page 3-70). (Default: METRIC)

If you wish to overrule Windows' regional settings, you can select either METRIC (Default setting) or US 
from the drop-down list. LOGIQworks will then use millimeters or inches irrespective of what is specified 
in the Windows Control Panel. 

Figure 3-73  Generic Properties - System Settings

System measurement

Administrator only
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3-5-2-5 System Properties (cont’d)

• Person name representation:
Here you can indicate how you want patient names to appear on work lists. 

- Preferred: Select from the drop-down list how you would like to display names on patient lists. 
The choices are: 
* Single-byte: displays patient names using the single-byte character set typical for 

displaying European languages. (Default)
* Ideographic: displays patient names by means of double-byte character sets typical for 

displaying far-eastern languages such as Japanese, Chinese and Korean. 
* Phonetic: also displays patient names using double-byte character sets, but shows the 

phonetic representation of patients' names, not the ideographic representation. 
- Alternative: Allows you to indicate an alternative method of displaying names if the first 

method is not a viable option. (Default: Style-byte)
• Calibration time-out: Set the number of days before calibration of the monitor is required for true 

size display. Monitors used for true size display must be re calibrated regularly to ensure that they 
provide accurate results. (Default: 14 days)

Figure 3-74  Generic Properties - System Settings (2)
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3-5-2-6 DICOM settings
To set the DICOM properties for your LOGIQworks system:

1.) Select Configuration > Generic... from the Data Selector menu.
2.) Select the DICOM tab from the Generic Properties dialog.
These steps describe how to enter the correct Application Entity Title and Port number.

• AE Title: DICOM Application Entity title for the DICOM services provided by your system. The AE 
Title entered here should be used by other systems to set up DICOM associations to your system. 
The same AE Title is also used by your system when it sets up associations to other systems. The 
AE Title is then referred to as the calling AE Title.

• Port No.: Socket port number for the DICOM services provided by this system. The Port Number 
is used by other systems to set up DICOM associations to this system.(Default: 104)

Figure 3-75  DICOM settings

NOTE For LOGIQ 7 the AE Title has always to begin with “AE_” otherwise the images can not be transferred.

NOTE Reboot entire system after any change to DICOM settings.

Administrator only
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3-5-2-7 Monitors of System Dell Precision 340
To set up LOGIQworks for use with single monitor log on as system administrator:

1.) Select Configuration > Generic... from the Data Selector menu and click the monitor tab.
2.) Select the Adapter and click Settings. Specify that 1 row and 1 column of monitors (1x1) are 

connected to that adapter.
3.) Select the Monitor Group and click Edit..... Specify that 1 row and 1 column of monitors (1x1) is 

defining this group.
4.) The “Default Monitor” is set to 1. All other settings are not accepted.
5.) The “Select Monitor” is set to 1. All other settings are not accepted.
6.) Restart LOGIQworks.

Figure 3-76  Single Monitor Setup

Administrator only

2.

3.
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3-5-2-7 Monitors of System Dell Precision 340 (cont’d)
Setting up LOGIQworks for use with dual monitors log on as system administrator:

1.) Select Configuration -> Generic... from the menu bar in the Data Selector and click the Monitor 
tab.

2.) Select the Adapter and click Settings. Specify that 1 row and 2 columns of monitors (1 x 2) are 
connected to that adapter.

3.) Select the Monitor Group and click Edit. Specify that 1 row and 2 columns of monitors (1 x 2) are 
defining this group. A group must have monitors with the same resolution and/or space.

4.) Set the “Default Monitor” (1 = left most monitor; 2 = second from the left).
5.) Set the “Select Monitor”, this determines where the data selector will appear (1 = left most 

monitor; 2 = second from left).
6.) Restart LOGIQworks.

Figure 3-77  Dual Monitor Setup

Administrator only
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3-5-2-8 Monitors of System Dell Precision 360 and of Dell Precision 370
To set up LOGIQworks for use with single monitor log on as system administrator:

1.) Select Configuration > Generic... from the Data Selector menu and click the monitor tab.
2.) Select the Adapter and click Settings. Specify that 1 row and 1 column of monitors (1x1) are 

connected to that adapter.
3.) Select the Monitor Group and click Edit..... Specify that 1 row and 1 column of monitors (1x1) is 

defining this group.
4.) The “Default Monitor” is set to 1. All other settings are not accepted.
5.) The “Select Monitor” is set to 1. All other settings are not accepted.
6.) Restart LOGIQworks.

Figure 3-78  Single Monitor Setup for Dell 360 and for Dell 370

Administrator only

2.

3.
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3-5-2-8 Monitors of System Dell Precision 360 and of Dell Precision 370 (cont’d)
Setting up LOGIQworks for use with dual monitors for true dual graphic card log on as system 
administrator.

Figure 3-79  Simulated Dual Monitor Setup for Dell 360 and Dell 370

Administrator only
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3-5-2-8 Monitors of System Dell Precision 360 and of Dell Precision 370 (cont’d)

Setting up LOGIQworks for use with true dual monitors log on as system administrator:

1.) Select Configuration -> Generic... from the menu bar in the Data Selector and click the Monitor 
tab.

2.) Select the Adapter and click Settings. Specify that 1 row and 1 columns of monitors (1 x 1) are 
connected to that adapter.

3.) Select the Monitor Group and click Edit. Specify that 1 row and 2 columns of monitors (1 x 2) are 
defining this group. A group must have monitors with the same resolution and/or space.

4.) Set the “Default Monitor” (1 = left most monitor; 2 = second from the left).
5.) Set the “Select Monitor”, this determines where the data selector will appear (1 = left most 

monitor; 2 = second from left).
6.) Restart LOGIQworks.

Figure 3-80  Real Dual Monitor Setup for Dell 360 only
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3-5-2-9 Study Statuses
To add/remove/modify study statuses:

1.) Select Configuration > Generic... from the Data Selector menu.
2.) Select the Study Statuses tab from the Generic Properties dialog.

You can add study statuses to be stored in the Data Selector with a selected study (use this Generic 
Properties page to do so) or to be saved with the study in the Save Data dialog drop-down list in the 
Viewing Section (see Section 3-5-2-12 on page 3-99 in the Configuration Menu).

The priority of the statuses is from low to high reading from the top of the list down. 

Statuses can be entered in various ways. The status written first (in capital letters) is the official DICOM 
description and will be stored in the database. This status description may not consist of words 
separated by a space. If you want to use two words, use an underscore character between them. 

Figure 3-81  Generic Properties - Study Statuses

Administrator only
if option below is disabled.
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3-5-2-9 Study Statuses (cont’d)

The backslash separates the DICOM description with your own description of that particular status. For 
this you may use more than one word separated by spaces.

Figure 3-82  Study Statuses including user defined status

Figure 3-83   User defined status with description
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3-5-2-9 Study Statuses (cont’d)
After adding the necessary statuses, the System Administrator has to configure the status permissions 
for each LOGIQworks user. The Allow (other) users to configure their status permissions check 
box must be checked (default after installation) in order to do this. Each user of this particular 
workstation should be present while doing so. 

Once all the status permissions have been configured, the System Administrator should uncheck the 
Allow (other) users to configure their status permissions check box by logging on as Administrator.

3-5-2-10 Study Status Permission
To set/remove Study Statuses Permission for a certain user:

1.) Select Configuration > Generic... from the Data Selector menu.
2.) Select the Study Status Permissions tab from the Generic Properties dialog.

Figure 3-84  Generic Properties - Study Status Permission (Default)

Administrator only if option 
“Allow (other) users to set back 
the study status” is disabled; 
will then not be available to 
non-admin users.
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3-5-2-10 Study Status Permission (cont’d)
.

Set which study statuses the user will be able to select from when presented with the opportunity to 
change study status while using LOGIQworks. 

Check the check boxes of the statuses the user will be able to select. 

The user can be allowed to set the status back to a 'lower' one, from 'Authorized' to 'Created' for 
example. In some cases, however, this may cause workflow problems. Check the Allow user to set 
back the study status check box if you want a user to be able to set back the study status on the 
workstation.

Figure 3-85  Generic Properties - Study Status Permission (with user added study status)

Figure 3-86  Study Status in Data Selector

Administrator only if option 
“Allow (other) users to set back 
the study status” is disabled; 
will then not be available to 
non-admin users.
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3-5-2-11 HIS-RIS
To configure HIS-RIS implementations, add/remove/modify worklist:

1.) Select Configuration > Generic... from the Data Selector menu.

In order to be able to use work lists you must configure or add HIS-RIS implementations. LOGIQworks 
comes with several Dynamic Link Libraries (DLL) which enable the system to connect to a HIS-RIS 
system, providing there is an external program that can make use of the supplied DLLs. 

By default, the HIS-RIS Manager uses its own DLL, which allows you to work with Local Database and 
DICOM Modality Work lists. 

• Implementations: During installation of LOGIQworks a default implementation will be installed. 
- Click the Add... button to add a pre-defined HIS-RIS implementation. You can only add an 

implementation if your system is connected to a HIS-RIS system. 
- Click on an implementation in the list and then on Remove to delete it from your system. 
- Click Config... to configure your HIS-RIS system. If you are not connected to a HIS-RIS 

system you need not change the default values in this dialog.
Please refer to Section 3-5-11-1 "Reading DICOM volume from DVD or CD"  to learn how to add a 
Study/Patient List DVD or CD with DICOM volume on CD or DVD as source database.

Figure 3-87  Generic Properties - HIS-RIS
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3-5-2-11 HIS-RIS (cont’d)
• Functionality 

The Functionality list shows the various functionalities which are available in the HIS-RIS 
Implementations. 

- Worklist: The Worklist which will be retrieved from the HIS-RIS and shown in the Data 
Selector. 

- Report: The HIS-RIS which will send report information (whether a report should be written 
or if the study has already been authorized) 

- Notify: The HIS-RIS which will be informed about study changes, etc. 
- Transaction: The HIS-RIS which will be queried for matching, accepting key images, etc. 

Click on a functionality and then on Modify... to use a different HIS/RIS implementation for the 
functionality.



GE MEDICAL SYSTEMS  
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS® BASIC SERVICE MANUAL 

Chapter 3 Installation 3-99

3-5-2-12 Viewing Properties

To set general viewing properties:

1.) Select Configuration > Viewing... from the Data Selector menu.
2.) Select the General tab from the Viewing Properties dialog.

Figure 3-88  Viewing Properties - General

Administrator only

Administrator only
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3-5-2-12 Viewing Properties (cont’d)
Use the General tab of the Viewing Properties page to define general properties of the Viewing Section. 

• Initial Settings 
- Annotation level: Annotation level that is initially used in the Viewing Section. 
- Mask State: Set how masks are displayed when entering the Viewing Section. The options 

NONE, SHOW and ACTIVATE correspond to the radio buttons on the Masks totable in the 
Viewing Section. 

- Mask Type: Set the type of mask that will appear as the default in the drop-down list at the 
top of the Masks tool tab in the Viewing Section. 

• Viewing Area 
- Monitor groups: Specifies the number of monitor groups you configured. Leave the field 

blank to have LOGIQworks display on all monitors. 
- Hanging protocol group: Specifies the group to which you want to apply your hanging 

protocols.
- Navigation buttons: Click the Config... button to customize where you want to position the 

Up, Down, Up Series, Down Series, Previous, Next and Back buttons in the Viewing Section. 
- Display Series from Level: Select the default that determines how LOGIQworks should fill 

the series area of the Viewing Section when you view multiple studies. 
* Select Patients if you want to display the first series of each patient when opening 

multiple items for viewing. 
* Select Studies if you want to display the first series of each study when opening multiple 

items for viewing. 
* Select Series if you want to display all the series of the first study, and then all the series 

of any remaining studies. 
- Show Menu Bar: Check this check box if you want LOGIQworks to display in the Viewing 

Section a menu bar with commands for viewing images. 
• Data

- Direct View: LOGIQworks can allow studies that are not immediately available on the local 
system (such as those in a remote view) to be “directly viewed”. Such studies will be opened 
immediately for viewing and the Pictorial Index will continually update to display new images 
as they arrive until all images have been received. To enable this feature, make sure the 
Direct View check box is checked and also set a Default Retrieve AE (see below) (Default: 
checked).
It could be that you never want your Viewing Section to be updated while viewing studies. You 
can turn off the direct viewing of images as they are received by unchecking the Direct View 
check box. Note, however, that this will turn off all the features relating to viewing images as 
they arrive, such as monitoring mode and directly viewing images from a remote view. 

- Fallback Retrieve AE Title: The second application title at which LOGIQworks will look to 
see where images are if they are not at the location of the primary application entity (machine 
hosting the study). 

- Multi Study Save Mode: This mode determines how changes can be saved to studies during 
multi study viewing. 
* All Combined means that the Save Data dialog box will be displayed only once (when 

something has been changed/added and can be saved with the study) and allows all 
relevant changes to be saved to the respective studies in a single action. 

* Most Recent Only means that the Save Data dialog box is only displayed for the most 
recent study (determined by study data and time) and not for the other studies. 

* None means that the Save Data dialog box will never appear in multi-study mode. 
* Sequential means that the Save Data dialog will be displayed for all studies sequentially.
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3-5-2-12 Viewing Properties (cont’d)
- Open Priors for viewing Opens for viewing priors associated with a study in the relevant 

worklist.
Please refer to the RadWorks 6.1 Installation guide, page 70 for more information on the viewing 
properties and the other configuration tabs on the Viewing Properties page.
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3-5-3 General Application Level Configuration for LOGIQworks Rev. 2.0 and Rev. 3.0

3-5-3-1 TruAccess Plugin Definition
Verify that the TruAccess Raw Data Processing plugin is already defined and activate the plugin if not 
yet done.

1.) Select Configuration -> Plugin Definitions... from the Data Selector menu.

2.) If TruAccess Raw Data Processing is not yet listed in the Installed Plugins window, click Add... to 
open the Add Plugin Definitions dialog box. If it is already listed quit the dialog by clicking on 
“Cancel”.

3.) From the Select Component drop-down list, select TruAccess Raw Data Processing.
4.) You can change the default description in the Enter Descriptions field. The entered text will be 

displayed in the Series Area Plugin menu (right click popup menu).
5.) Click OK to apply the changes.

Figure 3-89  LOGIQworks-Plugin Definition Properties (1)

3

4

2

Administrator only; not available as menu option for non-admin users.
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3-5-3-1 TruAccess Plugin Definition (cont’d)
Resulting list of installed plugins after TruAccess Raw Data Processing has been added:

Figure 3-90  LOGIQworks- Plugin Definition Properties (2)
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3-5-3-2 General settings
To view and set general LOGIQworks properties:

1.) Select Configuration > Generic... from the Data Selector Menu.
2.) Select the General tab in the Generic Properties dialog.

• Main Window: 
- Initial View: Check from the Initial View drop-down list the Worklist View you want 

LOGIQworks to display by default when starting. (Default: nothing selected, Local Studies will 
be default then)

Figure 3-91  Generic Properties - General Settings

Initial View

Compare patients 
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3-5-3-2 General settings (cont’d)
- Compare Patients on: Indicate how you want to view patient studies in a patient worklist: by 

name, ID or both. LOGIQworks will collapse all the studies into one folder for viewing on the 
Local Patient Worklist, provided that the studies have the same patient name and/or patient 
ID.(Default: Both name and ID)

3-5-3-3 Logging
To set and view RA600’s logging properties:

1.) Select Configuration > Generic... from the Data Selector Menu.
2.) Select the Logging tab from the Generic Properties dialog.

Figure 3-92  General Settings - Logging

Do not change! D:D:\RA600\LOG
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3-5-3-3 Logging (cont’d)

• Logging Level: Set the level of logging messages. If set to ALL, all messages will be logged. If set 
to NORMAL (the typical setting) only error messages will be logged. 

• Logging Type: Set the types of logging used by the RA 600 application. (Default: File)
- File: If this check box is checked, RA 600 will write general information about its operation to 

the RadWorks.log file, which you can view in the Log folder. 
- Console: If this check box is checked, LOGIQworks will display a window that continuously 

shows the actions LOGIQworks is performing. This is useful when troubleshooting. 
• Log File: Set the name of the general log file. Each Service has its own default log filename. See 

the Database Service, Connection Service and Print Service properties for details.
(Default: [DATADIR%\log\workstation.log%)]; DO NOT CHANGE THE DEFAULT SETTINGS!)

• Maximum Size (kB): Set the maximum size of the log file.
Set the Maximum Size of the log file to 0 to disable log file truncation. This can be very handy for 
troubleshooting. (Default: 64 kB)

• Always Flush File after Write: If checked, all logging actions will be written immediately to the log 
file. This option will have a serious impact on the performance of LOGIQworks, so it should not 
normally be checked. (Default: not checked)

3-5-3-4 Popup Menu
To select/deselect popup menu:

1.) Select Configuration > User... from the Data Selector menu.
2.) Select the Popup Menu tab from the User Properties dialog.
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3-5-3-4 Popup Menu (cont’d)

Check the boxes next to the menu items to select the ones you want to appear on the pop-up menu that 
appears when right-clicking in the Data Selector.

3-5-3-5 System Properties

To set display (system) properties:

1.) Select Configuration > Generic... from the Data Selector menu.
2.) Select the System tab from the Generic Properties dialog.

Figure 3-93  General Settings - Popup Menu
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3-5-3-5 System Properties (cont’d)

• System Measurement: Select the units of measurements you want LOGIQworks to use from the 
drop-down list. If you select REGIONAL SETTINGS (see Figure 3-74), LOGIQworks will use the 
settings as specified in Regional Settings in the Windows Control Panel (see Section 3-5-1-2 on 
page 3-70). (Default: METRIC)

If you wish to overrule Windows' regional settings, you can select either METRIC (Default setting) or US 
from the drop-down list. LOGIQworks will then use millimeters or inches irrespective of what is specified 
in the Windows Control Panel. 

Figure 3-94  Generic Properties - System Settings

System measurement

Administrator only



GE MEDICAL SYSTEMS  
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS® BASIC SERVICE MANUAL 

Chapter 3 Installation 3-109

3-5-3-5 System Properties (cont’d)

• Person name representation:
Here you can indicate how you want patient names to appear on work lists. 

- Preferred: Select from the drop-down list how you would like to display names on patient lists. 
The choices are: 
* Single-byte: displays patient names using the single-byte character set typical for 

displaying European languages. (Default)
* Ideographic: displays patient names by means of double-byte character sets typical for 

displaying far-eastern languages such as Japanese, Chinese and Korean. 
* Phonetic: also displays patient names using double-byte character sets, but shows the 

phonetic representation of patients' names, not the ideographic representation. 
- Alternative: Allows you to indicate an alternative method of displaying names if the first 

method is not a viable option. (Default: Style-byte)
• Calibration time-out: Set the number of days before calibration of the monitor is required for true 

size display. Monitors used for true size display must be re calibrated regularly to ensure that they 
provide accurate results. (Default: 14 days)

Figure 3-95  Generic Properties - System Settings (2)
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3-5-3-6 DICOM settings
To set the DICOM properties for your LOGIQworks system:

1.) Select Configuration > Generic... from the Data Selector menu.
2.) Select the DICOM tab from the Generic Properties dialog.
These steps describe how to enter the correct Application Entity Title and Port number.

• AE Title: DICOM Application Entity title for the DICOM services provided by your system. The AE 
Title entered here should be used by other systems to set up DICOM associations to your system. 
The same AE Title is also used by your system when it sets up associations to other systems. The 
AE Title is then referred to as the calling AE Title.

• Port No.: Socket port number for the DICOM services provided by this system. The Port Number 
is used by other systems to set up DICOM associations to this system.(Default: 104)

Figure 3-96  DICOM settings

NOTE For LOGIQ 7 the AE Title has always to begin with “AE_” otherwise the images can not be transferred.

NOTE Reboot entire system after any change to DICOM settings.

Administrator only
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3-5-3-7 Monitors of System Dell Precision 380 and Dell Precision 390
To set up LOGIQworks for use with single monitor log on as system administrator:

1.) Select Configuration > User... from the Data Selector menu and click the monitor tab.
2.) Select the Adapter and click Settings. Specify that 1 row and 1 column of monitors (1x1) are 

connected to that adapter.
3.) Select the Monitor Group and click Edit..... Specify that 1 row and 1 column of monitors (1x1) is 

defining this group.
4.) The “Default Monitor” is set to 1. All other settings are not accepted.
5.) The “Select Monitor” is set to 1. All other settings are not accepted.
6.) Restart LOGIQworks.

Figure 3-97  Single Monitor Setup for Dell 380 and for Dell 390

Administrator only

2.

3.
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3-5-3-7 Monitors of System Dell Precision 380 and Dell Precision 390 (cont’d)
Setting up LOGIQworks for use with dual monitors for true dual graphic card log on as system 
administrator.

Figure 3-98  Simulated Dual Monitor Setup for Dell 380 and Dell 390

Administrator only
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3-5-3-8 Study Statuses
To add/remove/modify study statuses:

1.) Select Configuration > User... from the Data Selector menu.
2.) Select the Study Statuses tab from the User Properties dialog.

You can add study statuses to be stored in the Data Selector with a selected study (use this Generic 
Properties page to do so) or to be saved with the study in the Save Data dialog drop-down list in the 
Viewing Section (see Section 3-5-2-12 on page 3-99 in the Configuration Menu).

The priority of the statuses is from low to high reading from the top of the list down. 

Statuses can be entered in various ways. The status written first (in capital letters) is the official DICOM 
description and will be stored in the database. This status description may not consist of words 
separated by a space. If you want to use two words, use an underscore character between them. 

Figure 3-99  User Properties - Study Statuses

Administrator only
if option below is disabled.
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3-5-3-8 Study Statuses (cont’d)

The backslash separates the DICOM description with your own description of that particular status. For 
this you may use more than one word separated by spaces.

Figure 3-100  Study Statuses including user defined status

Figure 3-101   User defined status with description
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3-5-3-8 Study Statuses (cont’d)
After adding the necessary statuses, the System Administrator has to configure the status permissions 
for each LOGIQworks user. The Allow (other) users to configure their status permissions check 
box must be checked (default after installation) in order to do this. Each user of this particular 
workstation should be present while doing so. 

Once all the status permissions have been configured, the System Administrator should uncheck the 
Allow (other) users to configure their status permissions check box by logging on as Administrator.

3-5-3-9 Study Status Permission
To set/remove Study Statuses Permission for a certain user:

1.) Select Configuration > User... from the Data Selector menu.
2.) Select the Study Status Permissions tab from the User Properties dialog.

Figure 3-102  User Properties - Study Status Permission (Default)

Administrator only if option 
“Allow (other) users to set back 
the study status” is disabled; 
will then not be available to 
non-admin users.
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3-5-3-9 Study Status Permission (cont’d)
.

Set which study statuses the user will be able to select from when presented with the opportunity to 
change study status while using LOGIQworks. 

Check the check boxes of the statuses the user will be able to select. 

The user can be allowed to set the status back to a 'lower' one, from 'Authorized' to 'Created' for 
example. In some cases, however, this may cause workflow problems. Check the Allow user to set 
back the study status check box if you want a user to be able to set back the study status on the 
workstation.

Figure 3-103  User Properties - Study Status Permission (with user added study status)

Figure 3-104  Study Status in Data Selector

Administrator only if option 
“Allow (other) users to set back 
the study status” is disabled; 
will then not be available to 
non-admin users.
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3-5-3-10 HIS-RIS
To configure HIS-RIS implementations, add/remove/modify worklist:

1.) Select Configuration > Generic... from the Data Selector menu.

In order to be able to use work lists you must configure or add HIS-RIS implementations. LOGIQworks 
comes with several Dynamic Link Libraries (DLL) which enable the system to connect to a HIS-RIS 
system, providing there is an external program that can make use of the supplied DLLs. 

By default, the HIS-RIS Manager uses its own DLL, which allows you to work with Local Database and 
DICOM Modality Work lists. 

• Implementations: During installation of LOGIQworks a default implementation will be installed. 
- Click the Add... button to add a pre-defined HIS-RIS implementation. You can only add an 

implementation if your system is connected to a HIS-RIS system. 
- Click on an implementation in the list and then on Remove to delete it from your system. 
- Click Config... to configure your HIS-RIS system. If you are not connected to a HIS-RIS 

system you need not change the default values in this dialog.
Please refer to Section 3-5-11-1 "Reading DICOM volume from DVD or CD"  to learn how to add a 
Study/Patient List DVD or CD with DICOM volume on CD or DVD as source database.

Figure 3-105  Generic Properties - HIS-RIS
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3-5-3-10 HIS-RIS (cont’d)
• Functionality 

The Functionality list shows the various functionalities which are available in the HIS-RIS 
Implementations. 

- Worklist: The Worklist which will be retrieved from the HIS-RIS and shown in the Data 
Selector. 

- Report: The HIS-RIS which will send report information (whether a report should be written 
or if the study has already been authorized) 

- Notify: The HIS-RIS which will be informed about study changes, etc. 
- Transaction: The HIS-RIS which will be queried for matching, accepting key images, etc. 

Click on a functionality and then on Modify... to use a different HIS/RIS implementation for the 
functionality.
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3-5-3-11 Viewing Properties

To set general viewing properties:

1.) Select Configuration > Viewing... from the Data Selector menu.
2.) Select the General tab from the Viewing Properties dialog.

Figure 3-106  Viewing Properties - General

Administrator only

Administrator only
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3-5-3-11 Viewing Properties (cont’d)
Use the General tab of the Viewing Properties page to define general properties of the Viewing Section. 

• Initial Settings 
- Annotation level: Annotation level that is initially used in the Viewing Section. 
- Mask State: Set how masks are displayed when entering the Viewing Section. 
- Mask Type: Set the type of mask that will appear as the default in the drop-down list at the 

top of the Masks tool tab in the Viewing Section. 
• Viewing Area 

- Monitor groups: Specifies the number of monitor groups you configured. Leave the field 
blank to have LOGIQworks display on all monitors. 

- Hanging protocol group: Specifies the group to which you want to apply your hanging 
protocols.

- Navigation buttons: Click the Config... button to customize where you want to position the 
Up, Down, Up Series, Down Series, Previous, Next and Back buttons in the Viewing Section. 

- Display Series from Level: Select the default that determines how LOGIQworks should fill 
the series area of the Viewing Section when you view multiple studies. 
* Select Patients if you want to display the first series of each patient when opening 

multiple items for viewing. 
* Select Studies if you want to display the first series of each study when opening multiple 

items for viewing. 
* Select Series if you want to display all the series of the first study, and then all the series 

of any remaining studies. 
- Show Menu Bar: Check this check box if you want LOGIQworks to display in the Viewing 

Section a menu bar with commands for viewing images. 
• Data

- Open Priors for viewing Opens for viewing priors associated with a study in the relevant 
worklist.

• Image Label
Please refer to the RadWorks 7.0 Installation guide for more information on the viewing properties and 
the other configuration tabs on the Viewing Properties page.
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly
The following configuration steps assume, that you already have two monitors configured for your 
RA600 / CA1000 system, and that you have now purchased a 3rd monitor and the LOGIQworks plugin, 
and would like to extend your system to a TripleMonitor system.

In order to use the TripleMonitor configuration capabilities together with the LOGIQworks plugin, 
Minimum RA600 /CA1000 SP 11 software patch is required. For reference see FX Installation Manual 
English, Direction Number 5184015-100 or Software Installation Manual English, Direction Number 
5184018-100. 

For Installation of the LOGIQworks plugin, also refer to same manuals. Make sure that you have 
checked the hanging protocol checkbox.

3-5-3-12-1 Connecting your 3rd monitor

1.) Connect your 3rd monitor to the system.

2.) Restart the system.
3.) Ensure that your system now recognizes all 3 monitors.

3-5-3-12-2 Configuring RA600 / CA1000

1.) Double click the LOGIQworks desktop icon
2.) Click the Configuration -> Generic menu, and click the Monitors tab
3.) It should look roughly like this:

Figure 3-107   TripleMonitor Generic Properties

NOTE After you have installed the LOGIQworks software, you will notice that you now have a desktop icon 
titled "LOGIQworks". You MUST double click this if you wish to review any images in the LOGIQworks 
plugin.

NOTE We strongly recommend that you connect the 3rd monitor as your left-most monitor for the LOGIQworks 
integration.
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly (cont’d)

4.) Reconfigure your Monitor groups section so that you have two entries here; the 1st entry with a "1 
x 1" layout, and the 2nd entry with a "1 x 2" layout.

5.) After this, the dialog should look like this:

Figure 3-108   TripleMonitor Generic Properties

6.) Quit and restart RA600 / CA1000 as prompted.
7.) Click the Configuration -> Viewing menu, and click the General tab.

NOTE Your Adapters section may have three entries with "1 x 1". This is fine.

NOTE Your Monitor groups section may have two entries, each with "1 x 1". This is fine.

NOTE Your Adapters section may just have one entry with "1 x 3". This is fine.
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly (cont’d)
8.) Set the number in the "Hanging protocol group" text field to 2.

Figure 3-109   TripleMonitor Viewing Properties

9.) Quit and restart RA600 / CA1000 as prompted.

3-5-3-12-3 Configuring Your TripleMonitor System for Optimal Usage.
Your RA600 / CA1000 software should now initially launch on your newly configured left most monitor 
(if you were previously using two black & white hi-res monitors, you will notice that RA600 / CA1000 
now initially launches in color).

1.) Double click any of your studies.
2.) You should now see the double clicked study opens up across the middle- and right-most monitors 

(essentially, it should look just as before).
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly (cont’d)
3.) You should also see that your left most monitor essentially remains empty (it will most likely show 

a black empty viewport). It should look roughly like this:

Figure 3-110   TripleMonitor Black Empty Viewport

4.) On the left-most monitor, click Layout -> Show Data Selector. If you already see your data selector, 
then you don't have to do anything.

NOTE Your general UI configuration will most likely differ from the above screenshot. This is fine.

NOTE If you don't see a pictorial index visible on the left-most monitor, make it visible by selecting Layout -> 
Show Pictorial Index.
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly (cont’d)
5.) You should now see your data selector on the left-most monitor. Your left-most monitor should look 

something like this:

Figure 3-111   TripleMonitor Data Selector
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly (cont’d)
6.) If the data selector doesn't expand to take up the entire workspace of the left-most monitor (as 

shown in the above screenshot), then click-grab the top edge of the data selector window, and drag 
the window upwards to take up the entire space of the left most monitor:

Figure 3-112   TripleMonitor Expanded Data Selector

7.) On the middle monitor, you may have a pictorial index visible. To maximize your screen real estate, 
we recommend that you hide the pictorial index on the middle monitor since you already have a 
pictorial index visible on the left-most monitor.

NOTE Your data selector may not take up the entire space of the left-most monitor (as shown in the above 
screenshot). This is fine.
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly (cont’d)
8.) To hide the pictorial index on the middle monitor, then select Layout -> Pictorial Index -> Hide on 

your middle monitor.

Figure 3-113   TripleMonitor Hide Pictorial Index

9.) Finally, it is recommended that your right-most monitor should have the RA600 / CA1000 tooltab 
visible. If it is not already visible, then select Layout -> Tooltabs -> Show on your right-most monitor. 

Figure 3-114   TripleMonitor Show Tooltabs

3-5-3-12-4 Summary Configuring RA600 / CA1000
In summary, this is how each of your monitors should be configured:

• Left monitor: Data selector visible, pictorial index visible
• Middle monitor: Viewport (nothing else)
• Right monitor: Viewport, and tooltab visible

3-5-3-12-5 Reviewing Your Images in the TripleMonitor Configuration Environment
With your new configuration, you should now be able to review your studies across two monitors just as 
before. With a study double clicked, just set focus in any of the viewports on either the middle or right 
monitor, and use the PgDn / PgUp keys, or mouse scroll wheel, or however you used to navigate your 
images.

To review another study, just double click the study you wish to review in the data selector on the left 
monitor, and the study should appear on the middle and right monitors (and the left monitor should 
remain as is).

3-5-3-12-6 Using the LOGIQworks plugin in the TripleMonitor environment
When you wish to review an image in the LOGIQworks plugin, we strongly recommend using the 
following workflow:

1.) Double click the study you wish to review an image from.
2.) Review the images of the study on the middle and right monitors, as you would normally.
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly (cont’d)
3.) Once you have located the image you wish to open in LOGIQworks, set focus in the left monitor, 

and hit the "2" key on your num lock pad (make sure your Num Lock key is activated)
4.) This will hide the data selector on the left monitor, and display a black empty viewport.

Figure 3-115   TripleMonitor Black Empty Viewport

5.) Click inside this viewport, and now locate the image you wish to review in the pictorial index on the 
left monitor.
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly (cont’d)
6.) Click the image in the pictorial index, and you should now have that image visible in the viewport of 

the left monitor.

Figure 3-116   TripleMonitor Image Visible
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly (cont’d)
7.) To activate the LOGIQworks plugin, right click in the viewport, and select Series Area Plugin -> 

TruAccess Raw Data Processing.

Figure 3-117   TripleMonitor TruAccess Raw Data Processing

8.) The selected image should now be open in the LOGIQworks plugin.
9.) With your num lock pad (make sure your Num Lock key is activated), hit the "3" key.
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly (cont’d)
10.)This will display the RA600 / CA1000 toolbars on the left monitor. This is where all the LOGIQworks 

related controls are located.

Figure 3-118   TripleMonitor LOGIQworks

11.)To review another image of the same study in the LOGIQworks plugin, ensure that the left monitor 
viewport is selected, and select any other image in the left monitor pictorial index.

12.)You can continue reviewing the open study on the middle and right monitors at any time while the 
LOGIQworks plugin is open. Make sure you select one of the viewports of the middle or right 
monitor, and use the PgDn/PgUp, mouse scroll wheel, etc. to continue reviewing your study.

13.)To exit the LOGIQworks plugin, click the Exit button in the LOGIQworks toolbar.
14.)To review another study, hit the "2" key on your Num Lock pad (with the Num Lock key activated) 

to show the data selector, and double click whatever study you wish to review.
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3-5-3-12 TripleMonitors for LOGIQworks FX and LOGIQworks SoftwareOnly (cont’d)

3-5-3-12-7 Summary: Using the LOGIQworks Plugin in the TripleMonitor Environment
• The LOGIQworks plugin is only available on the left (color LCD) monitor.
• At any time can you review your images on the middle and right monitors, just as you are used to.
• Extremely important is to always click in a viewport of the monitor you wish to work with. This is how 

the RA600 / CA1000 software will differentiate between the actions of the various monitors.
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3-5-4 Connection Service Properties up to LOGIQworks 1.3

3-5-4-1 General
The General Tab contains a collection of generic settings for the Connection Service.

To view these setting:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the General tab from the Connection Service Properties page.

• ROOT Directory: Root directory for the files for the Connection Service. This is where the file to 
start the Connection Service (connect.exe) resides. 

• Work Directory: Directory to create temporary files used by the Connection Service. 
• Pipe Name: General pipe used by RadWorks to interface to the Connection Service

NOTE ONLY CHANGE THE DEFAULT SETTINGS IN THE CONNECTION SERVICE PROPERTIES IF YOU 
ARE AN EXPERT!

Figure 3-119  Connection Service Properties - General (Default Settings)

Administrator only
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3-5-4-2 Module
To view the JPEG Options:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Module tab from the Connection Service Properties page.

Standard JPEG compression options: Each option is represented by one line. Before the semicolon 
a textual description can be entered, that appears in a list-box containing JPEG compression options. 
The number behind the semicolon is the JPEG Quality factor. This number should be larger than 0, and 
smaller than 100. It should be an ordinal number. 

3-5-4-3 Logging
To set and view RA600 logging properties:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Logging tab from the Connection Service Properties page.

Figure 3-120  Connection Service Properties - Module (Default Setting)

Administrator only
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3-5-4-3 Logging (cont’d)

• Logging Level: Set the level of logging messages. If set to ALL, all messages will be logged. If set 
to NORMAL (the typical setting) only error messages will be logged. 

• Logging Type: Set the types of logging used by the RadWorks application. (Default: File)
- File: If this check box is checked, RadWorks will write general information about its operation 

to the RadWorks.log file, which you can view in the Log folder. 
- Pipe: Used in combination with the listening tool in the X:\AMI_61\bin folder. Among other 

things, it enables you to observe DICOM transmissions in a pipe. Consult the technical 
reference manual or contact technical support for additional information. 

- Console: If this check box is checked, RadWorks will display a window that continuously 
shows the actions RadWorks is performing. This is useful when troubleshooting. 

• Log File: Set the name of the log file. Each Service has its own default log filename. (Do not 
change)

• Truncation Size (kB): Set the truncation size of the logging file. The truncation size is the size the 
log file will be shortened to when its maximum size has been exceeded. (Default: 800 kB)

• Maximum Size (kB): Set the maximum size of the log file. (Default: 1024 kB)

Figure 3-121  Connection Service Properties - Logging (Default Settings)

D:\RA600\LOG
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3-5-4-3 Logging (cont’d)
Set the Maximum Size of the log file to 0 to disable log file truncation. This can be very handy for 
troubleshooting. 

• Always Flush File after Write: If checked, all logging actions will be written immediately to the log 
file. This option will have a serious impact on the performance of RadWorks, so it should not 
normally be checked. (Default: not checked)

• Log Pipe: Name of the pipe where logging information is written.
Default: \\.\pipe\AMI2\Connection\Logging

3-5-4-4 Database
This tab contains a collection of settings that are related to database settings for the Connection 
Service. The Connection Service uses a database to store destinations and origins, pending and 
completed transmission jobs, and information about received studies. 

To view the connection database settings:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Database tab from the Connection Service Properties page.

NOTE Remember: Only change settings if you are an expert!
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3-5-4-4 Database (cont’d)

Figure 3-122  Connection Service Properties - Database (Default Settings)

Administrator only
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3-5-4-4 Database (cont’d)
• Connect DSN: Name of the ODBC database source (DSN) for the database used by the 

Connection Service. 
• Destinations: Name of the database table containing pre-configured destinations. 
• Pending: Name of the database table containing pending transmission jobs. 
• Origins: Name of the database table containing pre-configured origins. 
• Receive: Name of the database table containing the receive log. 
• Completed: Name of the database table containing the completed transmission jobs. 
• ODBC Driver: Specifies the ODBC driver used to access the database for the Connection Service. 
• ODBC Parameters: Parameters needed to create a DSN (Data Source Name) in ODBC.

3-5-4-5 Maintenance
Set the maintenance behavior of the Connection Service. The Connection Service can automatically 
cleanup entries in the Send and Receive Logs, if valid maintenance criteria have been set. 

To view and set these criteria:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Maintenance tab from the Connection Service Properties page.



GE MEDICAL SYSTEMS  
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS® BASIC SERVICE MANUAL 

Chapter 3 Installation 3-139

3-5-4-5 Maintenance (cont’d)

• Startup Delay (sec.): Specifies the delay after start-up when the first maintenance check will be 
performed. (Default: 30) 

• Maintenance Times: Specifies at which moments in time a maintenance check will be performed. 
These checks are done every day, and only if the system is up and running at that. (Default: 01:00, 
09:00 and 17:00). 

* You can add a time by filling in the field beneath the list of Maintenance Times and clicking 
on the Add button. 

* You can delete a time by selecting the time in the Maintenance Times list and clicking the 
Remove button. 

* You replace one maintenance time with another by filling in the field beneath the list of 
Maintenance Times, selecting the time you want to replace and clicking the Replace 
button. 

• Max. No. Send Log Records: Maximum number of Send Log records. This number is used when 
maintenance becomes active. If the number of records in the Send Log exceeds the specified 
number, the oldest records will be deleted from the Send Log until the required maximum is 
reached. Setting this number to zero (as shown) will disable maintenance for the Send Log. 
(Default: 500) 

Figure 3-123  Connection Service Properties - Maintenance (Default Settings)

Administrator only

Administrator only
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3-5-4-5 Maintenance (cont’d)
• Max. No. Receive Log Records: Maximum number of Receive Log records. This number is used 

when maintenance becomes active. If the number of records in the Receive Log exceeds the 
specified number, the oldest records will be deleted from the Receive Log until the required 
maximum is reached. Setting this number to zero (as shown) will disable maintenance for the Send 
Log. (Default: 500) 

• Thread Priority: Priority of the maintenance thread within the Connection Service. Changing this 
setting can influence the system performance. (Default: IDLE) 

• Time Out DICOM Storage Commitment (h): Number of hours LOGIQworks will wait for a DICOM 
Storage Commitment response before timing out.

3-5-4-6 Receive

This tab contains a collection of settings that control the 'receive' behavior of the Connection Service. 
The Receive tab contains the general receive parameters and parameters specific for receiving in AMI 
format. The DICOM format receive parameters can be found on the DICOM tab.

Only alter default settings if strictly necessary.

To view these receive parameters:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Receive tab from the Connection Service Properties page.
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3-5-4-6 Receive (cont’d)

• Generic Receive
- Verify Origin: Check this check box if you want the system to perform 'origin checking'. This 

option is available for DICOM transfers made to this system. When checked, the system will 
verify the presence of the origin (i.e. the system sending data to this system) in the Origin 
database. 
This setting is also valid for receive activity in DICOM 3.0 format. 

- Auto Decompress Loss less Compressed Studies: This setting controls whether studies 
that are received in a loss less compressed format are automatically decompressed when 
they are received. By default, this option is disabled. This will save storage space on the 
receiving side, but may increase loading time when viewing the study. The reverse effect 
(increased storage space, but decreased loading time) can be achieved by enabling this 
option. 

Figure 3-124  Connection Service Properties - Receive (Default settings)
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3-5-4-6 Receive (cont’d)
- Auto Decompress Lossy Compressed Studies: This setting controls whether studies that 

are received in a lossy compressed format are automatically decompressed when they are 
received. By default, this option is disabled. This will save storage space on the receiving 
side, but may increase loading time when viewing the study. The reverse effect (increased 
storage space, but decreased loading time) can be achieved by enabling this option. 

- Auto Compress Studies: Check the check box if you want LOGIQworks to automatically 
compress incoming studies as they are received. This will save disk space, but performance 
will be affected to some extent when studies are opened for viewing, since LOGIQworks will 
have to decompress them before they are displayed. Select the type of compression you want 
RadWorks to use from the Format drop-down list. If the format allows different compression/
quality settings (such as lossy JPEG), select a value from the Parameters drop-down list. 

• Success: This parameter specifies the Windows.WAV file that will be played when a study has 
been received successfully. 

• Error: This parameter specifies the Windows.WAV file that will be played when an error has 
occurred during the receive process for a study. 

• Post Process: When you need a special process to run, such as for quality control matching or 
repairing DICOM tags, enter the Dynamic Link Library here (qc.dll for example), or use the Browse 
button to locate the DLL you want to use. 

• Play Receive Sound: This setting controls whether a sound will be played when studies are 
received by the system. The sound will be played when an entry is added to the Receive Log. 

• RadWorks 5.1 Receive: 
Check this check box to specify whether the RadWorks 5.1 Receive thread is available in the 
system. If this check box is disabled, RadWorks 5.1 systems will not be able to send data to this 
system in AMI (5.1) format. 

- Directory: Directory where the Connection Service receives studies from RadWorks 2.x or 
higher and RadWorks 1.31 systems that arrive in AMI format. 

- Share: Share name for the directory (as specified above) that is made available to other 
systems that send data to this system. This share is automatically created during the 
installation of the software. 

- Pipe: Pipe name of the interface provided by the Connection Service for other RadWorks 2.x 
or higher systems that want to send data to it in AMI format. 

- Minimum Free Space: This indicates (in megabytes) the minimum amount of free space that 
should be kept available when receiving studies. Should the amount of free space come 
below the level specified here, the study will be refused.

3-5-4-7 DICOM
The DICOM tab contains a collection of settings that control various DICOM parameters of the 
Connection Service.

To view and set these DICOM settings:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the DICOM tab from the Connection Service Properties page.
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3-5-4-7 DICOM (cont’d)

The settings are divided into a section for DICOM Receive, followed by a section for DICOM send. The 
DICOM Application Entity Title and Port Number can be set in the DICOM tab in Generic System 
configuration (please refer to Section 3-5-2-6 "DICOM settings" on page 3-87).

Thread Priority: Priority of the DICOM service thread within the Connection Service. Changing this 
setting can influence the system performance. (Default: normal)

• DICOM Receive 
- Strict DICOM Conformance: This flag can be used to force strict DICOM conformance when 

receiving DICOM transfers from other systems. If images arrive that do not comply with strict 
DICOM conformance, these images will not appear in the database. This is also logged in the 
Receive Log. (Default: not checked)

- Wait before Converting: This number can be used to set a time-out for DICOM conversion 
when a DICOM transfer is done on an image-by-image basis, i.e. when for every image a new 
association is started. If not zero, the number specifies (in milliseconds) the time-out between 
images. (Default: 0)

Figure 3-125  Connection Service Properties - DICOM (Default settings)
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3-5-4-7 DICOM (cont’d)
- Max. Number of Associations: Set the maximum number of simultaneous incoming 

connections LOGIQworks should be able to handle. (Default: 4)
- Receive time-out (s): The time after which LOGIQworks will report an error if no command 

is sent to the system after another system has initiated a connection with it. (Default: 60)
• DICOM Send 

- Split DICOM Series: This option is used when studies are sent from LOGIQworks in DICOM 
3.0 format to other systems. If enabled the sending LOGIQworks system will use separate 
DICOM associations for each series contained in the study that is being transmitted. This 
option should only be used for systems that inadvertently "mix" images from different series. 
(Default: not checked)

- Request Explicit VR: This flag can be used to indicate whether the system should request 
the explicit VR transfers syntax when sending data to other systems. If the remote system 
declines the explicit VR syntax, the study will be sent in implicit VR mode. (Default: checked)

• DICOM General
- PDU Packed Size (bytes): Specifies the size of the packets that LOGIQworks uses to send 

data. Typically you should leave this at the default value since it works well for all 
LOGIQworks stations. If the value is too high, overall transmission speed will be reduced. A 
figure that is too low may mean that additional packets need to be used to send data, again 
redoing performance. (Default: 16384)

3-5-4-8 Transmit
View and adjust settings that control the 'transmission' behavior of the Connection Service.

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Transmit tab from the Connection Service Properties page.
All but the first two settings apply to transmissions in both AMI and DICOM formats. 
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3-5-4-8 Transmit (cont’d)

• Name (AMI format only): Specify the name (for teleradiology purposes) of this system. This name 
will be used to identify the system when it makes connections with other (LOGIQworksor 
RadWorks) systems. Data received on other LOGIQworks machines (and sent from this machine) 
will have their origin set to this name. The name is best kept short and concise. 

• Description (AMI format only): Give a description of the machine you are working on. This is free 
format text. 

• Maximum Retries: Specify the maximum number of times a study will be re-sent to a destination 
if it has previously failed. A new attempt is only made if the previous attempt was 'non-fatal' in 
nature, such as a line interruption. If the number of attempts to transmit a study reaches the 
specified maximum, the job will be set to an error state. 

• Retry Interval (sec.): Specifies the (minimum) waiting time before a transmission (that failed on a 
previous attempt) can be tried again. 

• Thread Priority: Priority of the transmission thread within the Connection Service. Changing this 
setting may influence system performance. 

Figure 3-126  Connection Service Properties - Transmit (Default settings)
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3-5-4-8 Transmit (cont’d)
• Allow use of Remote Access Service (RAS): This option is used to specify whether Remote 

Access Service (RAS) can be used for teleradiology destinations. If enabled, RAS is available when 
configuring teleradiology destinations. If disabled, the RAS parameters for a destination cannot be 
accessed or used. 
This setting is typically set during the installation of a system, and should not be changed at a later 
stage without great care. Especially when changing the option from disabled to enabled, please 
make sure RAS is actually installed on the system. Also make sure the RAS service dependency 
is enabled for the Connection Service. 

• Send prior studies: Check this check box if you want LOGIQworks to automatically send to other 
workstations prior studies associated with an active study.
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3-5-5 Connection Service Properties of LOGIQworks 2.0 and 3.0

3-5-5-1 Module
To view the JPEG Options:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Module tab from the Connection Service Properties page.

NOTE ONLY CHANGE THE DEFAULT SETTINGS IN THE CONNECTION SERVICE PROPERTIES IF YOU 
ARE AN EXPERT!

Figure 3-127  Connection Service Properties - Module (Default Setting)

Administrator only
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3-5-5-1 Module (cont’d)
Standard JPEG compression options: Each option is represented by one line. Before the semicolon 
a textual description can be entered, that appears in a list-box containing JPEG compression options. 
The number behind the semicolon is the JPEG Quality factor. This number should be larger than 0, and 
smaller than 100. It should be an ordinal number. 

Wavelet options: For more details see the Radworks 7.0 user documentation

3-5-5-2 Logging
To set and view RA600 logging properties:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Logging tab from the Connection Service Properties page.

Figure 3-128  Connection Service Properties - Logging (Default Settings)

1

111
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3-5-5-2 Logging (cont’d)
• Logging Level: Set the level of logging messages. If set to ALL, all messages will be logged. If set 

to NORMAL (the typical setting) only error messages will be logged. 
• Logging Type: Set the types of logging used by the RadWorks application. (Default: File)

- File: If this check box is checked, RadWorks will write general information about its operation 
to the RadWorks.log file, which you can view in the Log folder. 

- Console: If this check box is checked, RadWorks will display a window that continuously 
shows the actions RadWorks is performing. This is useful when troubleshooting. 

• Log File: Set the name of the log file. Each Service has its own default log filename. (Do not 
change)

3.) Maximum Size (kB): Set the maximum size of the log file. (Default: 1024 kB)
Set the Maximum Size of the log file to 0 to disable log file truncation. This can be very handy for 
troubleshooting. 

• Always Flush File after Write: If checked, all logging actions will be written immediately to the log 
file. This option will have a serious impact on the performance of RadWorks, so it should not 
normally be checked. (Default: not checked)

3-5-5-3 Database
This tab contains a collection of settings that are related to database settings for the Connection 
Service. The Connection Service uses a database to store destinations and origins, pending and 
completed transmission jobs, and information about received studies. 

To view the connection database settings:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Database tab from the Connection Service Properties page.

NOTE Remember: Only change settings if you are an expert!
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3-5-5-3 Database (cont’d)

Figure 3-129  Connection Service Properties - Database (Default Settings)

Administrator 
only
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3-5-5-3 Database (cont’d)
• Connect DSN: Name of the ODBC database source (DSN) for the database used by the 

Connection Service. 
• Destinations: Name of the database table containing pre-configured destinations. 
• Pending: Name of the database table containing pending transmission jobs. 
• Origins: Name of the database table containing pre-configured origins. 
• Receive: Name of the database table containing the receive log. 
• Completed: Name of the database table containing the completed transmission jobs. 
• ODBC Driver: Specifies the ODBC driver used to access the database for the Connection Service. 
• ODBC: Parameters needed to create a DSN (Data Source Name) in ODBC.

3-5-5-4 Maintenance
Set the maintenance behavior of the Connection Service. The Connection Service can automatically 
cleanup entries in the Send and Receive Logs, if valid maintenance criteria have been set. 

To view and set these criteria:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Maintenance tab from the Connection Service Properties page.
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3-5-5-4 Maintenance (cont’d)

• Startup Delay (sec.): Specifies the delay after start-up when the first maintenance check will be 
performed. (Default: 30) 

• Maintenance Times: Specifies at which moments in time a maintenance check will be performed. 
These checks are done every day, and only if the system is up and running at that. (Default: 01:00, 
09:00 and 17:00). 

* You can add a time by filling in the field beneath the list of Maintenance Times and clicking 
on the Add button. 

* You can delete a time by selecting the time in the Maintenance Times list and clicking the 
Remove button. 

* You replace one maintenance time with another by filling in the field beneath the list of 
Maintenance Times, selecting the time you want to replace and clicking the Replace 
button. 

Figure 3-130  Connection Service Properties - Maintenance (Default Settings)

Administrator only

Administrator only
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3-5-5-4 Maintenance (cont’d)
• Max. No. Send Log Records: Maximum number of Send Log records. This number is used when 

maintenance becomes active. If the number of records in the Send Log exceeds the specified 
number, the oldest records will be deleted from the Send Log until the required maximum is 
reached. Setting this number to zero (as shown) will disable maintenance for the Send Log. 
(Default: 500) 

• Max. No. Receive Log Records: Maximum number of Receive Log records. This number is used 
when maintenance becomes active. If the number of records in the Receive Log exceeds the 
specified number, the oldest records will be deleted from the Receive Log until the required 
maximum is reached. Setting this number to zero (as shown) will disable maintenance for the Send 
Log. (Default: 500) 

• Thread Priority: Priority of the maintenance thread within the Connection Service. Changing this 
setting can influence the system performance. (Default: IDLE) 

• Time Out DICOM Storage Commitment (h): Number of hours LOGIQworks will wait for a DICOM 
Storage Commitment response before timing out.

3-5-5-5 Receive

This tab contains a collection of settings that control the 'receive' behavior of the Connection Service. 
The Receive tab contains the general receive parameters and parameters specific for receiving in AMI 
format. The DICOM format receive parameters can be found on the DICOM tab.

Only alter default settings if strictly necessary.

To view these receive parameters:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Receive tab from the Connection Service Properties page.
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3-5-5-5 Receive (cont’d)

• Generic Receive
- Verify Origin: Check this check box if you want the system to perform 'origin checking'. This 

option is available for DICOM transfers made to this system. When checked, the system will 
verify the presence of the origin (i.e. the system sending data to this system) in the Origin 
database. 
This setting is also valid for receive activity in DICOM 3.0 format. 

Figure 3-131  Connection Service Properties - Receive (Default settings)
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3-5-5-5 Receive (cont’d)
- Auto Decompress Loss less Compressed Studies: This setting controls whether studies 

that are received in a loss less compressed format are automatically decompressed when 
they are received. By default, this option is disabled. This will save storage space on the 
receiving side, but may increase loading time when viewing the study. The reverse effect 
(increased storage space, but decreased loading time) can be achieved by enabling this 
option. 

- Auto Decompress Lossy Compressed Studies: This setting controls whether studies that 
are received in a lossy compressed format are automatically decompressed when they are 
received. By default, this option is disabled. This will save storage space on the receiving 
side, but may increase loading time when viewing the study. The reverse effect (increased 
storage space, but decreased loading time) can be achieved by enabling this option. 

- Auto Compress Studies: Check the check box if you want LOGIQworks to automatically 
compress incoming studies as they are received. This will save disk space, but performance 
will be affected to some extent when studies are opened for viewing, since LOGIQworks will 
have to decompress them before they are displayed. Select the type of compression you want 
RadWorks to use from the Format drop-down list. If the format allows different compression/
quality settings (such as lossy JPEG), select a value from the Parameters drop-down list. 

• Success: This parameter specifies the Windows.WAV file that will be played when a study has 
been received successfully. 

• Error: This parameter specifies the Windows.WAV file that will be played when an error has 
occurred during the receive process for a study. 

• Post Process: When you need a special process to run, such as for quality control matching or 
repairing DICOM tags, enter the Dynamic Link Library here (qc.dll for example), or use the Browse 
button to locate the DLL you want to use. 

• Icon Images
• Play Receive Sound: This setting controls whether a sound will be played when studies are 

received by the system. The sound will be played when an entry is added to the Receive Log. 
• RadWorks 5.1 Receive: 

Check this check box to specify whether the RadWorks 5.1 Receive thread is available in the 
system. If this check box is disabled, RadWorks 5.1 systems will not be able to send data to this 
system in AMI (5.1) format. 

- Directory: Directory where the Connection Service receives studies from RadWorks 2.x or 
higher and RadWorks 1.31 systems that arrive in AMI format. 

- Share: Share name for the directory (as specified above) that is made available to other 
systems that send data to this system. This share is automatically created during the 
installation of the software. 

- Pipe: Pipe name of the interface provided by the Connection Service for other RadWorks 2.x 
or higher systems that want to send data to it in AMI format. 

- Minimum Free Space: This indicates (in megabytes) the minimum amount of free space that 
should be kept available when receiving studies. Should the amount of free space come 
below the level specified here, the study will be refused.

3-5-5-6 DICOM
The DICOM tab contains a collection of settings that control various DICOM parameters of the 
Connection Service.

To view and set these DICOM settings:

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the DICOM tab from the Connection Service Properties page.
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3-5-5-6 DICOM (cont’d)

The settings are divided into a section for DICOM Receive, followed by a section for DICOM send. The 
DICOM Application Entity Title and Port Number can be set in the DICOM tab in Generic System 
configuration (please refer to Section 3-5-2-6 "DICOM settings" on page 3-87).

Thread Priority: Priority of the DICOM service thread within the Connection Service. Changing this 
setting can influence the system performance. (Default: normal)

• DICOM Receive 
- Strict DICOM Conformance: This flag can be used to force strict DICOM conformance when 

receiving DICOM transfers from other systems. If images arrive that do not comply with strict 

Figure 3-132  Connection Service Properties - DICOM (Default settings)
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3-5-5-6 DICOM (cont’d)
- DICOM conformance, these images will not appear in the database. This is also logged in the 

Receive Log. (Default: not checked)
- Wait before Converting: This number can be used to set a time-out for DICOM conversion 

when a DICOM transfer is done on an image-by-image basis, i.e. when for every image a new 
association is started. If not zero, the number specifies (in milliseconds) the time-out between 
images. (Default: 0)

- Max. Number of Associations: Set the maximum number of simultaneous incoming 
connections LOGIQworks should be able to handle. (Default: 4)

- Receive time-out (s): The time after which LOGIQworks will report an error if no command 
is sent to the system after another system has initiated a connection with it. (Default: 60)

• DICOM Send 
- Split DICOM Series: This option is used when studies are sent from LOGIQworks in DICOM 

3.0 format to other systems. If enabled the sending LOGIQworks system will use separate 
DICOM associations for each series contained in the study that is being transmitted. This 
option should only be used for systems that inadvertently "mix" images from different series. 
(Default: not checked)

- Request Explicit VR: This flag can be used to indicate whether the system should request 
the explicit VR transfers syntax when sending data to other systems. If the remote system 
declines the explicit VR syntax, the study will be sent in implicit VR mode. (Default: checked)

• DICOM General
- PDU Packed Size (bytes): Specifies the size of the packets that LOGIQworks uses to send 

data. Typically you should leave this at the default value since it works well for all 
LOGIQworks stations. If the value is too high, overall transmission speed will be reduced. A 
figure that is too low may mean that additional packets need to be used to send data, again 
redoing performance. (Default: 16384)

3-5-5-7 Transmit
View and adjust settings that control the 'transmission' behavior of the Connection Service.

1.) Select Configuration > Connection Service... from the Data Selector menu.
2.) Select the Transmit tab from the Connection Service Properties page.
All but the first two settings apply to transmissions in both AMI and DICOM formats. 
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3-5-5-7 Transmit (cont’d)

• Name (AMI format only): Specify the name (for teleradiology purposes) of this system. This name 
will be used to identify the system when it makes connections with other (LOGIQworksor 
RadWorks) systems. Data received on other LOGIQworks machines (and sent from this machine) 
will have their origin set to this name. The name is best kept short and concise. 

• Description (AMI format only): Give a description of the machine you are working on. This is free 
format text. 

• Maximum Retries: Specify the maximum number of times a study will be re-sent to a destination 
if it has previously failed. A new attempt is only made if the previous attempt was 'non-fatal' in 
nature, such as a line interruption. If the number of attempts to transmit a study reaches the 
specified maximum, the job will be set to an error state. 

Figure 3-133  Connection Service Properties - Transmit (Default settings)
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3-5-5-7 Transmit (cont’d)
• Retry Interval (sec.): Specifies the (minimum) waiting time before a transmission (that failed on a 

previous attempt) can be tried again. 
• Thread Priority: Priority of the transmission thread within the Connection Service. Changing this 

setting may influence system performance. 
• Allow use of Remote Access Service (RAS): This option is used to specify whether Remote 

Access Service (RAS) can be used for teleradiology destinations. If enabled, RAS is available when 
configuring teleradiology destinations. If disabled, the RAS parameters for a destination cannot be 
accessed or used. 
This setting is typically set during the installation of a system, and should not be changed at a later 
stage without great care. Especially when changing the option from disabled to enabled, please 
make sure RAS is actually installed on the system. Also make sure the RAS service dependency 
is enabled for the Connection Service.

3-5-6 Database Service Properties up to LOGIQworks 1.3

3-5-6-1 General
To set up the general aspects of the Database Service:

1.) Select Configuration > Database Service... from the Data Selector menu.
2.) Select the General tab from the Database Service Properties page.

• ROOT Directory: Click the Browse... button to locate the root directory of the Database Service. 
This is the directory where the DATABASE.EXE file is located. 

• Work Directory: Click the Browse... button to specify a working directory to hold the temporary files 
generated by the database application. 

WARNINGWARNING ONLY CHANGE THE DEFAULT SETTINGS IF YOU ARE AN EXPERT!

Figure 3-134  Database Service Properties - General (Default Settings)

Administrator only
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3-5-6-1 General (cont’d)
• Pipe Name: Name of the pipe on which clients can connect with the Database Service. 
• Import priority: The priority with which incoming items are imported into the database.

• Performance monitoring: Creates a log (DBS_Performance.log) of RadWorks' performance. The 
name of the log is DBS_Performance.log and it is stored in the RadStore log directory 
(X:\AMI_61\LOG).

3-5-6-2 Logging
To set and view RadWorks' logging properties:

1.) Select Configuration > Database Service... from the Data Selector menu.
2.) Select the Logging tab from the Database Service Properties page.

• Logging Level: Set the level of logging messages. If set to ALL, all messages will be logged. If set 
to NORMAL (the typical setting) only error messages will be logged. 

• Logging Type: Set the types of logging used by the RadWorks application. (Default: file)
- File: If this check box is checked, RadWorks will write general information about its operation 

to the RadWorks.log file, which you can view in the Log folder. 
- Pipe: Used in combination with the listening tool in the X:\AMI_61\bin folder. Among other 

things, it enables you to observe DICOM transmissions in a pipe. Consult the technical 
reference manual or contact technical support for additional information. 

- Console: If this check box is checked, RadWorks will display a window that continuously 
shows the actions RadWorks is performing. This is useful when troubleshooting. 

• Log File: Set the name of the log file. Each Service has its own default log filename. 

Figure 3-135  Database Service Properties - Logging (Default Settings)

Administrator 
only
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3-5-6-2 Logging (cont’d)
• Truncation Size (kB): Set the truncation size of the logging file. The truncation size is the size the 

log file will be shortened to when its maximum size has been exceeded. (Default: 800 kB)
• Maximum Size (kB): Set the maximum size of the log file. (Default: 1024 kB)

Set the Maximum Size of the log file to 0 to disable log file truncation. This can be very handy for 
troubleshooting. 

• Always Flush File after Write: If checked, all logging actions will be written immediately to the log 
file. This option will have a serious impact on the performance of RadWorks, so it should not 
normally be checked. (Default: not checked)

• Log Pipe: Name of the pipe where logging information is written.
(Default: \\.\pipe\AMI2\Database\Logging)

3-5-6-3 Auto Delete

To set how and when files will be automatically removed from your system:

1.) Select Configuration > Database Service... from the Data Selector menu.
2.) Select the Auto Delete tab from the Database Service Properties page.

WARNINGWARNING Danger of Data Loss!

Activation of the function for automatic deletion of patient studies might cause data loss.
 
To avoid this back up your data frequently.

Figure 3-136  Database Service Properties - Auto Delete (Default Settings)

Administrator only
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3-5-6-3 Auto Delete (cont’d)
• Age deletion 

- Time to Wait: Specify the age of image data (in days / hours) before the deletion rules will 
apply. If set to 0, no deletion will take place; if set to 2 DAYS for example, image files 2 days 
old or older will be removed. 

- Date Stamp to Use: Type of date stamp to use when checking the age of the data. 
- Deletion Rules: Rules which determine whether data will be deleted if it is older than the 

specified time frame. These rules are SQL (Structured Query Language) rules. Once one or 
more rules are entered, Auto Delete will be activated. If none of the studies match the criteria 
that have been set, disk space will not be released and new studies will be rejected due to a 
lack of disk space. Exercise caution when setting these rules. 
Deletion rules are only executed during a maintenance run. 

RadWorks 6.1 Services must be up and running at the time set for a maintenance run. 

Deletion rules are case sensitive. 

• Disk space deletion 
- Type in the Local Drives field to define the drive letter and the minimum and maximum 

amount of free disk space (in percentages). Disk space values represent the percentage of 
free disk space available. For example, the setting 'C: 50 70' means that if the C: drive is more 
than 70% full, files will be deleted (according to the set of rules) until the 50% or less mark is 
reached. If the free space is less than the maximum percentage specified, the Database 
Service will commence deleting data until the minimum size is reached (following the deletion 
rules). 

- Type in the Deletion Rules field to add rules which determine if data will be deleted if disk 
space is above the maximum value. These are SQL rules. Automatic deletion will be activated 
once one or more rules have been entered. If Time to Wait or Date Stamp to Use have also 
been set, these rules will be executed first. 
If none of the studies match the criteria that have been set, disk space will not be released 
and new studies will be rejected due to lack of disk space. Exercise caution when setting 
these rules. 

Deletion rules are only executed during a maintenance run. 

RadWorks Services must be up and running at the time set for a maintenance run. 

Deletion rules are case sensitive.

3-5-6-4 Input
To specify the input-related settings for the Database Service:

1.) Select Configuration > Database Service... from the Data Selector menu.
2.) Select the Input tab from the Database Service Properties page.
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3-5-6-4 Input (cont’d)

• Input Directory: Directory which will be watched (monitored) for new data. Data converted to AMI 
format (.IMG and MET files) and copied into this directory will be automatically added to the local 
database. (Default: C:\AMI_61\DATABASE\INPUT)

• Input Folder: New data will be added to this folder in the local database. 
• Minimum Stable Time: Time (in seconds) during which the input directory must be stable (there 

have been no writes to this directory) before the Database Service starts appending the data in the 
input directory to the local database. 

• Thread Priority: Priority of the Input thread within the service. Changing this setting may influence 
system performance.

3-5-6-5 Maintenance
To set up the maintenance aspects of the Database Service:

1.) Select Configuration > Database Service... from the Data Selector menu.
2.) Select the Maintenance tab from the Database Service Properties page.

Figure 3-137  Database Service Properties - Input (Default settings)

Administrator only
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3-5-6-5 Maintenance (cont’d)

• Startup Delay: Specify the delay (in seconds) after start-up before the first maintenance check will 
be performed. 

• Maintenance Times: Specify at which times of the day (24-hour clock) a maintenance check will 
be performed. These checks will be performed each day, but only if the system is running at the 
scheduled time. 

* Add a time by filling in the field beneath the list of Maintenance Times and clicking on the 
Add button. 

* Remove a time by selecting the time in the Maintenance Times list and clicking the 
Remove button. 

* Replace one maintenance time with another by filling in the field beneath the list of 
Maintenance Times, selecting the time you want to replace and clicking the Replace 
button. 

• History Database Max. Entries: Specify the maximum number of entries which are to be included 
in the history database. The least recent entries will be removed to make way for new entries once 
the figure you specify here is reached. 

• Thread Priority: Set the priority of the maintenance thread within the service. Changing this setting 
may influence system performance.

Figure 3-138  Database Service Properties - Maintenance (Default Settings)
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3-5-6-6 Local
To set up the local database aspects of the Database Service:

1.) Select Configuration > Database Service... from the Data Selector menu.
2.) Select the Local tab from the Database Service Properties page.

• Directory: Specify the root directory of the local database. All folders will have sub-directories of 
this directory. 

• Index: Specify the name of the DSN (Data Source Name) used. 
• Table: Specify the name of the table in the database. 
• ODBC Driver: Specify the ODBC driver to be used. 
• ODBC Parameters: Parameters required to create a DSN (Data Source Name) in ODBC. 
• Local Query Limit: The maximum number of studies or patients LOGIQworks will display as a 

result of a local query. You can specify up to a maximum of 100,000. Leave the setting at 0 if you 
want LOGIQworks to be able to show the maximum.

3-5-7 Database Service Properties for LOGIQworks 2.0 and 3.0

3-5-7-1 General
To set up the general aspects of the Database Service:

1.) Select Configuration > Database Service... from the Data Selector menu.

NOTE Remember: Only change if you are an expert!

Figure 3-139  Database Service Properties - Local (Default settings)

WARNINGWARNING ONLY CHANGE THE DEFAULT SETTINGS IF YOU ARE AN EXPERT!

Administrator only

1
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3-5-7-1 General (cont’d)
2.) Select the General tab from the Database Service Properties page.

• Performance monitoring: Creates a log (DBS_Performance.log) of RadWorks' performance. The 
name of the log is DBS_Performance.log and it is stored in the RadStore log 
directory%DATADIR%\LOG

3-5-7-2 Logging
To set and view RadWorks' logging properties:

1.) Select Configuration > Database Service... from the Data Selector menu.
2.) Select the Logging tab from the Database Service Properties page.

Figure 3-140  Database Service Properties - General (Default Settings)

Administrator only
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3-5-7-2 Logging (cont’d)

• Logging Level: Set the level of logging messages. If set to ALL, all messages will be logged. If set 
to NORMAL (the typical setting) only error messages will be logged. 

• Logging Type: Set the types of logging used by the RadWorks application. (Default: file)
- File: If this check box is checked, RadWorks will write general information about its operation 

to the RadWorks.log file, which you can view in the Log folder. 
- Console: If this check box is checked, RadWorks will display a window that continuously 

shows the actions RadWorks is performing. This is useful when troubleshooting. 
• Log File: Set the name of the log file. Each Service has its own default log filename. 

Figure 3-141  Database Service Properties - Logging (Default Settings)

Administrator 
only

D:\RA600\LOG
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3-5-7-2 Logging (cont’d)
• Maximum Size (kB): Set the maximum size of the log file. (Default: 1024 kB)

Set the Maximum Size of the log file to 0 to disable log file truncation. This can be very handy for 
troubleshooting. 

• Always Flush File after Write: If checked, all logging actions will be written immediately to the log 
file. This option will have a serious impact on the performance of RadWorks, so it should not 
normally be checked. (Default: not checked)

3-5-7-3 Auto Delete

To set how and when files will be automatically removed from your system:

1.) Select Configuration > Database Service... from the Data Selector menu.
2.) Select the Auto Delete tab from the Database Service Properties page.

• Age deletion 
- Time to Wait: Specify the age of image data (in days / hours) before the deletion rules will 

apply. If set to 0, no deletion will take place; if set to 2 DAYS for example, image files 2 days 
old or older will be removed. 

- Date Stamp to Use: Type of date stamp to use when checking the age of the data. 

WARNINGWARNING Danger of Data Loss!

Activation of the function for automatic deletion of patient studies might cause data loss.
 
To avoid this back up your data frequently.

Figure 3-142  Database Service Properties - Auto Delete (Default Settings)

Administrator only
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3-5-7-3 Auto Delete (cont’d)
- Deletion Rules: Rules which determine whether data will be deleted if it is older than the 

specified time frame. These rules are SQL (Structured Query Language) rules. Once one or 
more rules are entered, Auto Delete will be activated. If none of the studies match the criteria 
that have been set, disk space will not be released and new studies will be rejected due to a 
lack of disk space. Exercise caution when setting these rules. 
Deletion rules are only executed during a maintenance run. 

RadWorks 6.1 Services must be up and running at the time set for a maintenance run. 

Deletion rules are case sensitive. 

• Disk space deletion 
- Type in the Local Drives field to define the drive letter and the minimum and maximum 

amount of free disk space (in percentages). Disk space values represent the percentage of 
free disk space available. For example, the setting 'C: 50 70' means that if the C: drive is more 
than 70% full, files will be deleted (according to the set of rules) until the 50% or less mark is 
reached. If the free space is less than the maximum percentage specified, the Database 
Service will commence deleting data until the minimum size is reached (following the deletion 
rules). 

- Type in the Deletion Rules field to add rules which determine if data will be deleted if disk 
space is above the maximum value. These are SQL rules. Automatic deletion will be activated 
once one or more rules have been entered. If Time to Wait or Date Stamp to Use have also 
been set, these rules will be executed first. 
If none of the studies match the criteria that have been set, disk space will not be released 
and new studies will be rejected due to lack of disk space. Exercise caution when setting 
these rules. 

Deletion rules are only executed during a maintenance run. 

RadWorks Services must be up and running at the time set for a maintenance run. 

Deletion rules are case sensitive.

3-5-7-4 Input
To specify the input-related settings for the Database Service:

1.) Select Configuration > Database Service... from the Data Selector menu.
2.) Select the Input tab from the Database Service Properties page.
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3-5-7-4 Input (cont’d)

• Input Directory: Directory which will be watched (monitored) for new data. Data converted to AMI 
format (.IMG and MET files) and copied into this directory will be automatically added to the local 
database. (Default: %DATADIR%\DATABASE\INPUT)

• Input Folder: New data will be added to this folder in the local database. 
• Minimum Stable Time: Time (in seconds) during which the input directory must be stable (there 

have been no writes to this directory) before the Database Service starts appending the data in the 
input directory to the local database. 

• Thread Priority: Priority of the Input thread within the service. Changing this setting may influence 
system performance.

3-5-7-5 Maintenance
To set up the maintenance aspects of the Database Service:

1.) Select Configuration > Database Service... from the Data Selector menu.
2.) Select the Maintenance tab from the Database Service Properties page.

Figure 3-143  Database Service Properties - Input (Default settings)
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3-5-7-5 Maintenance (cont’d)

• Startup Delay: Specify the delay (in seconds) after start-up before the first maintenance check will 
be performed. 

• Maintenance Times: Specify at which times of the day (24-hour clock) a maintenance check will 
be performed. These checks will be performed each day, but only if the system is running at the 
scheduled time. 

* Add a time by filling in the field beneath the list of Maintenance Times and clicking on the 
Add button. 

* Remove a time by selecting the time in the Maintenance Times list and clicking the 
Remove button. 

* Replace one maintenance time with another by filling in the field beneath the list of 
Maintenance Times, selecting the time you want to replace and clicking the Replace 
button. 

• History Database Max. Entries: Specify the maximum number of entries which are to be included 
in the history database. The least recent entries will be removed to make way for new entries once 
the figure you specify here is reached. 

• Thread Priority: Set the priority of the maintenance thread within the service. Changing this setting 
may influence system performance.

Figure 3-144  Database Service Properties - Maintenance (Default Settings)
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3-5-7-6 Local
To set up the local database aspects of the Database Service:

1.) Select Configuration > Database Service... from the Data Selector menu.
2.) Select the Local tab from the Database Service Properties page.

• Directory: Specify the root directory of the local database. All folders will have sub-directories of 
this directory. 

• Index: Specify the name of the DSN (Data Source Name) used. 
• Table: Specify the name of the table in the database. 
• ODBC Driver: Specify the ODBC driver to be used. 
• ODBC: Parameters required to create a DSN (Data Source Name) in ODBC. 
• Local Query Limit: The maximum number of studies or patients LOGIQworks will display as a 

result of a local query. You can specify up to a maximum of 100,000. Leave the setting at 0 if you 
want LOGIQworks to be able to show the maximum.

NOTE Remember: Only change if you are an expert!

Figure 3-145  Database Service Properties - Local (Default settings)
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3-5-8 Print Services up to LOGIQworks 1.3

3-5-8-1 General

To set general properties for the LOGIQworks Print Service:

1.) Select Configuration > Print Service... from the Data Selector menu.
2.) Select the General tab from the Print Service Properties page.

• ROOT Directory: The root directory of the Print Service where PRINT.EXE resides. 
• Work Directory: Directory where temporary files generated by the Print Module/Service are 

placed. 
• Maximum Bitmap Size: Set the maximum size of bitmaps that LOGIQworks will export/print. 
• Maximum Number of Copies: Adjust the maximum number of copies of an image a printer can 

turn out. 
• Working Set 

- Minimum/Maximum (kB): Working set for the service. The service will always have an 
amount of physical RAM available within these limits.

NOTE ONLY APPLY CHANGES TO THE DEFAULT SETTINGS IF YOU ARE AN EXPERT!

Figure 3-146  Print Service Properties - General (Default settings)

Administrator only
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3-5-8-2 Logging
To set and view RA600 logging properties:

1.) Select Configuration > Print Service... from the Data Selector menu.
2.) Select the Logging tab from the Print Service Properties page.

• Logging Level: Set the level of logging messages. If set to ALL, all messages will be logged. If set 
to NORMAL (the typical setting) only error messages will be logged. 

• Logging Type: Set the types of logging used by the RadWorks application. (Default: File)
- File: If this check box is checked, RadWorks will write general information about its operation 

to the RadWorks.log file, which you can view in the Log folder. 
- Pipe: Used in combination with the listening tool in the X:\AMI_61\bin folder. Among other 

things, it enables you to observe DICOM transmissions in a pipe. Consult the technical 
reference manual or contact technical support for additional information. 

- Console: If this check box is checked, RadWorks will display a window that continuously 
shows the actions RadWorks is performing. This is useful when troubleshooting. 

• Log File: Set the name of the log file. Each Service has its own default log filename. 
• Truncation Size (kB): Set the truncation size of the logging file. The truncation size is the size the 

log file will be shortened to when its maximum size has been exceeded. (Default: 800 kB)
• Maximum Size (kB): Set the maximum size of the log file. (Default: 1024 kB)

Set the Maximum Size of the log file to 0 to disable log file truncation. This can be very handy for 
troubleshooting. 

Figure 3-147  Print Service Properties - Logging (Default settings)

D:\AMI_61\LOG\Print.LOG
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3-5-8-2 Logging (cont’d)
• Always Flush File after Write: If checked, all logging actions will be written immediately to the log 

file. This option will have a serious impact on the performance of RadWorks, so it should not 
normally be checked. (Default: not checked)

• Log Pipe: Name of the pipe where logging information is written.
(Default: \\.\pipe\AMI2\Print\Logging)

3-5-8-3 Database

To set database properties for the LOGIQworks Print Service:

1.) Select Configuration > Print Service... from the Data Selector menu.
2.) Select the Database tab from the Print Service Properties page.

• Print DSN: The name of the (ODBC) Data Source Name for the Print Service. 
• Destinations: The name of the database table that lists the print destinations. 
• Job Queue: The name of the Queue database table which lists the print jobs to be executed (or in 

error state). 
• Job Log: The name of the Job Log database table which lists the successfully completed print jobs. 
• Layouts: The name of the database table storing the layouts created. 
• ODBC Driver: Specify the ODBC driver to be used. 
• Database File: Enter the database file that the Print Service should use. Click the Browse... button 

to locate a file.

Figure 3-148  Print Service Properties - Database (Default settings)

Administrator only



GE MEDICAL SYSTEMS
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS BASIC SERVICE MANUAL

3-176 Section 3-5 - Configuration

3-5-8-4 Maintenance
To specify maintenance tasks relating to the LOGIQworks Print Service:

1.) Select Configuration > Print Service... from the Data Selector menu.
2.) Select the Maintenance tab from the Print Service Properties page.

• Startup Delay: Specify the delay (in seconds) after start-up after which the first maintenance check 
will be performed. 

• Maintenance Times: Specifies at which moments in time a maintenance check will be performed. 
These checks are done every day, and only if the system is up and running at that. (Default: 01:00, 
09:00 and 17:00). 
- You can add a time by filling in the field beneath the list of Maintenance Times and clicking 

on the Add button. 
- You can delete a time by selecting the time in the Maintenance Times list and clicking the 

Remove button. 
- You replace one maintenance time with another by filling in the field beneath the list of 

Maintenance Times, selecting the time you want to replace and clicking the Replace button. 
• Max. No. Log Records: The maximum permitted size of the job log. If the number of job log records 

exceeds this, the log will be truncated to the stated size by deleting the oldest jobs first. 
• Thread Priority: Priority of the Maintenance thread within the service. Changing this setting may 

influence system performance.

Figure 3-149  Print Service Properties - Maintenance (Default settings)
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3-5-8-5 Viewing Buttons
To select the layout types to be previewed on the Print tool tab:

1.) Select Configuration > Print Service... from the Data Selector menu.
2.) Select the Viewing Buttons tab from the Print Service Properties page.

• Button Preview: A preview of the buttons that will appear on the Print tool tab in the Viewing 
Section. 

• Medium Type for Preview: Select a medium size from the drop-down list of common sizes. 
LOGIQworks will use this size when creating the previews. 

• Click on the Change... button to change the selection of layouts to be shown on the Print tool tab 
in the Viewing Section.

Figure 3-150  Print Layout Types
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3-5-9 Print Services for LOGIQworks 2.0 and 3.0

3-5-9-1 General

To set general properties for the LOGIQworks Print Service:

1.) Select Configuration > Print Service... from the Data Selector menu.
2.) Select the General tab from the Print Service Properties page.

• Maximum Bitmap Size: Set the maximum size of bitmaps that LOGIQworks will export/print. 
• Maximum Number of Copies: Adjust the maximum number of copies of an image a printer can 

turn out. 
• Working Set 

- Minimum/Maximum (kB): Working set for the service. The service will always have an 
amount of physical RAM available within these limits.

NOTE ONLY APPLY CHANGES TO THE DEFAULT SETTINGS IF YOU ARE AN EXPERT!

Figure 3-151  Print Service Properties - General (Default settings)

Administrator only
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3-5-9-2 Logging
To set and view RA600 logging properties:

1.) Select Configuration > Print Service... from the Data Selector menu.
2.) Select the Logging tab from the Print Service Properties page.

• Logging Level: Set the level of logging messages. If set to ALL, all messages will be logged. If set 
to NORMAL (the typical setting) only error messages will be logged. 

• Logging Type: Set the types of logging used by the RadWorks application. (Default: File)
- File: If this check box is checked, RadWorks will write general information about its operation 

to the RadWorks.log file, which you can view in the Log folder. 
- Console: If this check box is checked, RadWorks will display a window that continuously 

shows the actions RadWorks is performing. This is useful when troubleshooting. 
• Log File: Set the name of the log file. Each Service has its own default log filename. 
• Maximum Size (kB): Set the maximum size of the log file. (Default: 1024 kB)

Set the Maximum Size of the log file to 0 to disable log file truncation. This can be very handy for 
troubleshooting. 

Figure 3-152  Print Service Properties - Logging (Default settings)
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3-5-9-2 Logging (cont’d)
• Always Flush File after Write: If checked, all logging actions will be written immediately to the log 

file. This option will have a serious impact on the performance of RadWorks, so it should not 
normally be checked. (Default: not checked))

3-5-9-3 Database

To set database properties for the LOGIQworks Print Service:

1.) Select Configuration > Print Service... from the Data Selector menu.
2.) Select the Database tab from the Print Service Properties page.

• Print DSN: The name of the (ODBC) Data Source Name for the Print Service. 
• Destinations: The name of the database table that lists the print destinations. 
• Job Queue: The name of the Queue database table which lists the print jobs to be executed (or in 

error state). 
• Job Log: The name of the Job Log database table which lists the successfully completed print jobs. 
• Layouts: The name of the database table storing the layouts created. 
• ODBC Driver: Specify the ODBC driver to be used. 
• Database File: Enter the database file that the Print Service should use. Click the Browse... button 

to locate a file.

Figure 3-153  Print Service Properties - Database (Default settings)

Administrator only
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3-5-9-4 Maintenance
To specify maintenance tasks relating to the LOGIQworks Print Service:

1.) Select Configuration > Print Service... from the Data Selector menu.
2.) Select the Maintenance tab from the Print Service Properties page.

• Startup Delay: Specify the delay (in seconds) after start-up after which the first maintenance check 
will be performed. 

• Maintenance Times: Specifies at which moments in time a maintenance check will be performed. 
These checks are done every day, and only if the system is up and running at that. (Default: 01:00, 
09:00 and 17:00). 
- You can add a time by filling in the field beneath the list of Maintenance Times and clicking 

on the Add button. 
- You can delete a time by selecting the time in the Maintenance Times list and clicking the 

Remove button. 
- You replace one maintenance time with another by filling in the field beneath the list of 

Maintenance Times, selecting the time you want to replace and clicking the Replace button. 
• Max. No. Log Records: The maximum permitted size of the job log. If the number of job log records 

exceeds this, the log will be truncated to the stated size by deleting the oldest jobs first. 
• Thread Priority: Priority of the Maintenance thread within the service. Changing this setting may 

influence system performance.

Figure 3-154  Print Service Properties - Maintenance (Default settings)
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3-5-9-5 Viewing Buttons
To select the layout types to be previewed on the Print tool tab:

1.) Select Configuration > Print Service... from the Data Selector menu.
2.) Select the Viewing Buttons tab from the Print Service Properties page.

• Button Preview: A preview of the buttons that will appear on the Print tool tab in the Viewing 
Section. 

• Medium Type for Preview: Select a medium size from the drop-down list of common sizes. 
LOGIQworks will use this size when creating the previews. 

• Click on the Change... button to change the selection of layouts to be shown on the Print tool tab 
in the Viewing Section.

Figure 3-155  Print Layout Types
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3-5-10 Connectivity (Application Level)

3-5-10-1 Setting up and configuring origins
When your system is connected to a network, any properly equipped DICOM compliant system 
connected to that network could query your system’s database and even send studies. Access to your 
system can be restricted using “origins”. When another system tries to communicate with your 
LOGIQworks, you can tell your system to only allow communication if this origin is one of a pre-
configured set of permitted origins.

1.) From the Data Selector menu, select Connection -> Origins...

2.) Press the Add Button, the Origin Properties page is displayed.

NOTE For Multivender Philips HD11 and Philips HD11 XE, 3D works for multiframes only if the field "Time 
Frame Vector" is disabled on the Philips scanner. For details refer to the Philips manual.

Figure 3-156  Configure Origins (Default)

2.
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3-5-10-1 Setting up and configuring origins (cont’d)

3.) Enter the appropriate information in the dialog box (Name, Host Name or IP address, DICOM AE 
Title, DICOM Port Number are mandatory fields), any additional fields may help for troubleshooting.

4.) Click OK to add a new origin in the origins table. Please refer to Figure 3-158 for an example 
configuration.

Figure 3-157  Origin Properties Page
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3-5-10-1 Setting up and configuring origins (cont’d)

Please refer also to RadWorks 6.1 Installation Guide, page 61 LOGIQworks up to Version 1.3 or to 
Radworks 7.0 Installation Guide for LOGIQworks Version 2.0 or 3.0.

Figure 3-158  Configure Origins (Example)
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3-5-10-2 Setting up and configuring destinations
To add a teleradiology destination

1.) Select Connection -> Destinations... from the menu bar in the Data Selector.
2.) In the Destinations dialog box, click Add. The Add Destinations dialog opens.

Figure 3-159  Configure Destinations - Default

2.
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3-5-10-2 Setting up and configuring destinations (cont’d)

3.) Enter the name of the new destination. The name will be displayed in the list box on the 
Teleradiology Tool tab. The name field must be unique. The system will check this when you enter 
the name.

4.) Enter the host name (DNS name or IP address) of the new destination.
5.) Optionally, you can enter a description.
6.) For more detail on the options and IODs to select, please refer to the RadWorks 6.1 Installation 

Guide, page 57 for LOGIQworks up to Version 1.3 or Radworks 7.0 Installation Guide for 
LOGIQworks Version 2.0 or 3.0.

7.) Click Next.

Figure 3-160  Teleradiology Destination - Add Destination
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3-5-10-2 Setting up and configuring destinations (cont’d)

8.) Enter the DICOM AE Title for the remote system.
9.) Enter the DICOM Port Number for the remote system.

Figure 3-161  DICOM Destination

8.

9.
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3-5-10-2 Setting up and configuring destinations (cont’d)

To change an existing site:

1.) Select Connection -> Destinations... from the menu bar in the Data Selector.
2.) In the Destinations dialog box, select destinations (click in the first column) and then click Modify.
3.) Change any of the items in the Destination Properties dialog box (refer to the online help for details 

on the tabs and all parameters)
Connection Parameters: The Backup Destination is used to provide redundancy. Whenever sending 
studies to a destination fails, LOGIQworks will send the data to the backup. Please see RadWorks 6.1 
Installation Guide, page 57, for LOGIQworks up to Version 1.3 or Radworks 7.0 Installation Guide for 
LOGIQworks Version 2.0 or 3.0.

3-5-10-3 Setting up auto-routing
LOGIQworks supports multiple auto transmit protocols. You can send to multiple destinations using a 
trigger mechanism with or without a set of rules and based on the origin of the study. 

Only a user with administrator rights can configure the Auto Transmit Protocol. Other users will only be 
able to use and modify the Basic Protocol. End users will only be able to select one destination for auto 
transmissions, which will be triggered as soon as the system receives studies. 

3-5-10-3-1 Setting up basic automatic routing
While you can create highly sophisticated auto transmission setups in LOGIQworks, for many users the 
facility of automatically forwarding incoming studies to another system will suffice. Setting up such basic 
automatic transmission is covered here. For details on setting up more sophisticated automatic 
transmission, see RadWorks 6.1 Installation Guide, page 70, Chapter 3 “Setting up advanced automatic 
transmission”.

Figure 3-162  Configure Destinations - Result Example
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3-5-10-3 Setting up auto-routing (cont’d)
Even if no protocols have yet been added you will see the Basic Protocol. This is a simple autoroute 
protocol installed with LOGIQworks that allows you to set up basic auto routing on your system. You 
can modify the Basic Protocol but you cannot delete it.

1.) Select Configuration -> Auto Routing... from the menu bar in the Data Selector.

2.) Click the Add button to add a new auto route protocol.
3.) To set up an auto route protocol similar to an existing one, click on the first (Name) column of the 

existing protocol to select it and click Copy.
4.) Then modify the newly created copy of the original protocol.
5.) To change an auto route protocol, click on the first (Name) column to select it and then on the 

Modify button.
6.) Select an auto route protocol and click Delete to remove it from your system.

To modify an existing basic protocol:

1.) Click <basic protocol>, (in the Name column) and then Modify in the Auto Route dialog box.

Figure 3-163  Configuring basic auto route protocols
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3-5-10-3 Setting up auto-routing (cont’d)

2.) Select a destination from the drop-down list, in the Auto Route Basic Teleradiology box.
3.) Click Send Immediate, to forward incoming studies immediately to the destination. Click 

Transmission Time, if you want to specify a particular time that incoming studies should be sent, 
or Delay Time if you want to specify a delay before the studies are sent to the destination. Set the 
transmission time or delay time appropriately.

4.) Check the Delete After Send check box, to remove the study after it has been sent successfully.
If auto transmission has been set, this will be shown by the indicator in the Send section of the 
Teleradiology tool tab. 

3-5-10-3-2 Turn off the automatic sending

1.) To turn off auto-routing, select Configuration -> Auto Routing from the menu bar in the Data 
Selector.

Figure 3-164  Basic Auto Route Parameters

Figure 3-165  Auto Route - turned off
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3-5-10-3 Setting up auto-routing (cont’d)
2.) In the Auto Route dialog box, click <basic protocol> (in the Name column) and then Modify. Select 

<none> from the Destination drop-down list in the Auto Route Basic Teleradiology dialog box. 
Please refer to Figure 3-165 for the basic auto route protocol being turned off.
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3-5-11 CD-R/RW and DVD Setup

3-5-11-1 Reading DICOM volume from DVD or CD
Creating and configuring a DVD or CD worklist view.

To create a study or patient list:

1.) Select Configuration -> Generic... from the Data Selector menu bar and click on the HIS-RIS tab 
in the Generic Properties dialog box.

2.) Select Default HIS/RIS Implementation in the Implementations section and then click on the 
Config... button.

Figure 3-166  Generic Properties - HIS-RIS for LOGIQworks up to Version 1.3

2.
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3.) Select the Study/Patient list tab of the Configure RadWorks Default HIS/RIS Implementation 
dialog box. Click the Add button to add an additional list.

3-5-11-1 Reading DICOM volume from DVD or CD (cont’d)

Figure 3-167  Generic Properties - HIS-RIS for LOGIQworks Version 2.0 and 3.0

2.
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3-5-11-1 Reading DICOM volume from DVD or CD (cont’d)

Figure 3-168  Generic Properties - Add Study/Patient List for LOGIQworks up to Version 1.3

Figure 3-169  Generic Properties - Add Study/Patient List for LOGIQworks Version 2.0 or 3.0

3.

3.
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3-5-11-1 Reading DICOM volume from DVD or CD (cont’d)

4.) In the Patient/Study List dialog box type in a Description of the Patient or Study list you want to 
create. E.g. DVD DICOM volume or CD DICOM volume.

5.) Select from the Type drop-down list the type of list you want to create: Study or Patient.
6.) Click the Add button.
7.) In the Source dialog box select the source you want to use for the Patient or Study worklist you want 

to define. Select DICOM Volume to use a single medium archive such as a DVD or CD. Then type 
in the drive of the Device containing the images you want to import into your RadWorks worklist.

Figure 3-170  Study/Patient List

4.

5.

6.
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3-5-11-1 Reading DICOM volume from DVD or CD (cont’d)

8.) Click the Test button to see whether your connection will work. If you get a message stating that the 
connection has failed, go back and correct any mistakes you have made. Otherwise, click OK until 
you reach the Data Selector again.

9.) Exit the application and start it up again.

Displaying data from your DVD or CD media

To view studies from a single medium archive in a worklist view:

Figure 3-171  Source Dialog Box

NOTE The test requires a DICOM volume to be in the drive.

Figure 3-172  Patient/Study List

7.

8.

Drive F as source added
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3-5-11-1 Reading DICOM volume from DVD or CD (cont’d)

1.) In the Data Selector, select Database -> Add view from the menu bar.

2.) In the Add View dialog, specify the Description field by typing in a description for your new study 
list. E.g. DVD or CD.

3.) Select from the List drop-down list the new worklist you created, e.g. DVD DICOM volume or CD 
DICOM volume.

Figure 3-173  Database - Add View (1)

Figure 3-174  Database - Add View (2)

Figure 3-175  Database - Add View (3)
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3-5-11-1 Reading DICOM volume from DVD or CD (cont’d)
4.) Use the copy settings from drop-down list to indicate the list whose settings should apply to the one 

you created. (Default: Local Studies)
5.) Click ok and view the worklist by selecting it from the Worklist View drop-down list on the Data 

Selector tab.

6.) Double-click the study to view it. Note that you can only view the study if the Direct View check box 
on the General tab of the Viewing Properties dialog box is checked (please refer to Section 3-5-2-
12 "Viewing Properties" on page 3-99).

7.) If you want to import the study, select it, right-click it and then left-click Import from the shortcut 
menu. LOGIQworks will return the file to the worklist view where it came from.

3-5-11-2 Writing a DICOM volume to DVD or CD-R/RW (SME)
The system must be licensed for use with Single Media Exchange (SME) option in order to be able to 
write data to CD-R/RW and/or DVD. In addition the system needs to be equipped with the HP DVD 
Writer for writing data to DVD.

It is recommended to add a new column to the Data Selector for the Single Media Exchange option 
(SME). To do so, right click on the column heading to the right of where you want to insert the new 
column and select Insert column.

Figure 3-176  Data Selector Tab - Worklist View

Figure 3-177  Import Study
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3-5-11-2 Writing a DICOM volume to DVD or CD-R/RW (SME) (cont’d)

3-5-11-3 Writing a DICOM volume to DVD or CD-R/RW

1.) Select Configuration -> Single Media Exchange from the Data Selector menu bar. In the 
Configure Single Media Archiving dialog box select Read-Only from the Media Type drop-down list.

2.) Select in the “File System” field the CD or DVD item

3.) Enter in the “Device” field, the drive of the device to which you are copying data to or from, or click 
the “Browse...” button.

4.) Specify in the “Total Size” field the storage limit of the medium you are using. For CD this is 640 or 
700 MB; for DVD 4.7 GB.

5.) In the “Block Size” field, define the size of the blocks you want for your read-only medium. The 
recommended setting is 4.

6.) Check the “Copy files” check box, to indicate that you want to copy additional items to your read-
only medium. Then enter the path from where you want to copy those items (or use the Browse... 
button). An example of such an item might be the CD Viewer. Note that you copy the contents of 
entire folders, not individual files.

WARNINGWARNING After writing a CD/DVD, eject the media to finalize the session and read the media. 
Before you don‘t eject the media once and insert it again, you won’t be able to read the 
CD/DVD e.g. in the Windows Explorer.

Figure 3-178  Configure Single Media Archiving (Read only)
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3-5-11-2 Writing a DICOM volume to DVD or CD-R/RW (SME) (cont’d)
7.) In the “Image directory” field, type in the path and directory on your hard disk where you want 

LOGIQworks to temporarily store images before burning them to CD or DVD. You can also use the 
Browse... button to navigate to this location.

8.) Check the “Verify burned contents” check box, if you want a message stating that your data has 
been copied to the CD.

9.) Check the “Delete marked studies after archiving” check box, if you want the study deleted after it 
has been copied, and then click OK. Note that this option will only be performed after data from the 
local database is archived, not with archiving data you selected.

10.)Check the “Enable Archive Index Tool” check box if you are planning to use the Archive Index Tool 
to index the data placed on the CD or DVD.

11.)Check the “Automatically add volumes to AIT” Tool if you want to immediately add to the Archive 
Index the volume to which you want to save data.

12.)Click OK to complete the configuration.
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3-5-12 Optional Peripherals/Peripheral Connections

3-5-12-1 Network Printer (Option)- Connections and Configurations
Refer to RadWorks 6.1 Installation Guide, page 140, for further details on DICOM, Windows and File 
Printer configuration.
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3-5-13 Software Option Configuration

3-5-13-1 Available Software options for LOGIQworks up to Version 1.3
The following software options are available for LOGIQworks.

• Single Media Exchange Part Number H49021LE.
• DICOM Print Part Number H49021LF.
• Quality Control Module Part Number H49021LG.

3-5-13-2 Available Software options for LOGIQworks Version 2.0 and 3.0
The following software options are available for LOGIQworks.

• Single Media Exchange Part Number H49021BC.
• DICOM Print Part Number H49021BD.
• Quality Control Module Part Number H49021BE.

3-5-13-3 Software Option Installation

3-5-13-3-1 License Configuration

1.) Run the License Configuration tool RunLCfg.exe from the C:\AMI_61\Bin directory.

2.) Select License type “License File”.

Figure 3-179  License Configuration
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3-5-13-3 Software Option Installation (cont’d)
3.) Press the Test Button to run the License Configuration test.
4.) The test results will be displayed, listing all tested components with Licensed or Not Licensed flag.

Figure 3-180  License Test - Result
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Section 3-6
Software Upgrades

To configure new software options for RA600 please see Software Option Configuration on page 3-203.

For software upgrades of the LOGIQworksturnkey system please see the Update Installation Manual.
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Section 3-7
Disable RAW data image transfer for Le

For Le only DICOM only images are supported, RAW data image transfer have to be disabled by the 
user. 

DICOM Image Storage allows the system to send or receive ultrasound images in a format that can be 
interpreted by LOGIQworks. For compatibility between LOGIQworks and Le, RAW data have to be turn 
off.

While setting up the connectivity for LOGIQworks, make sure that the ’Allow Raw Data’ checkbox is 
NOT checked. This disables the RAW data image transfer. For detailed description, please also refer 
to the LOGIQ e Basic User Manual, Direction 5118586-100 Rev.2, page 16-71.

Figure 3-181  DICOM Image Storage Service
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Chapter 4
Functional Checks

Section 4-1
Overview 

4-1-1 Purpose of Chapter 4
The purpose of this section is to provide quick procedures to check the major Hardware & Software 
functions of the LOGIQworks.

Section 4-2
Required Equipment

Table 4-1    Contents in Chapter 4

Section Description Page Number

4-1 Overview 4-1

4-2 Required Equipment 4-1

4-3 System Check 4-2

4-4 Healthpage 4-26

4-5 Site Log 4-32

Table 4-2    Required Equipment

Equipment Required for Chapter

Patient records loaded on the system containing at least one 
DICOM series with ultrasound raw data cine loops for each 
of the following modes: 2D, M-Mode, 2D Color, M-Mode 
Color and Doppler Mode as well as 3D data set with position 
information (Tru3D) and a sensor less data set.

4-3-2-3
4-3-2-2

A CD with patient records containing at least one DICOM 
series with ultrasound raw data cine loops for each of the 
following modes: 2D, M-Mode, 2D Color, M-Mode Color and 
Doppler Mode as well as 3D data set with position 
information (Tru3D) and a sensor less data set.

4-3-7-1

An empty CD-R/RW to copy DICOM data to. 4-3-8

To write data to CD or DVD the system needs Single Media 
Exchange option enabled. 4-3-7-2 
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Section 4-3
System Check

Table 4-3    Hardware & Software Function Check

Step Task See Chapter Check ( )

1 Boot the system and log on as lwuser see Section 3-4-4 on page 3-60

2 Check reading from CD-R/RW see Section 4-3-8 on page 4-23

3 Check modem see Section 4-3-6 on page 4-21

4 Check system time see 3-5-1-1 on page 3-68

5 Check units see 3-5-1-2 on page 3-70

6 Check monitor setup see 3-5-1-3 on page 3-71 and 3-
5-2-7 on page 3-88 

7 Check network configuration see 3-5-1-4 on page 3-76

8 Check the DICOM connection see 4-3-1-1 on page 4-3

9 Check the Ethernet connection to remote DICOM 
devices see 4-3-1-2 on page 4-7

10 Check LOGIQworks services see Section 4-4 on page 4-26

11 Check that all ordered software options are 
available. see 3-5-13-3 on page 3-203

12 Check the Program start up and the Data Selector see 4-3-2-1 on page 4-8

13 Check generic DICOM settings see 3-5-2-6 on page 3-87

14 Check LOGIQworks connectivity settings: 
Receiving devices (destinations) see 3-5-10-2 on page 3-186

15 Check LOGIQworks connectivity settings: 
Sending devices (origins) see 3-5-10-1 on page 3-183

16 Check images can be sent to a configured 
destination device see 4-3-2-3 on page 4-10

17 Check images can be displayed in the viewing 
section see 4-3-2-2 on page 4-9
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4-3-1 Windows Level Check

4-3-1-1 Check the DICOM Connection
Receiving DICOM images requires preparation of both the receiving and the sending site.

Condition: The LOGIQworks system needs to be connected to the network. See Section 2-3-4 on page 
2-14.

Testing the DICOM association:

We recommend testing the association to all devices listed in the destinations and origins table (please 
refer to Section 3-5-10-1 "Setting up and configuring origins" on page 3-183 and Section 3-5-10-2 
"Setting up and configuring destinations" on page 3-186) to ensure that the remote system and 
LOGIQworks have been correctly configured. There is a utility to test the DICOM association: DCMPing, 
which can be found in: C:\AMI_61\Bin for LOGIQworks up to 1.3 systems and in directory C:\Program 
Files\Centricity\RA600\7.0\Bin for LOGIQworks 2.0 and LOGIQworks 3.0.
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4-3-1-1 Check the DICOM Connection (cont’d)

1.) Enter the Host name or IP address of the system the association shall be tested with.
2.) Enter the DICOM port number of the remote system.
3.) Enter the DICOM Application Entity Title of the remote system.
4.) Then press the PING-button.

Figure 4-1  DICOM Pinger

1.

2.

3.

5.Output 
Window

4.
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4-3-1-1 Check the DICOM Connection (cont’d)

5.) The results will be listed in the output window.

Figure 4-2  Calling Remote Device

Figure 4-3  Successful DICOM communication
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4-3-1-1 Check the DICOM Connection (cont’d)

If the DCM Ping fails please go to 4-3-1-2 on page 4-7 for further trouble shooting.

Figure 4-4  DICOM Ping failure
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4-3-1-2 Check Ethernet Connection
Check Ethernet connection (only needed if DCM Ping - see Section 4-3-1-1 "Check the DICOM 
Connection" - fails).

Condition: The LOGIQworks system needs to be connected to the network. See Section 2-3-4 on page 
2-14 for details.

Check the status of the Ethernet connection to the devices your LOGIQworks system is set up to 
communicate with. Please look up all sending and receiving devices in the connections destination and 
origins list from the data selector menu. Refer to 3-5-10-1 on page 3-183 and 3-5-10-2 on page 3-186 
for detailed information on how to set up sending and receiving devices in LOGIQworks.

Run the network ping command to perform this verification:

1.) Click on Start > Programs > Accessories > Command Prompt. A command window will 
open.

2.) Execute the ping command for every IP address listed in the destinations and origins database 
(3-5-10-1 on page 3-183 and 3-5-10-2 on page 3-186).

Example:

Figure 4-5  Ethernet Connection Check

successful,
Ethernet connection 
is good

failed,
connection not 
established
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4-3-2 Application Level Check

4-3-2-1 Check the Program start up and the Data Selector
If not already started automatically during system start up, go to the desktop and double-click the 

LOGIQworks icon 

When the application is up and running the initial view should be the following:

Figure 4-6  LOGIQworks Data Selector
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4-3-2-2 Confirm images can be displayed on the graphical user interface

1.) If not already done, start the LOGIQworks application.
2.) Make sure you have GE Ultrasound Raw Data studies available in the local view or you have a CD 

or DVD work list view configured, see Section 3-5-11-1 "Reading DICOM volume from DVD or CD" 
on page 3-193 for more details.

3.) In the Data Selector select one study for viewing. Double click on it (anywhere in the row in your 
study or patient list).

4.) All the series contained into the selected study will be opened automatically and the application will 
switch to the Viewing Section and display the study.

Figure 4-7  RA600 Viewing Section
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4-3-2-3 Confirm images can be sent to a configured destination device.
Only applicable if your system is connected to a network.

1.) Select the data set you want to send to a remote device listed in the destinations list (see 3-5-10-2 
"Setting up and configuring destinations" on page 3-186 for details on how to set up destinations).

2.) Select the Teleradiology tool tab.

3.) In the destinations pane, select the site to which you want to send one or more images.

4.) Press the send button.

Figure 4-8  Teleradiology Tool tab Icon

Figure 4-9  Teleradiology Tool tab

4.
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4-3-2-3 Confirm images can be sent to a configured destination device. (cont’d)
5.) In the Send to... dialog box specify the format you would like to use from the Format drop-down list.

6.) Make sure the Send Immediate check-box is checked if you wish to send immediately.
7.) Make sure the Image check-box is checked.
8.) Click OK to send your study.
You can now monitor how many studies are waiting to be sent,

a.) whether any are correctly being sent (active)

Figure 4-10  Teleradiology - Configure Sending Parameters

Figure 4-11  Monitor Transmission
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4-3-3 Connectivity
Connectivity on the LOGIQworks™ is based on the DICOM standard. 

4-3-3-1 Teleradiology
Teleradiology allows you to send series, studies, images, or image-related data to another 
LOGIQworks™ or other DICOM 3.0 compliant systems. Also the system is able to query and retrieve 
images from other DICOM 3.0 compliant systems in the network. The steps to prepare the system for 
sending and query retrieve are described in the following sections. The whole process of sending and 
receiving data can be monitored.

4-3-3-2 Configuring Connectivity
Verify correct TCP/IP configuration using the Windows Control Panel.

If not already properly configured, identify the workstation to the rest of the network by filling in its IP 
Address, Subnet Mask, and Gateway (if applicable). Press OK to save the settings.

4-3-3-3 DICOM Properties
Select Configuration -> Generic from the menu bar in the Data Selector. Bring the DICOM tab to the 
front and type in the DICOM Application Entity Title (AE Title) and the Port number.t 

4-3-3-4 Configuring Destinations
To add a teleradiology destination

1.) Select Connection -> Destinations... from the menu bar in the Data Selector.
2.) In the Destinations dialog box, press Add. A dialog opens.

Figure 4-12  Generic Properties
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1.) Enter the name of the new destination. The name will be displayed in the list box on the 
Teleradiology Tooltab. The name field must be unique. The system will check this when you enter 
the name.

2.) Enter the host name (DNS name or IP address) of the new destination.
3.) Optionally, you can enter a description.
4.) Press Next.
5.) Enter the DICOM AE Title for the remote system.

4-3-3-4 Configuring Destinations (cont’d)

Figure 4-13  Destinations
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4-3-3-4 Configuring Destinations (cont’d)
6.) Enter the DICOM Port Number for the remote system.

4-3-3-5 Configuring Origins
To increase system security, you can restrict communication with your LOGIQworks™ PC to a pre-
configured set of permitted origins.

To turn verification on:

1.) In the Data Selector, select Configuration -> Connection Service from the menu and click on the 
Receive tab.

2.) To increase system security enable Verify Origin.

4-3-3-6 Setting up an origin:

1.) From the Data Selector menu, select Connection -> Origins....
2.) Press the Add Button, the Origin Properties page is displayed.
3.) Enter the appropriate information in the dialog box.

4-3-3-7 Receiving Series and Studies
Receiving studies takes place automatically in the background. When LOGIQworks™ has received a 
study, it will automatically place it in the appropriate place in your study list.

To see what images you received:

Figure 4-14  Origins

NOTE On these configuration pages only alter the default settings if this is strictly necessary.
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4-3-3-7 Receiving Series and Studies (cont’d)

1.) Press the Receive Log Button on the Teleradiology tooltab.
2.) The Receive Log will show you all the studies or series you have received along with various details 

about them and the transmission.

4-3-3-8 Sending entire or partial studies
While the patient is open and the plugin not active you can send entire studies, selected images or 
series from your system to another LOGIQworks™ or DICOM 3.0 compliant system.

1.) In the Data Selector select an entire or partial study in the Study or Patient list.
2.) In the Destinations pane of your teleradiology tooltab, select the site or sites to which you want 

to send one or more images.
3.) Press Send.
4.) In the Send to... dialog box select the appropriate options.
5.) Press OK to send your study.

4-3-3-9 Monitoring the Send Process
Using the teleradiology tooltab you can see at a glance if and how many studies are waiting to be sent.

For a more detailed view, press Send Queue on the teleradiology tooltab. The Send Queue box gives 
you information on the active jobs and on those that are waiting to be sent out.

• Details on a particular job [1].
• Remove a job from the queue [2]
• Stop a job currently in progress [3].
• Suspend a job [4].
• Resubmit a job [5].
• Set job priorities: Increase [6], Decrease [7]

Figure 4-15  Send Queue
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4-3-3-9 Monitoring the Send Process (cont’d)

4-3-3-10 Remote View
The filing tooltab lets you select which remote views will appear in the center of your screen.

1.) Select the filing tooltab.
2.) Check the box at the top of the section called Remote Views.
3.) In the area immediately below, you see a number of remote views which have been configured for 

your system.

Figure 4-16  Send Queue



GE MEDICAL SYSTEMS  
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS BASIC SERVICE MANUAL

Chapter 4 Functional Checks 4-17

4-3-3-10 Remote View (cont’d)
4.) In the center of your screen you have your local view at the top [4a] and beneath is a second window 

showing one of your remote views [4b]. If you have multiple remote views, you see tabs at the 
bottom of this window.

5.) A green indicator light at the left upper edge shows that the connection has been properly 
established.

4-3-3-11 Configuring the scanner

1.) On the scanner choose "Utility" > "Connectivity"
2.) Choose the "TCP/IP" tab. Do not change the Computer Name.

1.) Enter the "IP-Address" and the "Subnet Mask" values.
3.) Choose the "Device" tab.

1.) Enter the "Name" and the "IP Address".
4.) Choose the "Service" tab.

1.) Choose in the "Destination Device" field the "LOGIQworks" entry from the pull-down 
menu.

2.) Choose the "Dicom Image Storage" from the text field below.

Figure 4-17  Remote View

5

4b

4a



GE MEDICAL SYSTEMS
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS® BASIC SERVICE MANUAL 

4-18 Section 4-3 - System Check

4-3-3-11 Configuring the scanner (cont’d)
3.) Enter the "AE Title" and the "Port Number" in the "Properties" section.

4.) Choose the "Dicom Query/Retrieve" entry from the text field above.
5.) Enter the "AE Title" and the "Port Number" in the "Properties" section.
6.) Choose the "Dicom Storage Commitment" entry from the text field above.
7.) Enter the "AE Title" and the "Port Number" in the "Properties" section

5.) Choose the "Dataflow" tab.

1.) Choose a dataflow from the list.
2.) Enter the "Name" in the "Properties" section.
3.) Choose a entry in the "Default Dataflow" field.
4.) Choose a "Dataflow View" from the list and add with <<.

6.) Choose the "Button" tab.
7.) Do as described below:

4-3-4 Verification of the installation
To verify the correct installation of the TRUAccess Plug-In 2.0.2 or 3.0 do this:

1.) Start RA 600 and import an image from the database.
2.) Open an image.
3.) Start the TRUAccess Plug-In for the image from the context menu.
4.) Choose the Plug-In tool panel.
5.) Click on “Settings”.
6.) Click on “Utility”.
7.) Open the “About” tab. If “Version 2.0.2” or “Version 3.0” is displayed in the “Software version” field 

the Plug-In is successfully installed.

NOTE For LOGIQ 7 the AE Title has always to begin with "AE_" otherwise the images can not be transferred.

Figure 4-18  Configuring the scanner

Assume
entries

Select LOGIQWorks
and assume it with >>
in the Printflow View
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4-3-5 Service Platform Check for LOGIQworks up to Revision 2.0

4-3-5-1 Checking Global Service Platform connections

1.) Click on the Wrench icon on the desktop or in the Quick Launch bar.
 

2.) Select the logon level and enter the password for it to connect as shown below.
Figure 4-19   Service selection and Logon

Figure 4-20   In site home page for External Service Logon
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4-3-5-2 Checking iLinq Connection

1.) Click On the iLinq button on the Desktop. Wait until the system is connected to GE to check for new 
messages. You will see the update screen.

Figure 4-21   iLinq Home screen
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4-3-6 Modem Check (For LOGIQworks 3.0 optional)

4-3-6-1 Power-On 

1.) Test the modem by turning it on (a power on/off switch is located on the right side). When you apply 
power, the modem performs a diagnostic self-test, indicated by several indicators flashing for a 
second or two, after which the 56 indicator should light.

2.) If this does not happen, check that the power switch is on, the power supply is solidly connected, 
and the AC outlet is live. 

4-3-6-2 Modem Ready
Whenever the system is rebooted, the modem does not go through power cycle. Sometimes it might 
become necessary to restart the modem.

Check the following before restarting the modem:

• Check if there are 2 led lit on the modem. TR (Terminal Ready) and any of the 56,33,14 (indicate 
the maximum data speed of the modem 56kbps, 33kbps or 14kbps).

• Call the modem phone number from a regular phone. Make sure when the modem answers the OH 
(off hook) led is lit, and you hear the modem handshake.

These steps will make sure that the modem phone line is working correctly. 

If the in site checkout or connection still fails,

4-3-6-3 Modem Self-Test
Click on Start->Settings->Control panel->double click phone and modem options->select modems 
tab->

Make sure MultiTech MT5634ZBA is listed.

Select the Modem ->Click on properties-> select Diagnostics tab->click on Query Modem.

Make sure operating system displays a message ‘Communicating with the modem’ and displays certain 
results after some time. Not all the commands are supported by the modem. So some of the diagnostics 
might fail. These unsupported commands are not known to cause any problems.

Figure 4-22   Modem front

Indicators flash here On/Off Switch
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4-3-7 DVD Writer Check

4-3-7-1 Check reading from DVD

 

4-3-7-2 Check writing to DVD

Figure 4-23   DVD-Drive Front

Table 4-4    Using DVD Disk Drive

Step Task Expected Result(s)

1. Press the Eject Button on the DVD drive front to eject the disk tray 
for media input. The DVD drive tray is open.

2. Insert the DVD into the DVD Drive with the label facing up and 
push the tray carefully to close. Check that there is activity in the Busy LED.

3. Open the Windows explorer and check which drive letter is 
representing the DVD drive. Verify that the drive letter F: is assigned to the DVD drive.

4. Read a DICOM Volume from DVD, please refer to Section 3-5-11-
1 on page 3-193 for more details on how to create a CD, DVD or 
other work list views and how to add a view to the data selector.

All studies available on the DICOM media shall be visible in the 
data selector.

5. To eject a disk from the DVD Drive press the Eject Button on the 
DVD front. The DVD drive tray opens and the disk is ready to be removed.

Table 4-5    Using DVD Disk Drive

Step Task Expected Result(s)

1. Press the Eject Button on the DVD drive front to eject the disk tray 
for media input. The DVD drive tray is open.

2. Insert the DVD into the DVD drive with the label facing up and push 
the tray carefully to close. Check that there is activity in the Busy LED.

3. Write a DICOM Volume to DVD, please refer to Section 3-5-11-2 
on page 3-199 for more details on how to prepare the system for 
using SME option and to Section 4-3-8 on page 4-23 for detailed 
steps of how to write data to DVD using the SME option.

4. Writing to DVD is complete. The tray opens automatically and the DVD is ready to be removed.

Eject
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4-3-8 Archiving data with the Single Media Exchange Software Option
To test the SME functionality first select some studies in the Data Selector for writing to the SME.

1.) Either

a.) select the studies by highlighting them in the Data Selector and then selecting Select for 
Archiving on the Archiving menu.

or

b.) Right click on the desired study and select Archiving > Select for Archiving on the popup 
menu. 
Note that the selected studies become marked with Archive in the Selected for Archiving 
column of the Data Selector.

Figure 4-24  Select for Archiving (using the Data Selector menu)
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4-3-8 Archiving data with the Single Media Exchange Software Option (cont’d)

2.) When all the desired studies have been selected for archiving, first ensure a writable CD or DVD is 
in the drive. The approximate number of disks required to store the selected studies is shown in the 
Est. number of disks field on the Archive tab to the right of the Data Selector. Refer to the RadWorks 
6.0 User’s Guide, page 272 for information on using the Archive Index Tool.

Figure 4-25  Select for Archiving (using the Right Click menu)
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4-3-8 Archiving data with the Single Media Exchange Software Option (cont’d)

3.) Start the write operation either 

a.) by clicking the Local Database > Create Volume button on the Archive tab to the right of the 
Data Selector (See Figure 4-26)

or

b.) by selecting the Archiving > Create Volume from current selection from the menu bar.

4.) Once the write process starts, popup windows keep you informed about the archiving process.

Figure 4-26  Create Volume (Tool tab)

Figure 4-27  Create Volume (Data Selector Menu)
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Section 4-4
Healthpage 

4-4-1 Healthpage for LOGIQworks up to Rev. 1.3
The Healthpage tool indicates some details around LOGIQworks.The user can view the license, the 
running services and log files.

1.) To start 'Healthpage', click on the desktop icon:

2.) The main window of 'Healthpage' appears.

3.) Start or stop a service
4.) The green light for each service shows that the service is running.
5.) Clicking the 'Stop service' or 'Start Service' button toggles that service is on or off.

NOTE All log files are also available under 'Service Browser'.

Figure 4-28  Healthpage Icon

Figure 4-29  Healthpage Window
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4-4-1 Healthpage for LOGIQworks up to Rev. 1.3 (cont’d)

Normally all services are running. In cases of updating the system or changing the license file, a manual 
start of all services could be necessary. If the license file is valid, all services start up automatically after 
reboot.

4-4-2 Healthpage for LOGIQworks up to Rev. 2.0 and 3.0
The Healthpage tool indicates some details around LOGIQworks.The user can view the license, the 
running services and log files.

1.) To start 'Healthpage', click on the desktop icon:

NOTE All log files are also available under 'Service Browser'.

Figure 4-30  Healthpage Icon
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4-4-1 Healthpage for LOGIQworks up to Rev. 1.3 (cont’d)

2.) The main window of 'Healthpage' appears.

3.) Start or stop a service
4.) The green light for each service shows that the service is running.
5.) Clicking the 'Stop service' or 'Start Service' button toggles that service is on or off.
Normally all services are running. In cases of updating the system or changing the license file, a manual 
start of all services could be necessary. If the license file is valid, all services start up automatically after 
reboot.

Figure 4-31  Healthpage Window
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4-4-3 Logfiles
You can view the overall Logfile for RadWorks or the logfile for a single service.

Figure 4-32  RadWorks Overall Logfile
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4-4-4 License Configuration
1.) Click 'Licenses', if you want to see what options are included in your license.

You have the possibility to select a license file, to show the license options or to switch to a license 
dongle. 

You should not change anything except you want to change the license to another one.

Figure 4-33  Licence Options

NOTE: This is an example! Your output may differ
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4-4-5 License Test

Figure 4-34  Licence Test
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Section 4-5
Site Log

Date Service person Problem Comments

Table 4-6    Site Log
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Chapter 5
Components and Functions (Theory)

Section 5-1
Overview

5-1-1 Purpose of Chapter 5
This chapter explains LOGIQworks PC’s system concepts, component arrangement, and subsystem 
function.

Table 5-1    Contents in Chapter 5

Section Description Page Number

5-1 Overview 5-1

5-2 Major Components 5-2

5-3 Block Diagrams and Theory 5-3

5-4 Software Theory 5-15

Please refer to Section 3-5-2-1 
"TruAccess Plugin Definition" on page 
3-79 for plugin definition and to Section 
4-3-2 "Application Level Check" on 
page 4-8 for application specific.

5-23

5-5 Common Service Interface 5-29
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Section 5-2
Major Components

LOGIQworks Work Station is a commercially available Dell PC which has Ethernet for communication 
with the local network or the hospital network. It has a modem for internet communications with on-line 
service. It has external read and write media for locally handled scan data. 

5-2-1 List of Major Components
• Monitors (LCD or CRT)
• Dell PC
• Keyboard & Mouse
• Modem (Option)
• USB Hard drive
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Section 5-3
Block Diagrams and Theory

5-3-1 Work Station Overview

5-3-1-1 Technical Specifications of System based on Dell Precision 340
* Dell Precision 340
* Main Processor - Pentium IV 2.4 GHz
* 1024 MB RAM
* Hard Disk Capacity = 80GB
* Internal Archive space:70 GB
* CD RW – 40x, for S/W Upgrade 
* 10/100 Mbit Ethernet
* 3 1/2 “Floppy Disk, 1.44MB, for download data
* Dual Head Graphic Adapter
* IEEE 1394, Fire wire Controller
* Modem 56 Kbit
* 21" Monitor 1280 x 1023 resolution with maximum 170 Hz refresh rate
* 18.1" LCD Screen 
* USB Hard Disk (64MB)

5-3-1-2 Theoretical Description of System based on Dell Precision 340
LOGIQworks runs on a conventional off the shelf PC with either 18.1” LCD monitor or 21” CRT monitor, 
an extended keyboard and a mouse. 

It communicates with Insight and iLinq via a modem interface which has dedicated power and phone 
line delivery.

It runs on a local network or on a hospital network.

This is an overview of the LOGIQworks Work Station interconnections. Each of the main elements will 
be covered on the following pages.

5-3-1-3 Technical Specifications of System based on Dell Precision 360
* Dell Precision 360
* Main Processor - Pentium IV 2.6 GHz
* 1024 MB RAM
* Hard Disk Capacity = 250GB
* Internal Archive space: 230GB
* CD/DVD RW
* 10/100/1000 Mbit Ethernet
* 3 1/2 “Floppy Disk, 1.44MB, for download data
* Dual Head Graphic Adapter
* 19" LCD Screen Europe, 20” LCD Screen US/Asia
* USB Hard Disk (64MB)

5-3-1-4 Technical Specifications of System based on Dell Precision 370
* Dell Precision 370
* Main Processor - Pentium IV 2.8 GHz
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5-3-1-4 Technical Specifications of System based on Dell Precision 370 (cont’d)
* 1024 MB RAM
* Hard Disk Capacity = 250GB
* Internal Archive space: 230GB
* CD/DVD RW
* 10/100/1000 Mbit Ethernet
* 3 1/2 “Floppy Disk, 1.44MB, for download data
* Dual Head Graphic Adapter
* 19" LCD Screen Europe, 20” LCD Screen US/Asia
* USB Hard Disk (64MB)

5-3-1-5 Technical Specifications of System based on Dell Precision 380
* Dell Precision 380
* Main Processor - Pentium IV 3.0GHz
* 1024 MB RAM
* Hard Disk Capacity = 250GB
* Internal Archive space: 230GB
* CD/DVD RW
* 10/100/1000 Mbit Ethernet
* 3 1/2 “Floppy Disk, 1.44MB, for download data
* Dual Head Graphic Adapter
* 19" LCD Screen Europe, 20” LCD Screen US/Asia

5-3-1-6 Technical Specifications of System based on Dell Precision 390
* Dell Precision 390
* Main Processor - Single-Core Intel® Pentium® 4 631 (3,0 GHz, 800 FSB, 2 MB L2-

Cache) or Dual-Core Intel® Core 2 Duo E6400 (2,13 GHz, 1066 FSB, 2 MB L2-Cache)
* 1GB RAM
* Hard Disk Capacity = 250GB
* Internal Archive space: 230GB
* CD/DVD RW
* 10/100/1000 Mbit Ethernet
* 3 1/2 “Floppy Disk, 1.44MB, for download data
* Dual Head Graphic Adapter
* 19" LCD Screen Europe, 20” LCD Screen US/Asia

5-3-1-7 Theoretical Description of System based on Dell Precision 360, Dell Precision 370, Dell 
Precision 380 and Dell Precision 390

LOGIQworks runs on a conventional off the shelf PC with either 19” LCD monitor or 20” LCD monitor, 
an extended keyboard and a mouse. 

It communicates with Insight and iLinq via either a modem (which has it’s own dedicate power and 
phone line), or a (GE approved) VPN connection.

It runs on a local network or on a hospital network.

This is an overview of the LOGIQworks Work Station interconnections. Each of the main elements will 
be covered on the following pages.
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5-3-1-8 Description of Drives and Partition

Table 5-2    Description of Drives and Partition of System based on Dell Precision 340

Table 5-4    Description of Drives and Partition of System based on Dell Precision 370, Dell 
 Precision 380 and Dell Precision 390

Drive Partition

Drive A 3.5” Floppy Disc

Drive B N/A

Drive C
7 GB partition contains Windows 2000 and the LOGIQworks 
application software

Drive D 67 GB partition contains DICOM Data

Drive E USB HDD contains user and software settings

Drive F N/A

Drive G CD-RW Drive used with the SMA option to store DICOM data

Table 5-3    Description of Drives and Partition of System based on Dell Precision 360

Drive Partition

Drive A 3.5” Floppy Disc

Drive B N/A

Drive C
7 GB partition contains Windows 2000 and the LOGIQworks 
application software

Drive D 230 GB partition contains DICOM Data

Drive E Temporary drive for SME Option

Drive F USB HDD contains user and software settings

Drive G CD/DVD RW Drive used with the SME option to store DICOM data

Drive Partition

Drive A 3.5” Floppy Disc

Drive B N/A

Drive C
7 GB partition contains Windows XP and the LOGIQworks application 
software

Drive D 230 GB partition contains DICOM Data

Drive E Temporary drive for SME Option

Drive F CD/DVD RW Drive used with the SME option to store DICOM data

Drive G USB HDD contains user and software settings
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5-3-1 Work Station Overview (cont’d) 

Figure 5-1   Work Station Power and Signal cable Overview
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5-3-2 Monitors

5-3-2-1 Technical Specifications, CRT Monitor
- Manufacturer & Model Name: Sony, GDM-F520.
- 21" screen, (19,8" viewable image size)
- maximum resolution 2048 x 1536.
- Aperture Grille pitch 0.22 mm
- Refresh Rate: 48 to 170 Hz
- Horizontal Scan Range: 30kHz to 137kHz
- Visual Area 404 (H) x 302 (V) mm
- Size (WxHxD): 19.6” x 19.6” x 19.2”/ 497 x 499 x 487 mm.
- Weight: 67.4 lbs/ 30.5 kg
- Power: Operation < 145watts, active off< 3 watts

5-3-2-2 Technical Specifications, LCD Monitor 
- Manufacturer & Model Name: NEC LCD 1880SX-BK
- 18.1" screen, 0.297x 0297 mm pixel pitch
- Visual Area 359 (H) x 287 (V) mm
- 16,7 million colors
- native recommended resolution: 1280 x 1024 @ 60Hz
- Refresh rate: 50 to 85 Hz
- Horizontal Scan Range: 31kHz to 82kHz
- Viewing Angle: Horizontal: 85°, (left, right, up, down)
- Active Display Size359(h) x 302(v) mm
- Size (WxHxD): 15.2” x 15.5-19,9” x 7.1” / 387 x 394.3-504.3x179.6 mm
- Weight: 18.11 lbs/ 8.2 kg
- Power: Operation 50 watts, active off < 1-1.8 watts

5-3-2-3 Technical Specifications, LCD Monitor 
- Manufacturer & Model Name: DELL LCD 1901/2001
- 19" screen, 0.297x 0297 mm pixel pitch
- 16,7 million colors
- native recommended resolution: 1280 x 1024 @ 60Hz/1600x1200 @ 60Hz
- Refresh rate: 56 to 76 Hz
- Horizontal Scan Range: 30kHz to 80kHz
- Viewing Angle: Horizontal: 85°, (left, right, up, down)
- Active Display Size359(h) x 302(v) mm
- Size (WxHxD): 15.2” x 15.5-19,9” x 7.1” / 387 x 394.3-504.3x179.6 mm
- Weight: 16.19 lbs/ 7.35 kg
- Power: Operation 50 watts, active off < 1-1.8 watts
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5-3-2-4 Theoretical Description of System based on Dell Precision 340
The Monitors receive a video signal from the PC.

Figure 5-2  Monitors Power and Signal cabling information
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5-3-2-5 Theoretical Description of System based on Dell Precision 360, 370, 380, 390
The Monitors receive a video signal from the PC. 

Figure 5-3   Monitors Power and Signal cabling information.
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5-3-3 Dell PC

5-3-3-1 Technical Specifications, Dell Precision Workstation
- Main Processor - Pentium IV, 2.6 GHz
- Hard Disk Capacity 120 GB or 250GB
- DVD +R/RW, for S/W Upgrade 
- 1024 MB RAM
- 3 1/2 “Floppy Disk, 1.44MB, for download data
- Size (WxHxD): 4.1” x 7.7” x 17.5”/ 106x181x447 mm
- Weight: Approximately 18 lbs/40 kg to 157 lbs/71 kg

5-3-3-2 Theoretical Description
The PC receives input power from wall outlet. It has TCP/IP communications via a local ethernet 
network. It has online TCP/IP communications via a Modem. It is Fire wire (IEEE1394) interfaced with 
an external DVD Writer It delivers Digital Output to a LCD monitor.

Figure 5-4   Dell PC Power and Signal cabling information
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5-3-4 Keyboard & Mouse

5-3-4-1 Theoretical Description
With the keyboard and mouse controls, functions and text are entered and sent to the PC. There they 
are interpreted and translated into digital or analog signal and presented on the monitor.

Figure 5-5   Keyboard & Mouse Signal cabling information
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5-3-5 Modem (optional)

5-3-5-1 Technical Specifications, Modem Unit
- Manufacturer & Model Name: MultiTech Systems, Multi Modem ZBA
- 56k Modem
- Data Format: serial, binary, asynchronous
- Flow control XON/XOFF (software), RTS/CTS (hardware)
- Size (WxHxD): 4.3” x 1.2” x 5.8” / 10.8 x 2.9 x 14.8 cm
-  Weight: 0.5 lbs/ 0.22 kg

5-3-5-2 Theoretical Description
The Modem Receives power via a dedicated wall outlet. It is the telephonic link between the work station 
and the GE online centre. It communicates with the PC over an RS232 interface.

Figure 5-6   Modem Power and Signal cabling information
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5-3-5-2 Theoretical Description (cont’d)

Figure 5-7   Modem Signal cabling information of the USB Modem
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5-3-6 USB HDD

5-3-6-1 Technical Specifications USB
- Manufacturer: DELL
- Interface: USB
- Capacity: 64MB

5-3-6-2 Theoretical descriptions
The USB HDD receives power from the USB interface. It has read/write communications with the PC 
over a USB interface.

.

Figure 5-8   USB HDD Signal cabling information
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Section 5-4
Software Theory

5-4-1 Software Theoretics
LOGIQworks is a standard PC application. It runs on the same operating system that is globally chosen 
by GE for all its cardiac and radiology products. LOGIQworks is a combination of the proven RadWorks 
(Centricity RA600 review workstation) multi-modality platform and GE’s TruAccess technology. In other 
words it contains a TruAccess raw data processing software plugin based on the same application that 
is installed and runs on the PC back end within GE Radiology Ultrasound Scanners such as LOGIQ 9 
and LOGIQ 7.

Transferred studies, images and cine loops in DICOM and Raw data formats will appear in the Data 
Selector, the “home base” when using LOGIQworks. The Data Selector lets you manage your images 
and patient studies and load them from local and remote DICOM 3.0 compliant storage devices.

Figure 5-9  LOGIQworks Data Selector
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5-4-1 Software Theoretics (cont’d)

The application handles DICOM 3.0 compliant data for all modalities. Also it is able to store, transfer 
and re-send DICOM 3.0 compliant data that includes GE Ultrasound Raw data in private DICOM data 
elements.

To open a study for viewing, you can select all the series within a study, a particular series or even an 
individual image. Or you select multiple patients, studies, series or images which are all to be opened 
for viewing.

Double click on the selected study, series or images or right click on the selection and press View from 
the right-click-menu.

When the data is opened for viewing you get to the viewing section of LOGIQworks. At this time you are 
still working in the RadWorks part of LOGIQworks, where only the DICOM standard image data is 
displayed. 
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5-4-1 Software Theoretics (cont’d)

When in this Viewing Section of LOGIQworks, there are many possible layouts or hanging protocols 
that can be used to show your information.

Figure 5-10  LOGIQworks Viewing Section

Pictorial Index Display Window Control Panel
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5-4-1 Software Theoretics (cont’d)

One of them is the TruAccess hanging protocol:

When you are viewing images from GE’s LOGIQ 7 and LOGIQ 9 ultrasound scanners that contain GE’s 
TruAccess Raw Data you can select this TruAccess hanging protocol to activate the TruAccess Raw 
Data Processing Plugin. When the plugin is started the Ultrasound Raw Data information is read from 
the private DICOM elements of the selected DICOM image and you have access to the same image 
manipulation functionality as on the ultrasound scanners.

Figure 5-11  TruAccess Hanging Protocol
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5-4-1 Software Theoretics (cont’d)

From the LOGIQworks TruAccess plugin images can be saved back to the local database in DICOM 
Secondary Capture format. They will be stored in a new series to the same study. As an alternative they 
can be also explicitly saved to disk either as AVI, JPEG, RawDICOM or DICOM.

Figure 5-12  TruAccess Plugin
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5-4-1 Software Theoretics (cont’d)

Figure 5-13  Pictorial Index after Storing an image from the TruAccess plugin

New series 
containing 
Secondary 
Capture image 
stored from 
within the 
plugin
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5-4-1 Software Theoretics (cont’d)

As an alternative they can also be explicitly saved to disk either as AVI, JPEG, RawDICOM or DICOM.

5-4-2 Services
The DICOM services consist of 3 different services: front end application, the connection service and 
the print service. All three are implemented as separate Windows services that run as background 
processes. All 3 services have dedicated user accounts they will use to log on.

All 3 users are belonging to the RW-Service Group.

They are all started automatically during system start-up and will remain active until shutdown. That 
means, that requests for e.g. image storage can be accepted at all times when the system is up and 
running, regardless of whether the LOGIQworks application is active or not.

The connection service is responsible for image reception and transmission in addition to accepting 
requests for database queries and retrieves. It maintains logs of all studies that entered and left the 
system. It can perform scheduled image transfers to remote Application Entities at all times. The 
LOGIQworks front-end application issues queries to remote DICOM databases and initiates import 
requests. Please note that the destination of imports is the LOGIQworks Connection Service.

The LOGIQworks Print Service is responsible for managing print job queues for one or more printers or 
laser imagers. It supports several protocols of which the DICOM standard is one. Please note that the 
print service is an optional component of the LOGIQworks installation.

Figure 5-14  Data Selector with new series 

Table 5-5    LOGIQworks Services

Services User Account

AMI Database DB-Service

AMI Connection CN-Service

AMI Print PR-Service

NOTE Please make sure that the properties of these users are never changed! Never remove one of these 
users from the user manager. They are essential for the proper functioning of the LOGIQworks system.

New Series
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5-4-2 Services (cont’d)

The Database and Connection Services are integral parts of a LOGIQworks installation.

In addition to the Storage SOP Class support for networking, LOGIQworks also supports the Media 
Storage Service Class for the Interchange of images as a File Set Reader (FSR) and File Set Creator 
(FSC). FSR is a standard feature and FSC is an optional feature.

5-4-3 Functional Definitions of Application Entities
The Application Entity of the LOGIQworks Connection Service acts as an SCU for the verification, 
storage, and storage commitment SOP classes and as an SCP for verification, storage, query, retrieve, 
and storage commitment SOP classes.

The Application Entity of the LOGIQworks front-end application acts as an SCU for the query and 
retrieve SOP classes.

The Application Entity of the LOGIQworks Print Service acts as an SCU for the basic gray scale and 
color print management meta SOP classes, and optionally the Print Job and Basic Annotation Box SOP 
classes.

5-4-4 Number of associations
The LOGIQworks Connection Service supports multiple associations both as an SCU and SCP. By 
default the maximum number of simultaneous associations that the Connection Service will support as 
an SCP is 4.

Please refer to RadWorks 6.0 Installation Guide, page 54, Configuring teleradiology section, Setting up 
the Connection Service.

When receiving images or processing query and retrieve requests as an SCP the Connection Service 
will start a new thread for each association that is being handled. As an SCU the Connection Service 
also supports multiple associations, for instance to verify a remote destination and simultaneously send 
images to a storage SCP.

The LOGIQworks front-end application supports multiple associations as an SCU for query and retrieve 
to different SCPs. Multiple queries and/or retrieves to the same SCP will be performed sequentially.

The LOGIQworks Print Service will queue multiple print jobs such that it only establishes one 
association as an SCU at a time when it manages multiple laser imagers via DICOM.

The LOGIQworks DICOM services do not support asynchronous operations and will not perform 
asynchronous window negotiation.

5-4-5 Auto-routing
LOGIQworks allows image transfers to be scheduled for specific times and has mechanisms for retrying 
a transfer in case that a transfer failed at an earlier time. After a configured number of unsuccessful 
attempts LOGIQworks will mark the transfer as failed. The LOGIQworks system keeps a log of transfers 
that is viewable by the user. The log indicates the status of transfers.

LOGIQworks provides full (level 2) conformance as SCP of the Storage SOP class. This means that 
upon sending an image received via DICOM on to another DICOM compliant system it will send out all 
attributes that it received (this includes private attributes from other vendors).

Please refer to RadWorks 6.0 Installation Guide, page 54, Configuring teleradiology section, Setting up 
auto-routing.
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5-4-6 Query a remote database and retrieve from a remote system
The user of the LOGIQworks system wants to have a view on a remote DICOM database and either 
views the complete contents of the remote database or fills out a query dialog box with fields for Patient 
Name, Patient ID, Study date, etc. Wild cards can be used instead of fully specified information to allow 
flexible queries. The contents of this dialog box and the requested columns in the Remote view can be 
fully configured, hence the contents of the Query data is dependent on the configuration.

After a view on a remote DICOM database has been obtained the user makes a selection of one or more 
studies, series or images and subsequently presses the Import button. This will initiate the transfer of 
images from the remote system to the local database of LOGIQworks.

Please refer to RadWorks 6.0 User’s Guide, page 55.

Note that the LOGIQworks front-end application performs the C-MOVE operation while the destination 
of the resulting C-STORE operation is the LOGIQworks Connection Service

5-4-7 Print management
The LOGIQworks user selects a study in the local database and submits it to the Print Service as a job 
for the desired laser imager. The user can choose several parameters such as the layout of the film and 
number of copies. Or the LOGIQworks user creates a Virtual Film Sheet print job from the studies 
available in the Viewing module and submits it as a job for the desired laser imager. On a per-image or 
per-sheet basis several parameters can be altered. When submitting the job the user can choose a few 
parameters, such as the number of copies.

The LOGIQworks Print Service is able to send the appropriate data to printers that support True Size 
printing, both for gray scale printers and color printers. The LOGIQworks Print Service will send the pixel 
data in its native size and additionally sends the Requested Image Size, which is considered to be a 
request to the Print SCP to Print at that size. 

Please note that there is no formal way in DICOM to verify whether a DICOM Print SCP actually 
supports True Size printing, and that some Print SCPs do not report a failure when the Requested 
Image Size was requested by the SCU but not supported by the SCP. 

As a result LOGIQworks Print Service can be configured in a way that it seems that images will be 
printed True Size, while they are just printed at a different size. It is up to the system integrator to verify 
from the printer's DICOM conformance Statement whether that printer supports True Size printing, 
before setting the True Size option in the configuration for that particular printer.

Please refer to RadWorks 6.0 Installation Guide, page 140, Configuring Printing.

5-4-8 Overview of supported DICOM services
For an exhaustive overview of the supported DICOM services please refer to the LOGIQworks DICOM 
Conformance Statement for DICOM V3.0 Direction 2361950-100.(DCS LOGIQworks Rev0.pdf) 

5-4-9 TruAccess Raw data processing
The LOGIQworks workstation offers extended image manipulation capabilities on GE Ultrasound Raw 
DICOM images. While in the viewing section screen, the user gets access to these functions by 
selecting the TruAccess Raw data processing plug in definition. Plug in access is only available when 
configured in the plug in definition screen;

Please refer to Section 3-5-2-1 "TruAccess Plugin Definition" on page 3-79 for plugin definition and to 
Section 4-3-2 "Application Level Check" on page 4-8 for application specific.
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5-4-10 Keyboard Shortcuts
 

Table 5-6    Overview of LOGIQworks Shortcut checks

Step Check Expected Result

1 Press the CTRL + Q key when in Data 
Selector.

Perform a query. Query Parameters dialog 
box pops up.

2 Press the CTRL + I key when in Data 
Selector. View information

3 Press the CTRL + O key when in Data 
Selector. Open folder in study or patient view.

4 Press the CTRL + C key when in Data 
Selector. Close folder in study or patient view.

5 Press ALT + L, T when in Quality Control or 
viewing. Hide/Show tool tabs.

6 Press ALT + L, P when in Quality Control or 
viewing. Hide/Show Pictorial Index.

7 Press ALT + L, R when in viewing. Hide/Show Reports window.

8 Press ALT + L, D when in Quality Control or 
viewing. Hide/Show local database window.

8 Press ALT + Q, R when in Quality Control. Reset images to original state.

9 Press ALT + Q, B when in Quality Control. Go back to Data Selector.

‘10 Press ALT + Q, E when in Quality Control. Edit demographics.

11 Press ALT + Q, M when in Quality Control. Match

12 Press ALT + Q, H when in Quality Control. Study status history.

13 Press ALT + Q, D when in Quality Control. Show Data Selector.

14 Press ALT + Q, W when in Quality Control. Show work list.

15 Press ALT + M, D when in Quality Control. Remove (delete) series.

16 Press ALT + M, I when in Quality Control. Insert as series.

17 Press ALT + M, N when in Quality Control. Insert as images.

18 Press ALT + M, P when in Quality Control. Set patient orientation.

19 Press ALT + Q, S when in Quality Control. Save changes to study.

20 Press ALT + L, T when in viewing. Hide/Show tool tabs.

21 Press ALT + S, S, V when in viewing. Set Scope to Viewport.

22 Press ALT + S, S, O when in viewing. Set Scope to one series.

23 Press ALT + S, S, S when in viewing. Set Scope to study.

24 Press ALT + S, S, A when in viewing. Set Scope to all.

25 Press ALT + S, R when in viewing. Reset images to original state.
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26
Press ALT + S, L when in viewing. Load selected study for viewing (and 

replace current loaded study)

27
Press ALT + S, A when in viewing. Add study (load selected study to compare 

with currently loaded study):

28 Press ALT + I, C, U when in viewing. Select up direction for cine.

29 Press ALT + I, C, D when in viewing. Select down direction for cine.

30 Press ALT + I, C, B when in viewing. Select bounce for cine.

31 Press ALT + I, F, H when in viewing. Flip image horizontally.

32 Press ALT + I, F, V when in viewing. Flip image vertically.

33 Press ALT + I, F, L when in viewing. Rotate 90° to left.

34 Press ALT + I, F, R when in viewing. Rotate 90° to right.

35 Press ALT + I, A, C, M when in viewing. Create marker.

36 Press ALT + I, A, C, T when in viewing. Create annotation text.

37 Press ALT + I, A, C, D when in viewing. Create distance indicator.

38
Press ALT + I, A, O when in viewing. Show image annotation (if previously 

created).

39 Press ALT + I, Q, L when in viewing. Select linear interpolation for zoom.

40 Press ALT + I, W, I when in viewing. Invert image.

41 Press ALT + I, W, R when in viewing. Create ROI for windowing.

42 Press ALT + I, W, T, L when in viewing. Select linear windowing function.

43 Press ALT + I, W, T, E when in viewing. Select exponential windowing function.

44 Press ALT + I, W, T, O when in viewing. Select logarithmic windowing function.

45 Press ALT + I, W, T, when in viewing. Select sigmoid windowing function.

46 Press ALT + I, F, Right Arrow then Down 
Arrow plus [Enter] when in viewing. Select image filter option.

47 Press ALT + I, C, C, Right Arrow when in 
viewing. Select cutlines option.

48 Press ALT + S, P when in viewing. Load previous study in selection.

49 Press ALT + S, N when in viewing. Load next study in selection.

50 Press ALT + S, B when in viewing. Go back to Data Selector.

51 Press ALT + I, Z, 1 thru 4 followed by 
[Enter] when in viewing. Select zoom factor of 1 to 4

52 Press ALT + I, Z, T when in viewing. Show images at true size

53 Press ALT + I, Z, M when in viewing. Create magnifying glass.

Table 5-6    Overview of LOGIQworks Shortcut checks

Step Check Expected Result
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54 Press ALT + I, C, O when in viewing. Start cine.

55 Press ALT + I, C, M when in viewing. Create manual cine

56 Press ALT + I, C, F when in viewing. Stop cine.

57 Press ALT + I, A, C, R when in viewing. Create profile.

58 Press ALT + I, A, C, B when in viewing. Create box ROI.

59 Press ALT + I, A, C, E when in viewing. Create elliptical ROI

60 Press ALT + I, A, C, R when in viewing. Create freehand ROI

61 Press ALT + I, A, C, O when in viewing. Create polygon ROI

62 Press ALT + I, A, C, A when in viewing. Create angle.

63 Press ALT + I, A, F when in viewing. Display full annotation.

64 Press ALT + I, A, B when in viewing. Display basic annotation.

65 Press ALT + I, A, N when in viewing. Display no annotation.

66 Press ALT + I, K, K or CTRL + Left mouse 
button when in viewing. Mark as key image.

67 Press ALT + I, K, O when in viewing. Show key images only.

68 Press ALT + I, I when in viewing. Show DICOM info

69
Press ALT + I, C, C, C when in viewing. Copy image in viewport to windows 

clipboard.

70 Press ALT + I, T when in viewing. Export image in viewport as TIFF.

71 Press ALT + T when in TruAccess Plugin - 
Measure Mode

Toggle between Measure Menu and 
TruAccess Control tab.

72 Press ESC key in all TruAcces menus and 
dialogs Get out of the menu/dialog

73 Press ESC key when in TruAccess 
Worksheet Exit and go to Review Screen

Table 5-6    Overview of LOGIQworks Shortcut checks

Step Check Expected Result
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5-4-11 Workstation Directory Tree of LOGIQworks up to Revision 1.3

Figure 5-15  Workstation Directory Tree

RA600 Root directory
Archive Index Tool, containing the AIT database
RA600 binaries (dlls, exe, manuals, tools like Healthpage, DCMPing etc.).

RA600 Connection Service Database

RA600 Study Database

RA600 CD Viewer, DICOM Viewer to display DICOM data from Media

RA600 Local Database, not used. Database is located on drive D, see below

RA600 Working folder, used for temporary storage, e.g. during archiving to CD

RA600 Logging folder, not used. Files are collected on drive D, see below
RA600 Print Service Database

TruAccess plugin root directory

RA600 User Profiles in XML, use RadWorks Settings Tool for storage

Resources – configuration system for the TruAccess plugin
Service Software 

RA600 on D drive, for database only. Hidden directory by default, to make it 
visible go to the Explorer select Tools – Folder Options, click on the View tab 
and unselect “Hide protected Operating System Files”.

RA600 Study Database located on D drive 

TruAccess plugin, executable

Used for storage of AVI, JPEG, RawDICOM and DICOM files from within the Plugin
Service directory to collect service related debugging information. This 
folder is essential for proper functionality of the entire system!
RA600 log files

Network tool log files

AMI_61

AMI_61

AMI_61
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5-4-12 Workstation Directory Tree of LOGIQworks 2.0 and 3.0

Figure 5-16  Workstation Directory Tree

RA600 Root directory

Archive Index Tool, containing the AIT database

RA600 binaries (dlls, exe, manuals, tools like Healthpage, DCMPing etc.).

RA600 Connection Service Database

RA600 CD Viewer, DICOM Viewer to display DICOM data from Media

RA600 Local Database, not used. Database is located on drive D, see below
RA600 Working folder, used for temporary storage, e.g. during archiving to CD

RA600 Print Service Database

TruAccess plugin root directory

Resources – configuration system for the TruAccess plugin

Service Software 

RA600 on D drive, for database only. Hidden directory by default, to make it 
visible go to the Explorer select Tools – Folder Options, click on the View tab 
and unselect “Hide protected Operating System Files”.

RA600 Study Database located on D drive 

TruAccess plugin, executable

RA600 log files
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Section 5-5
Common Service Interface

5-5-1 Introduction
The Service Platform contains a set of software modules that are common to all ultrasound and 
cardiology systems containing a PC back end. This web-enabled technology provides linkage to e-
Services, e-Commerce, and the iCenter, making GE’s scanners more e-enabled than ever. The Service 
Platform will increase service productivity and reduce training and service costs.

5-5-2 iLinq Interactive Platform Features
Many of the services of the Common Service Platform come from its integration with iLinq. The following 
sections contain a brief introduction of iLinq’s features.

5-5-2-1  Web Server/Browser
The Service platform and other Service software use the iLinq web server and Netscape browser.

5-5-2-2 Connectivity*
This feature provides basic connectivity between the scanner and the OnLine Center (OLC).

5-5-2-3 Configuration
This feature provides for the interfaces to configure various iLinq parameters.

5-5-2-4 Contact GE
Allows for an on-screen one-touch button used to contact the OnLine Center and describe problems 
with their scanner in an easy and convenient way.

5-5-2-5 Interactive Application
The main application is displayed in the form of HTML pages whenever the Netscape browser starts. 
This is the entry point for any user to start any iLinq application.

NOTE *These features that allow the customer to contact the GE OnLine Center are available for Warranty 
and Contract customers only.
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5-5-3 Global Service User Interface (GSUI)

5-5-3-1 Internationalization
The user interface provided by the service platform is designed for GE personnel and as such is in 
English only. There is no multi-lingual capability built into the Service Interface.

5-5-3-2 Service Login
Select the wrench icon in the Windows task bar at the bottom of the screen.

This icon links the user or the Field Engineer (FE) to the service login screen.

5-5-3-3 Access / Security
The service interface has different access and security user levels. Each user is only granted access to 
the tools that are authorized for their use.

Figure 5-17   Login Screen for Global Service User Interface

NOTE OnLine Center access to the workstation requires the password and they must have “Disruptive” 
permission and customer input to run diagnostics.

Table 5-7    Service Login User Levels

User Level Access Authorization Password

Operator
Administrator
External Service

Authorized access to specified diagnostics, error logs and 
utilities. Same acquisition diagnostic tests as GE Service.

uls
uls
gogems

NOTE For a GE Field Engineer, the password changes at specific intervals. Access with the password is tied 
to the service key.
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5-5-3-3 Access / Security (cont’d)
Every access request, whether successful or not, will be logged into a service access log that is 
viewable to authorized users.

5-5-4 Service Home Page
When the Service Interface is started, the Service Home Page appears. The Home Page contains the 
software revision along with the hardware inventory and the results of the latest System Health 
Information. The navigation bar at the top of the screen allows the user to select from several tools and 
utilities.
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5-5-4 Service Home Page (cont’d)

Figure 5-18  Customer Service Home Page
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5-5-5 Error Logs Page
In the Error Logs page there are 2 types of Error Logs:

• Error Logs for Centricity
• Error Logs for TruAccess Plugin.

5-5-5-1 Error Logs for Centricity
Select one of the proposed categories in the list above. There are at least 4 different logs available:

• Connection.LOG
• Database.LOG
• Print.LOG
• RadWorks.LOG
All logs have the same structure and are written in text format. The structure is: date and time followed 
by a descriptive text. The text is self-explanatory.

Dependent on the settings in LOGIQworks additional logs can be listed.

5-5-5-2 Error Logs for TruAccess
From the Error Logs tab the Log Viewer displays four categories with pull-down sub-menus and an Exit 
selection. The Service Interface allows scanner logs to be viewed by all service users.

The Filter Error log is keyed to GE Service login access permissions and is not available to customer 
level analysis.

The log entries are color-coded to identify the error level severity at a glance.

Figure 5-19  Error Logs for Centricity

Available Logs
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5-5-5-2 Error Logs for TruAccess (cont’d)

The Service Interface supports the transfer of these logs to local destinations such as the MOD and CD-
ROM drive.

5-5-5-2-1 Logs 
The seven sub-menus of the Logs category are System, Power, Informatics, Temperature, Probe, 
Board and DICOM.

Log table headings for the different logs are as follows:

• System
Log entry headings include TimeStamp; Error Level; Package and Error Message.

• Power
Log entry headings include Time Stamp; Error Level; Package and Error Message

Table 5-8    Log Entry Key

Severity Error Level Color Code

1 Information Green

2 Warning Blue

3 Error Red

Figure 5-20   Error Logs

NOTE Figure 5-20 provides a graphical example of the log entries for the System Logs.
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5-5-5-2 Error Logs for TruAccess (cont’d)
• Informatics

Log entry headings include TimeStamp; Revision; PtID; PtDOB; PtSex; PtWeight; PtHeight; 
ExamID; Exam Category; ExamCurDate and ExamStartTime.

• Temperature
Log entry headings include TimeStamp: Error Level; Package; Upper FEC Sensor and Lower FEC 
Sensor.

• Probe
Log entry headings include TimeStamp; Error Level; Package; Error Message; Severity; Revision 
and three (3) new labels that have not yet been named.

• Board
Log entry headings include TimeStamp; Error Level; Package; Board; Severity and two (2) new 
labels that have yet been named.

• DICOM
Log entry headings include TimeStamp; Error Level; Package and Error Message.

5-5-5-2-2 Utilities
The two sub-menus of the Utilities category are Plot Log and Plot Page.

• Plot Log
Allows for the color coded plot of all Log contents with the package on the “X” axis and incident 
count on the “Y” axis.

• Plot Page
Allows for the color coded plot of all Page contents with the package on the “X” axis and incident 
counts on the “Y” axis.

Figure 5-21  Utilities Sub-Menus
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5-5-5-2 Error Logs for TruAccess (cont’d)

5-5-5-2-3 Exit
The sub-menu, Exit Log Viewer, returns the user to the Service Desktop home page.
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5-5-5-2 Error Logs for TruAccess (cont’d)

Figure 5-22   Exit Log Sub-Menu
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5-5-6 Diagnostics
Detailed Diagnostic information is found in Section  "Diagnostics/Troubleshooting" on page 7-1

5-5-6-1 Diagnostics Execution
Diagnostic tests are executable by both local and remote users. The Service Platform provides top-level 
diagnostic selection based on the user’s level and login access permissions. Remote access will require 
disruptive diagnostic permissions to run Acquisition diagnostics.

5-5-6-2 Diagnostic Reports
Diagnostic tests return a report to the Service Platform. The platform retains the report and allows for 
future viewing of the diagnostic logs.

5-5-6-3 Proactive Diagnostics
A system of self-monitoring is largely supported with the integration of iLinq. The scheduler, executive, 
user interfaces and some of the proactive diagnostic functions are provided by iLinq. Other tasks should 
be provided by the product team.

Figure 5-23   GE Service Diagnostic Page
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5-5-7 Image Quality
The Image Quality page is intended to contain tools for troubleshooting image quality issues.

5-5-8 Calibration
The Calibration page is intended to contain tools used to calibrate the system.

Figure 5-24  Image Quality Page

Figure 5-25  Calibration Page
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5-5-9 Configuration
The Configuration page is intended to be used to setup various configuration files on the system.

The Service Platform is the access and authorization control for remote access to the configuration 
subsystem.

The enable/disable of software options can be done from this Configuration page.

Figure 5-26  Configuration Page
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5-5-10 Utilities
The Utilities page contains several miscellaneous tools. 

These tools are available:

• Windows utilities
- Disk usage: shows available and used disk space
- IP Configuration: shows several network and TCP/IP parameters
- Network status: lists the usage of network protocols, addresses and ports
- Windows services: lists all running background services
- User accounts: lists all applied users (including system users)
- Shared Resources: shows remote accessible drives and folders
- System Shutdown: possibility to remotely shutdown or restart computer

• System utilities
-
- Resource File Utilities: enables the viewing of special files
- Image Viewer Utility: shows the folder where files intended for the export are stored
-

• DICOM
- tools: reserved for future use

Figure 5-27   Utilities/Tools Page
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5-5-11 Replacement
Not available for this product.

5-5-12 PM
Not available for this product.
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Chapter 6
Service Adjustments

Section 6-1
Overview

6-1-1 Purpose of Chapter 6
This chapter explains how to do Monitor adjustments.

Table 6-1    Chapter 6 Contents

Section Description Page Number

6-1 Overview 6-1

6-2 Monitor Adjustment 6-2

WARNINGWARNING Danger of False Diagnosis!

An incorrect monitor or incorrect monitor configuration can lead to false diagnosis.

Adjust the monitor to display the images in adequate quality according to the manufacturer's 
instructions for use. If in doubt, please contact your service representative.
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Section 6-2
Monitor Adjustment

6-2-1 NEC 1880, 18,1" LCD
The Quick Start Guide is delivered with the LCD Monitor. It is also available on the Internet at this 
location: 

http://www.plasmasync.com.

6-2-1-1 Screen Manager
See MultiSync LCD 1880 Sx Quick Start Guide.

6-2-1-2 Screen Adjustment

1.) See MultiSync LCD 1880 Sx Quick Start Guide.
2.) To calibrate the monitor so that it is capable for diagnostic medical usage set the Contrast value to 

50 and the Brightness to a value from 90-100.

6-2-1-3 Displaying a Low Resolution
See MultiSync LCD 1880 Sx Quick Start Guide.

6-2-1-4 Color Adjustment

1.) See MultiSync LCD 1880 Sx Quick Start Guide.
2.) To calibrate the monitor so that it is capable for diagnostic medical usage set the Color temperature 

to Native.

6-2-1-5 Power-save Setup
See MultiSync LCD 1880 Sx Quick Start Guide. 

6-2-2 Dell LCD 1901/2001
The Quick Start Guide is delivered with the LCD Monitor. It is also available on the Internet at this 
location: 

http://www.dell.com.

6-2-2-1 Screen Manager
See Dell LCD 1901/2001 Manual.

6-2-2-2 Screen Adjustment

1.) See Dell LCD 1901/2001 Manual.
2.) To calibrate the monitor so that it is capable for diagnostic medical usage set the Contrast value to 

50 and the Brightness to a value from 90-100.

6-2-2-3 Displaying a Low Resolution
See Dell LCD 1901/2001 Manual.

WARNINGWARNING Allow the monitor to warm up at least 20 minutes before making adjustment.

WARNINGWARNING Allow the monitor to warm up at least 20 minutes before making adjustment.
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6-2-2-4 Color Adjustment

1.) See Dell LCD 1901/2001 Manual.
2.) To calibrate the monitor so that it is capable for diagnostic medical usage set the Color temperature 

to Native.

6-2-2-5 Power-save Setup
See Dell LCD 1901/2001 Manual. 
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6-2-3 Sony Triniton, GDM-F520, 21" CRT
The Sony Monitor Operating Instruction are delivered with the Monitor.

6-2-3-1 Monitor On-screen Menu Language
See Sony Monitor Operation Instructions.

6-2-3-2 On-screen Menu
See section “Customizing Your Monitor” in the Sony Monitor Operating Instruction on how to make 
numerous adjustments to the monitor, by using the on-screen menu.

6-2-3-3 Brightness and Contrast

1.) See step “Adjusting the brightness and contrast” section “Customizing Your Monitor” in the Sony 
Monitor Operating Instruction. 

2.) To calibrate the monitor so that it is capable for diagnostic medical usage set the Contrast value to 
85 and the Brightness to a value from 50-80.

6-2-3-4 Centering of the Picture
See step “Adjusting the centering of the picture (CENT)” section “Customizing Your Monitor” in the Sony 
Monitor Operating Instruction.

6-2-3-5 Picture Size
See step “Adjusting the size of the picture (SIZE)” section “Customizing Your Monitor” in the Sony 
Monitor Operating Instruction.

6-2-3-6 Picture Zoom
See step “Enlarging or reducing the picture (ZOOM)” section “Customizing Your Monitor” in the Sony 
Monitor Operating Instruction.

6-2-3-7 Shape of Picture
See step “Adjusting the shape of the picture (GEOM)” section “Customizing Your Monitor” in the Sony 
Monitor Operating Instruction. 

6-2-3-8 Color

1.) See step “Adjusting the color of the picture (COLOR)” section “Customizing Your Monitor” in the 
Sony Monitor Operating Instruction.

2.) To calibrate the monitor so that it is capable for diagnostic medical usage set the Color temperature 
to 9300 K.

6-2-3-9 Convergence
See step “Adjusting the convergence (CONV)” section “Customizing Your Monitor” in the Sony Monitor 
Operating Instruction. 

6-2-3-10 Additional settings
See step “Additional settings (OPTION)” section “Customizing Your Monitor” in the Sony Monitor 
Operating Instruction.

WARNINGWARNING Allow the monitor to warm up at least 20 minutes before making adjustment.
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6-2-4 Calibrate CRT Monitor

Before you will be able to view images at their true size, your monitor or monitors will have to be 
calibrated. Also, the picture on all display monitors will gradually change over time, so the image may 
become slightly smaller or larger. Most of the time this will hardly matter, but for true size display it 
means that it is important to periodically re calibrate your monitor or monitors to ensure optimum 
accuracy. 

To calibrate a monitor for true size display 

1.) Select Viewing -> Calibrate Monitors... from the menu bar in the Data Selector. 

Figure 6-1  Monitor Calibration
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6-2-4 Calibrate CRT Monitor (cont’d)

2.) Using a ruler and the monitor's controls, make the three horizontal lines on the monitor calibration 
screen the same length. Type this length in millimeters in the box in the center right of the screen. 

3.) Read the vertical length (in millimeters) automatically inserted by LOGIQworks in the other box in 
the center at the bottom of the screen and use the monitor's controls to set the lengths of the vertical 
lines equal to each other and to the value given by LOGIQworks. 

4.) For a multi-monitor system, repeat the process for the other monitors in the system.
If you are calibrating a multi-monitor system, the monitor calibration screen will first appear on your top 
left monitor and then on each of the remaining monitors in turn. 

Please refer to the RadWorks 6.0User’s Guide, page 190 for further information. 

To calibrate brightness and contrast

go to the desktop and click on the  icon to open the following Bitmap:

Follow the following monitor calibration procedure:

1.) Perform calibration in dim room.
2.) Set Contrast = 50 and Brightness = 100 using monitor controls.
3.) Test pattern consists of small gray box within black boxes.
4.) Slowly decrease brightness just until inner box is no longer visible.

The brightness setting should range between 35 and 50.

Final adjustment relies on customer approval.

Figure 6-2  Monitor Brightness/Contrast Calibration Test Pattern

NOTE Monitor response lags button push.

small grey box within black box
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Chapter 7
Diagnostics/Troubleshooting

Section 7-1
Overview

7-1-1 Purpose of Chapter 7
This section describes how to setup and run the tools and software that help maintain image quality and 
system operation. Very basic host, system and board level diagnostics are run whenever power is 
applied. Some Service Tools may be run at the application level.

Table 7-1    Contents in Chapter 7

Section Description Page Number

7-1 Overview 7-1

7-2 Collect Vital System Information 7-2

7-3 Diagnostics 7-4

7-4 Virtual Console Observation 7-6
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Section 7-2
Collect Vital System Information

LOGIQworks has a common interface for the user to collect critical system data in the event of a failure. 
This mechanism can be invoked by the globally available hotkey <Ctrl-Alt-D>.

After entering the hotkey the default folder 'D:\Export' is suggested. To save the data on a different place 
enter a valid path without ending slash.

The procedure will store some system information in a compressed file with a name beginning with 
'logfile' and the current time stamp in the name.

Press 'OK', wait until the next message comes up indicating the output file.

The file contains several types of information:

• - screen shot
• - version information
• - registry information
• - main TCP/IP settings
• - modem log files
• - tracing files with debug information
• - application events
• - system events
• - peer-to-peer logfile
• - iip logfile
• - http error logfile
• - http access logfile
• - proDiags logfile
• - application logfile
• - distinct net sniffer logfile

Figure 7-1  Entering the path
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Section 7-2Collect Vital System Information (cont’d)

Figure 7-2  Save data
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Section 7-3
Diagnostics

The Diagnostics are part of the Service Browser. To enter the Service Browser follow Section 5-5-3-2 
"Service Login" on page 5-30.

7-3-1 Global Service User Interface (GSUI) Diagnostic
The Diagnostics are started from the Global Service User Interface Main Menu.

1.) Click on the DIAGNOSTICS Tool Button.
2.) Click on the Common Diagnostic folder to view contents.

The below menu will appear:

Figure 7-3   GSUI main menu for External Service users
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7-3-1 Global Service User Interface (GSUI) Diagnostic (cont’d)

Figure 7-4   GSUI Diagnostic Menu
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Section 7-4
Virtual Console Observation

7-4-1 General
This tool offers the possibility to view the entire customer's desktop and operation system.

Using the tool a remote service technician or the online center can access and modify all PC settings 
and programs on the customer's PC.

Before a GE Service FE can access the customer’s PC remotely, first the customer has to enable this 
feature by choosing "Disruptive Mode" and confirming "Yes".

Figure 7-5  Disruptive Mode
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7-4-1 General (cont’d)

Second the customer has to start the VCO:

• Open Utilities.
• Go to Common Utilities.
• Open the Virtual Console Observation.
• Press the ’Start’-botton.
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This page was intentionally left blank.
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Chapter 8
Replacement Procedures

Section 8-1
Overview

8-1-1 Purpose of Chapter 8
This chapter contains replacement procedures for the following modules/subsystems:

WARNINGWARNING No covers or panels should be removed from the system (high-voltage risk). 
Service and repairs must only be performed by authorized personal. 
Attempting do-it-yourself repairs invalidate warranty and are an infringement to regulations and are 
inadmissible acc. to IEC 60601-1.

Table 8-1    Chapter 8 Contents

Section Description Page Number

8-1 Overview 8-1

8-2 FRU Replacement Procedure 8-2

8-3 Recovery Procedure 8-14
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Section 8-2
FRU Replacement Procedure

8-2-1 PC Replacement Procedure

8-2-1-1 Preparations
• Write down the Computer-ID of the PC.
• If possible save all system presets (see Section 10-6-4-1 "Backup" )
• Boot from CD drive with Recovery CD and set PC to factory settings. See 8-3-1-1 "Complete 

reformatting of a System" on page 8-14.
• Shut Down the PC and all Peripherals as described in chapters 3 and 4.

8-2-1-2 PC Removal

1.) Disconnect the Power cable coming from the wall outlet.
2.) Disconnect all signal cabling from the rear of the PC.
3.) Remove the SW option dongle.
4.) Remove the USB Hard Disk.
5.) Remove the PC.

Figure 8-1  PC disconnections and removal System based on Dell Precision 340

Disconnect all cables 
connected on this 
partition.

Disconnect all cables on 
the backend.

Remove the PC.Computer ID
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8-2-1-2 PC Removal (cont’d)

8-2-2 CRT Monitor Replacement Procedure

8-2-2-1 Preparations
• Shut Down and turn Off the PC as described in chapters 3 and 4.

8-2-2-2 Monitor Removal

1.) Switch OFF the Monitor.
2.) Disconnect the Monitor Power cable from wall outlet.
3.) Disconnect the Monitor Signal cables from the PC.

Figure 8-2   PC disconnections and removal System based on Dell Precision 360 or on Dell Precision 370

Disconnect all cables 
connected on this 
partition.

Disconnect all cables on 
the backend.

Remove the PC.Computer ID
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8-2-2-2 Monitor Removal (cont’d)
4.) Remove the Monitor

Figure 8-3  Monitor disconnection and removal

Disconnect

Remove
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8-2-2-3 Monitor Installation

1.) Position new Monitor where old one was positioned.
2.) Connect the Power cable to the wall outlet.
3.) Connect the Signal cables to the PC.
4.) Switch ON the Monitor.
5.) Turn ON the PC.
6.) Calibrate the monitor as described in section 6-2-4.

Figure 8-4  Monitor Connection and installation

Install

Connect
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8-2-3 LCD Monitor Replacement Procedure

8-2-3-1 Preparations
• Shut Down and turn Off the PC as described in chapters 3 and 4.

8-2-3-2 Monitor Removal

1.) Switch OFF the Monitor.
2.) Disconnect the Monitor Power cable from the wall outlet.
3.) Disconnect the Monitor Signal cables from the PC.
4.) Remove the Monitor.

Figure 8-5   Monitor disconnection and removal

Disconnect

Remove
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8-2-3-3 Monitor Installation

1.) Position new Monitor where old one was positioned.
2.) Connect the Power cable to the wall outlet.
3.) Connect the Signal cables to the PC.
4.) Switch ON the Monitor.
5.) Turn ON the PC.

Figure 8-6   Monitor connection and installation

Install

Connect
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8-2-4 LCD Monitor Replacement Procedure

8-2-4-1 Preparations
• Shut Down and turn Off the PC as described in chapters 3 and 4.

8-2-4-2 Monitor Removal

1.) Switch OFF the Monitor.
2.) Disconnect the Monitor Power cable from the wall outlet.
3.) Disconnect the Monitor Signal cables from the PC.
4.) Remove the Monitor.

Figure 8-7   Monitor disconnection and removal

Disconnect

Remove
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8-2-4-3 Monitor Installation

1.) Position new Monitor where old one was positioned.
2.) Connect the Power cable to the wall outlet.
3.) Connect the Signal cables to the PC.
4.) Switch ON the Monitor.
5.) Turn ON the PC.

Figure 8-8   Monitor connection and installation

Install

Connect
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8-2-5 Modem Replacement Procedure

8-2-5-1 Modem of Dell 340 and Dell 360

8-2-5-1-1 Preparations
• Shut Down and turn Off the Workstation and all its parts as described.

8-2-5-1-2 Modem Removal

1.) Switch Off the Modem

2.) Disconnect the phone cable from the wall jack.
3.) Disconnect the DC Power cable.

4.) Disconnect the Signal cable to the PC.
5.) Remove the Modem.

Figure 8-9   Modem showing ON/OFF switch

Figure 8-10   Modem Rear connections

ON/OFF
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8-2-5-2 Modem of Dell Precision 370

8-2-5-2-1 Preparations
• Shut Down and turn Off the Workstation and all its parts as described.

8-2-5-2-2 Modem Removal

1.) Disconnect the phone cable from the wall jack.
2.) Disconnect the DC Power cable.
3.) Disconnect the Signal cable to the PC.
4.) Remove the Modem

8-2-5-3 Modem Installation

1.) Place the New Modem where the old one was.
2.) Connect the signal cable to the PC.
3.) Connect the wall outlet.
4.) Connect the Phone cable to wall phone jack.
5.) Switch On the Modem.
6.) Turn ON the Workstation and all its parts as described on previous page.
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8-2-5-4 Modem of Dell Precision 380 and Dell 390

8-2-5-4-1 Preparations
• Shut Down and turn Off the Workstation and all its parts as described.

8-2-5-4-2 Modem Removal

1.) Disconnect the phone cable from the wall jack.
2.) Disconnect the USB cable to the PC.
3.) Remove the Modem.

8-2-5-5 Modem Installation

1.) Place the New Modem where the old one was.
2.) Connect the USB cable to the PC.
3.) Connect the wall outlet.
4.) Connect the Phone cable to wall phone jack.
5.) Turn ON the Workstation and all its parts as described on previous page.
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8-2-6 Cable Replacement Procedure

8-2-6-1 Preparations
• Shut Down and turn Off the Workstation and all its parts as described.

8-2-6-2 Cable Removal

1.) Unplug the cable from the connecting devices.
2.) Remove the cable.

8-2-6-3 Cable Installation

1.) Plug the New Cable to the same devices as the old one was connected to.
2.) Turn on the workstation and the connected device.

a.) Power Cable: Verify System is powered on.
b.) Fire wire Cable: Insert a media into the DVD Drive. Connect to the Dataflow, and verify there 

is power on the DVD drive and that you are able to read from the disk.
c.) Ethernet Cables: Verify a green link light present on the Ethernet Switch, or PC.
d.) RS-232 Cable, modem: Verify iLinq connection.

CAUTION This procedure is a general cable replacement procedure, and should be valid for Power, Fire wire, 
Ethernet and RS-232 cables.
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Section 8-3
Recovery Procedure

8-3-1 Purpose of Software Recovery

8-3-1-1 Complete reformatting of a System

1.) Insert Recovery CD into the CD drive. Use the Recovery CD which is shipped with the system. Only 
this CD restores the Specific User, Windows and Application Settings which are put on the system 
during manufacturing.

2.) Enter the Boot Menu by pressing <F12>.
3.) Select the CD-Drive to boot from.

WARNINGWARNING All data will be lost. Your system will be set to factory settings.Store user settings on USB HDD and 
DICOM data on network store devices or CD-RW/DVD-RW if possible.

Figure 8-11  Factory Settings
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8-3-1-1 Complete reformatting of a System (cont’d)

4.) Press 2. for restoring the system like Factory new condition.
5.) If you don’t want to proceed the Recovery Procedure, press 4. to exit DOS. Remove the Recovery 

CD and reboot your system

6.) If you are sure that you want to proceed the System restore press 1. After choosing this point Ghost 
will restore your system like Factory new condition. Consider, that all data on your hard disk will be 
erased.

Figure 8-12  Restore Menu

Figure 8-13  System Restore
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8-3-1-1 Complete reformatting of a System (cont’d)

7.) While system restores the Ghost surface like on figure 8-15 is shown on the screen.

Figure 8-14  Ghost Surface
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8-3-1-1 Complete reformatting of a System (cont’d)

8.) After the restore has finished remove the CD from the CD drive and reboot the PC.

9.) Check the installation of the USB HDD
10.)Recover User settings from USB HDD (see 10-6-4)

Figure 8-15  Restore Complete

Figure 8-16  USB HDD check System based on Dell Precision 340
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8-3-1-2 PC is working but System is corrupted

Proceed Step 1 to Step 9 from 8-3-1-1.

8-3-1-3 PC is working but Windows or application files are corrupted

1.) Insert Recovery CD into the CD drive. Use the Recovery CD which is shipped with the system. Only 
this CD restores the Specific User, Windows and Application Settings which are put on the system 
during manufacturing.

2.) Boot from the CD by pressing <F12> during boot sequence.

WARNINGWARNING All data will be lost. Your system will be set to factory settings. Store user settings on USB HDD and 
DICOM Data on network store devices or CD-RW/DVD-RW is possible.

NOTE All data on Drive C will be set to factory settings. Store user settings on USB HDD and DICOM Data on 
network store devices or CD-RW/DVD-RW if possible.

Figure 8-17  Factory Settings
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8-3-1-3 PC is working but Windows or application files are corrupted (cont’d)

3.) Press 3. for restoring your C: Partition like Factory new condition.
4.) If you want to exit to DOS press 4.

5.) If you are sure that you want to proceed the Partition restore press 1. After choosing this point Ghost 
will restore drive C: from your system like Factory new condition. Consider that all data on your 
partition C: will be erased.

Figure 8-18  Restore Menu

Figure 8-19  Partition Restore
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8-3-1-3 PC is working but Windows or application files are corrupted (cont’d)

6.) While partition restore, the Ghost surface like on Figure 8-14 is shown on the screen.

7.) After the restore has finished remove the CD from the CD drive and reboot the PC.

Figure 8-20  Ghost surface partition restore

Figure 8-21  Restore Complete
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8-3-1-3 PC is working but Windows or application files are corrupted (cont’d)

8.) Check the installation of USB HDD.
9.) Recover User settings from USB HDD (see 10-6-4)

8-3-1-4 PC is working but Software is corrupted
All data will be lost. Store User Settings on USB HDD and DICOM Data on network store devices or 
CD-RW/DVD-RW.

Proceed Step 1 to Step 6 from 8-3-1-1.

Figure 8-22  USB HDD check of System based on Dell Precision 340

Figure 8-23  USB HDD check of System based on Dell Precision 360
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8-3-1-5 Windows Message after Recovery Procedure
If the message shown in the picture below occurs click on the “Yes"-button and reboot the system.

Figure 8-24  Windows Message
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8-3-1-6 Recover with Spare Part Recovery CD
Recover the system with Spare Part recovery DVD P/N 2413251 for DELL 340 and 2366663-2 for DELL 
360 and 2413250 for Dell 370

1.) Proceed the steps in Section 8-3-1-1 "Complete reformatting of a System"  by using the Spare Part 
Recovery DVD.

2.) Reboot the system.

3.) Click “Next” to continue.

Figure 8-25  Setup Wizard

3.



GE MEDICAL SYSTEMS
DIRECTION 5184024-100, REVISION 5 LOGIQWORKS BASIC SERVICE MANUAL

8-24 Section 8-3 - Recovery Procedure

8-3-1-6 Recover with Spare Part Recovery CD (cont’d)

Figure 8-26  Confirm License Agreement
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8-3-1-6 Recover with Spare Part Recovery CD (cont’d)
4.) Select “I accept this agreement” and click “Next”.

5.) To change the local settings for system and keyboard click “Customize”.
6.) Click “Next” to continue.

Figure 8-27  Regional Settings
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8-3-1-6 Recover with Spare Part Recovery CD (cont’d)

7.) Type in the Product Key you will find on a label on top of the CPU box.
8.) Click “Next” to continue.

Figure 8-28  Product Key
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8-3-1-6 Recover with Spare Part Recovery CD (cont’d)

9.) Verify date and time and if necessary change the Date & Time settings.
10.)Select the Time Zone the system is located.
11.)Click “Next” to continue.
12.)Logon as ADMINISTRATOR.
13.)Go through the steps in Section 3-5 on page 3-68 to configure the system.

Figure 8-29  Date and Time Settings
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Chapter 9
Renewal Parts

Section 9-1
Overview

9-1-1 Purpose of Chapter 9
This chapter gives you an overview of Spare Parts available for the LOGIQworks.

 

Table 9-1    Contents in Chapter 9

Section Description Page Number

9-1 Overview 9-1

9-2 List of Abbreviations 9-2

9-3 Renewal parts list 9-3
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Section 9-2
List of Abbreviations

9-2-1 Stock Items
• FRU 1 - Field Replacement Unit - Stock Part.
• FRU 2 - Field Replacement Unit - Stock Part, Long delivery.

9-2-2 Non stock Items
FRU N - Field Replacement Unit - Non Stock Part.

9-2-3 General abbreviations
QTY= Quantity

9-2-4 LOGIQworks PC versions covered in this manual
See Section 1-1-4 "LOGIQworks Models covered by this Manual" on page 1-2.
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Section 9-3
Renewal parts list

9-3-1 Stock Items FRU 1 and 2

Figure 9-1  LOGIQworks Parts identifications
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Table 9-2    PC, Monitor, Keyboard and Mouse parts

Item Part Name Part Number FRU Qty. Description

1 Dell Precision 340 2365947 1 1 Dell support on GPO

2

Spacesaver Keyboard US
Spacesaver Keyboard French
Spacesaver Keyboard German
Spacesaver Keyboard Italian

Spacesaver Keyboard Spanish

2366635
2369714
2366631
2369725
2369730

1
2
2
2
2

1

3 Optical USB Mouse 2366634 2 1

4 Monitors
2365798
2365799

1 1
NEC LCD 1880 Sx Black

Sony GMD-F520

5
Signal Cables digital
Signal Cables analog

2368273
2370014

2 1
LCD Monitor digital (DV)

CRT Monitor analog (VGA)

6 Power Cables for PC, Monitor, Modem

2369732
2369733
2369734
2369735
2369736

2 3-5

Power Cord for Precision 340 US
Power Cord for Precision 340 French
Power Cord for Precision 340 German
Power Cord for Precision 340 Italian

Power Cord for Precision 340 Spanish

7
Y-Monitor cable digital
Y-Monitor cable analog

2368269
2368271

1 1

8 Serial Modem 2245794 1 1 Modem MUltitech MT-5634 ZBA V.90

9 Patch Cable 2366640 2 1 5 meters long

10 RS-232 Cable, 9 pin ends 2368272 2 1 PC to Modem

11 IEEE Fire wire Cable 2366637 2 1

12 Recovery DVD V. 1.2 2413251 1 1

13 USB Harddisk 2365958 1 1
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9-3-2 Stock Items FRU 1 and 2
 

Figure 9-2   LOGIQworks Parts identifications
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Table 9-3    PC, Monitor, Keyboard and Mouse parts

Item Part Name Part Number FRU Qty. Description

1

Dell Precision 360
Dell Precision 370
Dell Precision 380
Dell Precision 390

2365947-2
2413249
2416901
5184038

1
1
1
1

1
1
1
1

Dell support not on GPO

2

Spacesaver Keyboard US
Spacesaver Keyboard French
Spacesaver Keyboard German
Spacesaver Keyboard Italian

Spacesaver Keyboard Spanish

2366635
2369714
2366631
2369725
2369730

1
2
2
2
2

1

3 Optical USB Mouse 2366634 2 1

4 Monitors 2409662
2409663 1 1 Dell LCD 1901 Europe

Dell LCD 2001 US/Asia

5 Monitor Signal Cable LCD digital 2368273 2 1 LCD Monitor digital (DV)

6 Power Cables for PC, Monitor, Modem

2369732
2369733
2369734
2369735
2369736
2409670

2

2

3-5

1-2

Power Cord for Precision 360 US
Power Cord for Precision 360 French
Power Cord for Precision 360 German
Power Cord for Precision 360 Italian

Power Cord for Precision 360 Spanish
Power Cord FP2001 US

7 Serial Modem 2413338 1 1 Modem Multitech MT-5634 ZBA-USB

8 Patch Cable 2366640 2 1 5 meters long

9 RS-232 Cable, 9 pin ends 2368272 2 1 PC to Modem

10

Recovery DVD V. 1.2 Dell 360
Recovery DVD V. 1.3 Dell 370
Recovery DVD V. 2.0 Dell 380
Recovery DVD V. 3.0 Dell 380
Recovery DVD V. 3.0 Dell 390

2366663-2
2413250
5180509
5179581
5260541

1
1
1
1

1
1
1
1

11 USB Harddisk 2365958 1 1

12 Y-Monitor cable digital 2368269 1 1 for Dell 370
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9-3-3 Renewal Part Lists
9-3-3-1 Updates

To Update LOGIQworks version 1.2 to LOGIQworks version 3.0, all three items have to be ordered. 
First update your system to LOGIQworks 1.3, after that to LOGIQworks 2.0 and in the end to 
LOGIQworks 3.0.

For the update from LOGIQworks 1.3 to 3.0, two parts are required, item 2 and item 3. First update your 
system to LOGIQworks 2.0 and finally update your system to LOGIQworks 3.0.

All three items are valid for all workstations.

Before recover, check the correct RA600 license file or the correct RA600 dongle. In case you have a 
licence file, make a backup of the license file, you will need it for the update. 

Also check if you have the correct TruAccess / PlugIn USB dongle, it should have the same version as 
the update. Mind that the TruAccess / PlugIn USB dongle is independent to the Software version, you 
will only need the latest version, it will also be valid for older versions. Latest dongle can be ordered by 
GPO (Part Number: 2413709).

9-3-3-2 LOGIQworks FX and LOGIQworks SoftwareOnly

LOGIQworks FX is the plug-in software for an existing Centricity RA600 or ViewPoint system. With 
LOGIQworks FX you have the ability to add the image review capabilities of LOGIQworks to your 
existing RA600 or ViewPoint workstation. LOGIQworks FX removes the necessity for a separate 
workstation to achieve enhanced image review of your ultrasound studies.

Software only package is the plug-in software to run LOGIQworks on third party hardware. 

9-3-3-2-1 DVD burner for LOGIQworks SoftwareOnly

The LACIE D2 EXTERNAL DVD BURNER is a external DVD drive for compatibility with RA600 
software. For Installation of the external DVD burner see Technical Publication: Centricity 
Radiology RA 600 V7.0 Service Manual (Direction DOC0054151).

Table 9-4    LOGIQworks Updates

Item Part Name Part Number FRU Qty. Description

1 Update 1.2 to 1.3 2413333 1 1 Update of LOGIQworks version 1.2 to version 1.3

2 Update 1.3 to 2.0 5180305 1 1 Update of LOGIQworks version 1.3 to version 2.0

3 Update 2.0 to 3.0 5260545 1 1 Update of LOGIQworks version 2.0 to version 3.0

Table 9-5    LOGIQworks FX and LOGIQworks SoftwareOnly

Item Part Name Part Number FRU Qty. Description

1 LW-FX 3.0.4 Inst CD RA600 5260543 1 1 Installation CD of LOGIQworks FX version 3.0.4 for 
installation on existing RA600 systems

2 LW3.0.4 InstCD SWonly 5260546 1 1 Installation CD of LOGIQworks SWonly version 
3.0.4 for software only installation

Table 9-6    LOGIQworks FX and LOGIQworks SoftwareOnly

Item Part Name Part Number FRU Qty. Description

1 LACIE D2 EXTERNAL DVD BURNER 2014143-007 1 1 DVD Burner for compatibility with RA600 software
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9-3-4 Product Manuals

Part Name
 

FRU Part Number  QTY

Basic Service Manual English N 5184024-100 1

Proprietary Service Manual English N 5184027-100 1

Instruction for Use English N 5177849-100 1

Release Notes English N 5177928-100 1

Quick Guide English N 5177986-100 1

Quick Card English N 5177962-100 1

Update Installation Manual English N 5177883-100 1

FX Installation Manual English N 5184015-100 1

Software Installation Manual English N 5184018-100 1

Instruction for Use French N 5177849-101 1

Release Notes French N 5177928-101 1

Quick Guide French N 5177986-101 1

Quick Card French N 5177962-101 1

Instruction for Use Spanish N 5177849-106 1

Release Notes Spanish N 5177928-106 1

Quick Guide Spanish N 5177986-106 1

Quick Card Spanish N 5177962-106 1

Instruction for Use German N 5177849-108 1

Release Notes German N 5177928-108 1

Quick Guide German N 5177986-108 1

Quick Card German N 5177962-108 1

Instruction for Use Italian N 5177849-111 1

Release Notes Italian N 5177928-111 1

Quick Guide Italian N 5177986-111 1

Quick Card Italian N 5177962-111 1

Instruction for Use Japanese N 5177849-140 1

Release Notes Japanese N 5177928-140 1

Quick Guide Japanese N 5177986-140 1

Quick Card Japanese N 5177962-140 1

Table 9-7    Product manuals
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Instruction for Use Swedish N 5177849-142 1

Release Notes Swedish N 5177928-142 1

Quick Guide Swedish N 5177986-142 1

Quick Card Swedish N 5177962-142 1

Quick Guide Korean N 5177986-144 1

Instruction for Use Danish N 5177849-160 1

Release Notes Danish N 5177928-160 1

Quick Guide Danish N 5177986-160 1

Quick Card Danish N 5177962-160 1

Quick Guide Norwegian N 5177986-161 1

Quick Guide Finish N 5177986-162 1

InSite II ViewPoint/LOGIQworks
Installation Manual

N 5181936-100 1

Part Name
 

FRU Part Number  QTY

Table 9-7    Product manuals
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Chapter 10
Quality Assurance

Section 10-1
Overview

10-1-1 Purpose of Chapter 10
This chapter describes Periodic Maintenance (PM) and customer performed tasks on the workstation 
and peripherals. These procedures are intended to maintain the quality of the computer system. Read 
this chapter completely and familiarize yourself with the procedures before performing a task.

 

Table 10-1    Contents in Chapter 10

Section Description Page Number

10-1 Overview 10-1

10-2 Why perform Periodic Maintenance 10-2

10-3 Periodic Maintenance Schedule 10-3

10-4 Tools Required 10-4

10-5 Safety Inspections 10-5

10-6 PC Maintenance 10-6

WARNINGWARNING Do not remove any covers from the computer system!
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Section 10-2
Why perform Periodic Maintenance

10-2-1 Keeping Records
It is good business practice that ultrasound facilities maintain the records of periodic and corrective 
maintenance of the LOGIQworks which is a peripheral to radiology ultrasound scanners such as LOGIQ 
7 and LOGIQ 9.

10-2-2 Quality Assurance
Routine quality control testing must occur regularly Table 10-2 on page 3. The same tests are 
performed during each period so that changes can be monitored over time and effective corrective 
action can be taken.
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Section 10-3
Periodic Maintenance Schedule

10-3-1 How often should PMs be performed?
The Maintenance Task Schedule specifies how often your LOGIQworks should be serviced and what 
items need attention. It is the customer’s responsibility to ensure the LOGIQworks periodic maintenance 
is performed as scheduled in order to retain its high level of safety, dependability and performance. Your 
GE Service Representative knows your LOGIQworks best and can provide competent, efficient service. 
Please contact us for further information and to schedule GE Medical Systems Ultrasound to perform 
this service for you.

The services and intervals shown in the maintenance schedule assumes that you use your 
LOGIQworks for an average image review load.

If conditions exist which exceed typical usage and image review load, then it is recommended to 
increase the periodic maintenance frequencies.

Table 10-2    Periodic Maintenance Schedule

Service at Indicated Time Daily Weekly Monthly Annually Notes

Inspect AC Mains Cable • look for damages

Inspect Cables and Connectors • look for damages

Clean all outer casings • dry PC cleaner cloth

Clean Monitor screen • Use anti static alcoholic moist 
cloth

Clean Mouse and Keyboard • Use anti static alcoholic moist 
cloth

Calibrate Monitors 2 weekly
See to 6-2 for LCD monitors 
To adjust calibration interval 
see chapter 3-5-2-5

Removal of Log files is performed 
automatically

See chapter 3-5-4-5 for 
maintenance period of 
connection service,
Chapter 3-5-6-5 for 
maintenance period of 
database service,
Chapter 3-5-8-4 for 
maintenance period of the 
print service.
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Section 10-4
Tools Required

10-4-1 Necessary Tools

10-4-1-1 Specific Requirements for Periodic Maintenance

Table 10-3     Overview of Requirements for Periodic Maintenance

Tool  Part Number Comments

Anti Static Vacuum Cleaner
46–194427P278
46–194427P279

120V
230V

Disposable Gloves

Cleaning Cloth For moisturized cleaning
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Section 10-5
Safety Inspections

10-5-1 Electrical Safety Tests

10-5-1-1 Specifications to meet

Check that power cables are connected correctly and undamaged in any way.

WARNINGWARNING THE USER MUST ENSURE THAT SAFETY INSPECTIONS ARE PERFORMED AT LEAST 
EVERY 12 MONTHS ACCORDING TO THE REQUIREMENTS OF THE PATIENT SAFETY 
STANDARD IEC-EN 60601-1. ONLY TRAINED PERSONS ARE ALLOWED TO PERFORM 
THE SAFETY INSPECTIONS MENTIONED ABOVE.
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Section 10-6
PC Maintenance

10-6-1 LOGIQworks units Outer casing
1.) Switch off the Units.
2.) Remove the power cord from the wall outlet.
3.) Clean outer casings with a special PC cleaner cloth.

10-6-2 Monitor Screen
1.) Switch off the monitor and remove the power cord from the wall outlet.
2.) Clean the screen with a conventional off the shelf screen cleaner cloth.
3.) If necessary wipe it dry.

10-6-3 Keyboard and Mouse
1.) Clean the Keyboard keys and Mouse cover with a conventional off the shelf keyboard and mouse 

cleaner.
2.) If necessary wipe them dry.
3.) Vacuum the keyboard pads clean.

10-6-4 Backup and Restore 

10-6-4-1 Backup
The system data (C: drive) has to be backed up every day in order to restore LOGIQworks to its latest 
state, in case of system failure. The recommended method to backup system data is to have a separate 
RW-DVD for each working day (e.g. DVD-Monday, DVD-Tuesday etc.)

1.) Insert the DVD for a particular day into the DVD drive and the rescue floppy to the floppy drive.

2.) Restart the system. 
3.) To copy/backup the C: drive onto the DVD, press “1”. The backup process may take around 30 

minutes, and then a screen pops up prompting the user to remove the floppy disc and DVD. Follow 
the instructions.

4.) Restart the system. Press “Ctrl+Alt+Del” keys.

10-6-4-2 Restore

1.) Insert the DVD for a particular day into the DVD drive and the rescue floppy to the floppy drive.

2.) Restart the system. 

NOTE This backup process does NOT backup image data present in D: drive. It backups file present on C. 
drive only.

NOTE Ensure that the correct DVD-RW for the day is inserted in order to avoid mix up of the backup of a 
different day.

NOTE Ensure that the correct DVD-RW for the day is inserted in order to avoid mix up of the backup of a 
different day.
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10-6-4 Backup and Restore (cont’d)

3.) To restore C: drive from the DVD, press “2”. The backup process may take around 30 minutes, and 
then a screen pops up prompting the user to remove the floppy disc and DVD. Follow the 
instructions.

4.) Restart the system. Press “Ctrl+Alt+Del” keys.

10-6-5 Save and Restore 
Following settings are saved by the Save and Restore function: LOGIQworks user and system settings, 
as for example the Hanging Protocols or the Desktop-Window settings, Windows Network and 
Operating System settings as the IP-Address or the Host name. 

Settings and data which cannot be saved by the Save and Restore utility are: DICOM image data and 
Windows specific user settings as for example different users who where created. Normally the 
personal user settings are saved by your computer administrator. Please contact him to be sure not to 
lose any important settings.

10-6-5-1 Save
The utility will save all user settings to the USB mass storage device. The USB mass storage device 
must be plugged in and you are requested to enter the assigned drive letter for your USB mass storage 
device (you can find the drive letter by looking in Windows Explorer for “Removable disc”).

1.) Select all contents on the USB mass storage device.
2.) To Save the RA600 settings double-click the ’RA600 settings tool’ icon on the desktop.
3.) Save User and/or System Data.

Figure 10-1  
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10-6-4-1 Backup (cont’d)

To save user settings: 

1.) Click on 'RadWorks User'.

2.) Click on 'Save'.

Figure 10-2  RadWorks Settings Tool

Figure 10-3  RadWorks User Settings
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10-6-4-1 Backup (cont’d)

3.) Enter a valid device (use the USB mass storage device).
4.) Enter a file name for the user settings.This file name should reflect the date and the type of settings 

you are storing. In this case: user settings.
5.) Click “save”.

To save system settings: 

1.) Click on “RadWorks System”.

Figure 10-4  RadWorks User Settings - Save
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10-6-4-1 Backup (cont’d)

2.) Click on “Backup”.

3.) Enter a valid device (use the USB mass storage device).
4.) Enter a file name for the system settings. This file name should reflect the date and the type of 

settings you are storing. In this case: system settings.
5.) Click “save”.
6.) Close the RadWorks Setting Tool.

Figure 10-5  RadWorks System Settings

Figure 10-6  RadWorks System Settings - Save
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10-6-4-1 Backup (cont’d)

7.) Open Windows Explorer to check whether the Save operation has completed successfully. Select 
the drive letter that represents the USB HDD and verify that three files were saved to the USB HDD.

10-6-5-2 Restore
The restore utility will help you in any cases of software or hardware corruption, to get back the original 
condition before the crash. In most cases the recovery procedure precedes the restore function (see 
Section 8-3 "Recovery Procedure" on page 8-14). 

The utility will restore all user and system settings from the USB mass storage device. To use this utility 
you must have saved your settings with the “Save”- function before. The USB mass storage device must 
be plugged in and you are requested to enter the assigned drive letter for your USB mass storage 
device (you can find the drive letter by looking in the Windows Explorer for “Removable disk”).

Figure 10-7  Windows Script Host - Saved successfully
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10-6-5-2 Restore (cont’d)
After that you have started the ’RA settings tool’, you can restore User and/or System Data.

To load user settings:

1.) Click on “RadWorks User”.

Figure 10-8  RadWorks Settings Tool
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10-6-5-2 Restore (cont’d)

2.) Select the user settings from the Available Settings List (see Figure 10-9). Make sure that you don’t 
select System settings.

3.) Click on “Load”.

Figure 10-9  Restore RadWorks User Settings
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10-6-5-2 Restore (cont’d)

4.) Select a previously saved file and click “Open”.

5.) Confirm with “OK”.

To load system settings:

1.) Click on “RadWorks System” see Figure 10-8.

Figure 10-10  Load user settings

Figure 10-11  Overwriting of User Settings
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10-6-5-2 Restore (cont’d)

2.) Select the system settings from the Available Settings list (see Figure 10-12).
3.) Click on “Restore”.

4.) Pick up a previously saved file and click “Open”.
5.) Close the “RadWorks Setting Tool”.

Figure 10-12  Restore RadWorks System Settings.

Figure 10-13  Load System Settings
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